
Manual
MS-00809-0100-0700, Rev AC

November 2023

Rosemount™ 700XA
Gas Chromatograph



Notice
EMERSON (“SELLER”) SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS IN THIS MANUAL OR
OMISSIONS FROM THIS MANUAL. SELLER MAKES NO WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THIS MANUAL
AND, IN NO EVENT, SHALL SELLER BE LIABLE FOR ANY SPECIAL OR CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT
LIMITED TO, LOSS OF PRODUCTION, LOSS OF PROFITS, ETC.
PRODUCT NAMES USED HEREIN ARE FOR MANUFACTURER OR SUPPLIER IDENTIFICATION ONLY AND MAY BE
TRADEMARKS/REGISTERED TRADEMARKS OF THESE COMPANIES.
THE CONTENTS OF THIS PUBLICATION ARE PRESENTED FOR INFORMATIONAL PURPOSES ONLY AND, WHILE EVERY
EFFORT HAS BEEN MADE TO ENSURE THEIR ACCURACY, THEY ARE NOT TO BE CONSTRUED AS WARRANTIES OR
GUARANTEES, EXPRESSED OR IMPLIED, REGARDING THE PRODUCTS OR SERVICES DESCRIBED HEREIN OR THEIR USE
OR APPLICABILITY. WE RESERVE THE RIGHT TO MODIFY OR IMPROVE THE DESIGNS OR SPECIFICATIONS OF SUCH
PRODUCTS AT ANY TIME.
SELLER DOES NOT ASSUME RESPONSIBILITY FOR THE SELECTION, USE, OR MAINTENANCE OF ANY PRODUCT.
RESPONSIBILITY FOR PROPER SELECTION, USE, AND MAINTENANCE OF ANY SELLER PRODUCT REMAINS SOLELY WITH
THE PURCHASER AND END-USER.

Warranty
1. LIMITED WARRANTY: Subject to the limitations contained in Section 2 herein and except as otherwise

expressly provided herein, Emerson (“Seller”) warrants that the firmware will execute the programming
instructions provided by Seller and that the Goods manufactured or Services provided by Seller will be free
from defects in materials or workmanship under normal use and care until the expiration of the applicable
warranty period. Goods are warranted for twelve (12) months from the date of initial installation or eighteen
(18) months from the date of shipment by Seller, whichever period expires first. Consumables and Services
are warranted for a period of 90 days from the date of shipment or completion of the Services. Products
purchased by Seller from a third party for resale to Buyer (“Resale Products”) shall carry only the warranty
extended by the original manufacturer. Buyer agrees that Seller has no liability for Resale Products beyond
making a reasonable commercial effort to arrange for procurement and shipping of the Resale Products. If
Buyer discovers any warranty defects and notifies Seller thereof in writing during the applicable warranty
period, Seller shall, at its option, promptly correct any errors that are found by Seller in the firmware or
Services, or repair or replace F.O.B. point of manufacture that portion of the Goods or firmware found
by Seller to be defective, or refund the purchase price of the defective portion of the Goods/Services. All
replacements or repairs necessitated by inadequate maintenance, normal wear and usage, unsuitable power
sources, unsuitable environmental conditions, accident, misuse, improper installation, modification, repair,
storage or handling, or any other cause not the fault of Seller are not covered by this limited warranty, and
shall be at Buyer's expense. Seller shall not be obligated to pay any costs or charges incurred by Buyer or any
other party except as may be agreed upon in writing in advance by an authorized Seller representative. All
costs of dismantling, reinstallation and freight, and the time and expenses of Seller's personnel for site travel
and diagnosis under this warranty clause shall be borne by Buyer unless accepted in writing by Seller. Goods
repaired and parts replaced during the warranty period shall be in warranty for the remainder of the original
warranty period or ninety (90) days, whichever is longer. This limited warranty is the only warranty made
by Seller and can be amended only in a writing signed by an authorized representative of Seller. Except as
otherwise expressly provided in the Agreement, THERE ARE NO REPRESENTATIONS OR WARRANTIES OF ANY
KIND, EXPRESSED OR IMPLIED, AS TO MERCHANTABILITY, FITNESS FOR PARTICULAR PURPOSE, OR ANY OTHER
MATTER WITH RESPECT TO ANY OF THE GOODS OR SERVICES. It is understood that corrosion or erosion of
materials is not covered by our guarantee.

2. LIMITATION OF REMEDY AND LIABILITY: SELLER SHALL NOT BE LIABLE FOR DAMAGES CAUSED BY DELAY
IN PERFORMANCE. THE SOLE AND EXCLUSIVE REMEDY FOR BREACH OF WARRANTY HEREUNDER SHALL BE
LIMITED TO REPAIR, CORRECTION, REPLACEMENT, OR REFUND OF PURCHASE PRICE UNDER THE LIMITED
WARRANTY CLAUSE IN SECTION 1 HEREIN. IN NO EVENT, REGARDLESS OF THE FORM OF THE CLAIM OR
CAUSE OF ACTION (WHETHER BASED IN CONTRACT, INFRINGEMENT, NEGLIGENCE, STRICT LIABILITY, OTHER
TORT, OR OTHERWISE), SHALL SELLER'S LIABILITY TO BUYER AND/OR ITS CUSTOMERS EXCEED THE PRICE TO
BUYER OF THE SPECIFIC GOODS MANUFACTURED OR SERVICES PROVIDED BY SELLER GIVING RISE TO THE
CLAIM OR CAUSE OF ACTION. BUYER AGREES THAT IN NO EVENT SHALL SELLER'S LIABILITY TO BUYER AND/OR
ITS CUSTOMERS EXTEND TO INCLUDE INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE DAMAGES. THE TERM
“CONSEQUENTIAL DAMAGES” SHALL INCLUDE, BUT NOT BE LIMITED TO, LOSS OF ANTICIPATED PROFITS,
LOSS OF USE, LOSS OF REVENUE, AND COST OF CAPITAL.
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Safety information

NOTICE
The analyzer electronics and oven assembly, when housed inside a purged enclosure, meet the certifications and
classifications identified in the Specifications section of the Product Data Sheet, which is located on the Emerson
website: Emerson.com/global.

 WARNING
Precautionary signs
Failure to observe precautionary signs may result in injury or death to personnel or cause damage to equipment.
Observe and comply with all precautionary signs posted on the device.

 WARNING
Toxic vapors
Exit ports may discharge dangerous levels of toxic vapors.
Use proper protection and a suitable exhaust device.

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.

 WARNING
Safety compliance
Failure to follow the safety instructions may cause injury to personnel. The seller does not accept any responsibility for
installations of the device or any attached equipment in which the installation or operation thereof has been
performed in a manner that is negligent and/or non-compliant with applicable safety requirements.

Install and operate all equipment as designed and comply with all safety requirements.
If the device is not operated in a manner recommended by the manufacturer, the overall safety could be
impaired.
Observe all safety precautions defined in the gas Safety Data Sheet (SDS), especially for hazardous locations.

 WARNING
Supply mains connection
The device is intended to be connected to supply mains by qualified personnel in accordance with local and national
codes.

 WARNING
Power
A suitable APPROVED switch and fuse or a circuit breaker shall be provided to facilitate the disconnection of mains
power.
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 WARNING
Ventilation

Use the device in a well-ventilated area.
If you plan to place the device in a sealed shelter, always vent it to atmosphere with ¼-in. (6.4 mm) tubing or
larger. This will prevent the build up of H2 and sample gas.

 WARNING
Leak testing

All gas connections must be properly leak tested at installation.
Do not turn on gas until you have completely checked the carrier lines for leaks.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot unless it has been
switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure that it has been switched off
and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

 WARNING
Physical access
Unauthorized personnel may potentially cause significant damage to and/or misconfiguration of end users’
equipment. This could be intentional or unintentional and needs to be protected against.
Physical security is an important part of any security program and fundamental to protecting your system. Restrict
physical access by unauthorized personnel to protect end users' assets. This is true for all systems used within the
facility.

NOTICE
Replaceable parts
Only a few parts inside the device are replaceable. Only trained service personnel should replace parts.
All replacement parts must be authorized by Emerson to ensure product certification compliance.

NOTICE
Equipment damage
If the device is heated without carrier flow, damage to the columns may occur.

NOTICE
Waste disposal
Waste electrical and electronic products must not be disposed of with household waste.
Please recycle where facilities exist.
Check with your local authority or retailer for recycling advice.
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NOTICE
The device is certified by CSA and ATEX. See the certification tag on the device for specific details about its agency
approvals.
When the vapor regulators and flow switches are fitted, they must be suitably certified with the ratings Ex d IIC Gb
T6/T4/T3 and for a minimum ambient temperature range: Ta = -20 °C to +60 °C.
Where right angle bend cable adapters are used, they shall be appropriately certified and shall interface with
enclosures via appropriate certified barrier glands.

Glossary

Auto zero The thermal conductivity detector (TCD) is auto zeroed at the start of a new analysis. You can also
configure automatic zeroing of the TCD amplifier to take place at any time during the analysis
if the component is not eluting or the baseline is steady. The flame ionization detector (FID)
will auto zero at each new analysis run and can be configured to auto zero anytime during the
analysis if the component is not eluting or the baseline is steady.

Baseline Signal output when there is only carrier gas going across the detectors. In a chromatogram, you
should only see Baseline when running an analysis without injecting a sample.

Carrier gas The gas used to push the sample through the system during an analysis.
CDT Component data table.
Chromatogram A permanent record of the detector output. A chromatogram is obtained from a personal

computer (PC) interfaced with the detector output through the controller assembly. A typical
chromatogram displays all component peaks and gain changes. You can view it in color, as it
is processed on a PC display. Check marks recorded on the chromatogram by the controller
assembly indicate where timed events take place.

Component Any one of several different gases that may appear in a sample mixture. For example, natural gas
usually contains the following components: nitrogen, carbon dioxide, methane, ethane, propane,
isobutane, normal butane, isopentane, normal pentane, and hexanes plus.

CTS Clear to send.
DCD Data carrier detect.
DSR Data set ready.
DTR Data terminal ready.
FID Flame ionization detector. The optional FID may be used in place of a TCD for the detection of

trace compounds. The FID requires a polarization voltage, and its output is connected to the input
to a high impedance amplifier, an electrometer. The sample of gas to be measured is injected into
the burner with a mixture of hydrogen and air to maintain the flame.

FPD Flame photometric detector. The FPD is used to analyze gas compound impurities, such as
sulfur, phosphorous, and metals. When sample gas passes through the hydrogen/air flame the
component's wavelengths emitted are electrically measured. The FPD is located in the analyzer's
upper enclosure.

GC Gas chromatograph. The GC is a user-configurable analyzer for various process gas applications.
LSIV Liquid sample injection valve. The optional LSIV is used to convert a liquid sample to a gas sample

by vaporizing the liquid in a heated chamber, so the resulting gas sample can be analyzed.
Methanator The optional methanator, also known as a catalytic converter, transforms the components that

are undetectable by the FID (carbon dioxide and/or carbon monoxide) into methane by adding
hydrogen and heat to the sample.

PC Personal computer.
Response factor Correction factor for each component as determined by the following calibration:
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Retention time Time, in seconds, that elapses between the start of analysis and the sensing of the maximum
concentration of each component by the detector.

RI Ring indicator.
RLSD Received line signal detect. A digital simulation of a carrier detect.
RTS Request to send.
RxD, RD, or Sin Receive data or signal in.
SCS Sample conditioning system.
TCD Thermal conductivity detector. A detector that uses the thermal conductivity of the different gas

components to produce an unbalanced signal across the bridge of the preamplifier. The higher
the temperature, the lower the resistance on the detectors.

TxD, TD, or Sout Transmit data or signal out.
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1  Cybersecurity recommendations for
Rosemount XA gas chromatograph
(GC) and MON2020 users
Install XA GC in a secure environment with physical protection
• Install the XA GC in a secure environment with physical protection.
• Scan the USB shipped with the XA GC with anti-virus software before use.
• Store all the GC related files including application files, drawings, and documents, in a

secure network/drive with restricted access.
Install MON2020 on a secure personal computer (PC)
• Access to PC should be protected by adequate username/password.
• With restricted admin privileges on PC - operating system (OS) configuration, install

software, etc.
• Restrict network ports and connection of mass storage devices/removable media.
• Resides on a private local area network (LAN) with firewall and network access control

list configured for blocking illegitimate access.
• With anti-virus software kept current on PC.
• With Microsoft® Windows automatic updates enabled on PC.
• PC updated with Windows security patches.
• With physical access controls - locked room, key-card entry, etc.
Use XA GCs in secure network
This product is designed to be used in an industrial environment with appropriate defense-
in-depth security measures and compensating controls effective against cyber-attacks.
This product is not designed to be connected directly to the Internet or Internet facing
networks. Security measures should include, but are not limited to:
• Ethernet should be set up in a private LAN with firewall and network access control list

configured for blocking illegitimate access.
• Network devices stored with physical access controls - physical locks, ID verification, etc.
• Network devices updated with all available security patches.
• Anti-virus software kept current on all computers in the network.
• Other industry best practices for secure network.
Control access to XA GC using password of sufficient complexity
• The password length should be at least eight alphanumeric characters.
• All default users should be removed after XA GC commissioning or password upgrade

to comply with the password complexity guidelines.
• Password policy level should be set after GC commissioning by accessing Tools → Users 

→ User Administration.
• Use a unique password for each user.

Manual Cybersecurity recommendations for Rosemount XA gas chromatograph (GC) and MON2020 users
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• Avoid sharing passwords with other users.
Control access to user profile for XA GC using admin password of sufficient
complexity
• The admin password length should be at least 10 alphanumeric characters.
• The admin password should include at least one number, mix of upper/lower case

characters, and at least one special character (!@#$%^&*_-+=:?)
• The default admin password should be changed after GC commissioning by using the

password complexity guidelines.
• Avoid sharing the password with non-admin users.
Upload/download files of the approved types to/from XA GC
• Upload/download files of the approved types to/from XA GC.
• The approved files of type include .xls, .xlsx, .pdf, .tif/.tiff, .xrted (XA trend file), .xcgm (XA

chromatogram file), and .xcmp (XA comparison file).
• Scan the mass storage device with the latest anti-virus software before uploading any

files to GC.
Check integrity for distributed binaries
• A hash value will be provided for some software/firmware files distributed by Emerson

GC, so that the user can verify the integrity of the file.
• The hashing algorithm SHA-256 is used for calculating the hash value of the binary file.
• There are many programs for calculating the SHA-256 hash including Windows

Command Prompt, Windows PowerShell, and third-party software (such as Hash Tool).
The user can use a program of choice to calculate the SHA-256 hash value of the
downloaded file and compare it to the value specified on the download page.

• The following is an example of using Windows Command Prompt to calculate the
SHA-256 hash value:
— In a command line, run the command:

• certutil -hashfile [filename] SHA256
— For example:

Cybersecurity recommendations for Rosemount XA gas chromatograph (GC) and MON2020 users Manual
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2  Overview
2.1  System description

The Rosemount 700XA is a high-speed gas chromatograph (GC) system that is engineered
to meet specific field application requirements based on typical hydrocarbon stream
composition and anticipated concentration of selected components. In its standard
configuration, the analyzer can handle up to eight streams: seven sample streams and
one calibration stream.
The 700XA system consists of two major parts: the analyzer assembly and the electronics
assembly. Depending upon the particular GC, there may also be a third, optional assembly
called the sample conditioning system (SCS).
The electronics and hardware are housed in an explosion-proof enclosure that meets the
approval guidelines of various certification agencies for use in hazardous environments.
See the certification tag on the GC for specific details about agency approvals.

2.1.1  Analyzer assembly
The analyzer assembly includes:
• Columns
• Thermal conductivity detectors (TCDs)
• Flame ionization detectors (FIDs)
• Flame photometric detector (FPD)
• Preamplifier
• Preamplifier power supply
• Stream switching valves
• Analytical valves
• Solenoids
Additionally, the gas chromatograph (GC) can be equipped with a liquid sample injection
valve (LSIV) or methanator.
Related information
Upper compartment

2.1.2  Electronics assembly
The electronics assembly includes the electronics and ports necessary for signal
processing, instrument control, data storage, personal computer (PC) interface, and
telecommunications.
Use the electronics assembly and Rosemount MON2020 to control the gas chromatograph
(GC).
The GC-to-PC interface provides you with the greatest capability, ease-of-use, and
flexibility. You can use MON2020 to edit applications, monitor operations, calibrate
streams, and display analysis chromatograms and reports, which you can then store as
files on the PC’s hard drive or print from a printer connected to the PC.
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 WARNING
Hazardous area explosion hazard
Failure to follow this warning may result in injury or death to personnel.

Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the analyzer to
the PC and to connect to other computers and printers in a safe area.

2.1.3  Sample conditioning system (SCS)
The optional sample conditioning system is located between the process stream and the
sample inlet, which is often mounted below the gas chromatograph (GC).
The standard SCS configuration includes a stream switching system and filters.

2.2  Functional description
A sample probe installed in the process line takes a sample of the gas to be analyzed from
the process stream. The sample passes through a sample line to the sample conditioning
system (SCS) where it is filtered or otherwise conditioned. After conditioning, the sample
flows to the analyzer assembly for separation and detection of the gas components.

Figure 2-1: Gas chromatography process model

A. Process line
B. Probe
C. Sample system
D. Chromatograph oven
E. Gas chromatograph (GC) controller
F. Sample return
G. Slip stream
H. Carrier gas
I. Reference vent
J. Detector vent

K. Analysis results

Overview Manual
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Separation and analysis
The GC separates the sample gas into its components as follows:

1. A precise volume of sample gas is injected into one of the analytical columns. The
column contains a stationary phase (packing) that is either an active solid or an inert
solid support that is coated with a liquid phase (absorption partitioning).

2. A mobile phase (carrier gas) moves the sample gas through the column.
3. The selective retardation of the components takes place in the column, causing

each component to move through the column at a different rate. This separates the
sample into its constituent gases and vapors.

4. A detector located at the outlet of the analytical column senses the elution of
components from the column and produces electrical outputs proportional to the
concentration of each component.

Output from the electronic assembly is normally displayed on a remotely located personal
computer (PC) or in a distributed control system (flow computer).
To connect the GC to a PC, use a direct serial line, an optional Ethernet cable, or a
Modbus®-compatible communication interface.
You can use Rosemount MON2020 to display several chromatograms with separate color
schemes, allowing you to compare present and past data.
In most cases, it is essential to use MON2020 to configure and troubleshoot the GC. The
PC may be remotely connected via Ethernet, telephone, radio, or satellite communications.
Once installed and configured, the GC can operate independently for long periods of time.

2.3  Software description
The gas chromatograph (GC) uses two distinct types of software. This enables total
flexibility in defining the calculation sequence, report content, format, type, and amount of
data for viewing, control, and/or transmission to another computer or controller assembly.
The two types are:
• Embedded GC firmware
• Rosemount MON2020 software
Emerson installs the RTOS firmware and the application software before shipping the GC.
Emerson tailors the application configuration to the customer's process and ships the
configuration on a USB stick with the GC. Emerson also tests the hardware and software
together as a unit before the equipment leaves the factory.
MON2020 communicates with the GC; you can use it to initiate site system setup, such as
operational parameters, application modifications, and maintenance.

2.3.1  Embedded gas chromatograph (GC) firmware
The GC’s embedded firmware supervises operation of the GC through its internal
microprocessor-based controller.
All direct hardware interface is via this control software. It consists of a multitasking
program that controls separate tasks in system operation, as well as hardware self-testing,
user application downloading, start-up, and communication. After configuration, the GC
can operate as a stand-alone unit.
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2.3.2  Rosemount MON2020
The MON2020 software provides you with control of the gas chromatograph (GC),
monitors analysis results, and inspects and edits various parameters that affect the
analyzer operation. It also controls display and printout of the chromatograms and reports,
and it stops and starts automatic analysis cycling or calibration runs.
After the equipment/software has been installed and the operation stabilized, automatic
operation takes place over an Ethernet network.
MON2020 is a Windows™-based program that allows you to maintain, operate, and
troubleshoot a GC. Individual GC functions that can be initiated or controlled by MON2020
include, but are not limited to, the following:
• Valve activations
• Timing adjustments
• Stream sequences
• Calibrations
• Baseline runs
• Analyses
• Halt operation
• Stream/detector/heater assignments
• Stream/component table assignments
• Stream/calculation assignments
• Diagnostics
• Alarm and event processing
• Event sequence changes
• Component table adjustments
• Calculation adjustments
• Alarm parameters adjustments
• Analog scale adjustments
• Local operator interface (LOI) variable assignments (optional)
Reports and logs that can be produced, depending upon the GC application in use, include,
but are not limited to, the following:
• Configuration report
• Parameter list
• Analysis chromatogram
• Chromatogram comparison
• Alarm log (unacknowledged and active alarms)
• Event log
• Various analysis reports

Overview Manual
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2.4  Theory of operation
Related information
Glossary

2.4.1  Thermal conductivity detector (TCD)
One of the detectors available on the gas chromatograph (GC) is a TCD, which consists of
a balanced bridge network with heat sensitive thermistors in each leg of the bridge. Each
thermistor is enclosed in a separate chamber of the detector block.
One thermistor is designated the reference element, and the other thermistor is
designated the measurement element. See Figure 2-2 for a schematic diagram of the TCD.

Figure 2-2: Analyzer assembly with TCD bridge

A. Detector block (in heated oven section of analyzer)
B. Reference flow (carrier gas)
C. Measurement flow ("MV")
D. Signal out
E. Preamplifier (in analyzer electronics housing)
F. Detector bridge
G. DC power
H. Valves, columns, etc.

Manual Overview
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In the quiescent condition, prior to injecting a sample, both legs of the bridge are exposed
to pure carrier gas. In this condition, the bridge is balanced, and the bridge output is
electrically nulled.
The analysis begins when the sample valve injects a fixed volume of sample into the
column. The continuous flow of carrier gas moves the sample through the column. As
successive components elute from the column, the temperature of the measurement
element changes.
The temperature change unbalances the bridge and produces an electrical output
proportional to the component concentration.
The differential signal developed between the two thermistors is amplified by the
preamplifier. Figure 2-3 illustrates the change in detector electrical output during elution of
a component.

Figure 2-3: Detector output during component elution

A. Detector bridge balanced
B. Component begins to elute from column and is measured by thermistor.
C. Peak concentration of component

In addition to amplifying the differential signal developed between the two thermistors,
the preamplifier supplies drive current to the detector bridge.
The signal is proportional to the concentration of a component detected in the gas
sample. The preamplifier provides four different gain channels as well as compensation
for baseline drift.
The signals from the preamplifier are sent to the electronic assembly for component
concentration computation, recording, or viewing on a personal computer (PC) with
Rosemount MON2020.

2.4.2  Flame ionization detector (FID)
Another detector available for the Rosemount 700XA is the flame ionization detector (FID).
The FID requires a polarization voltage, and its output is connected to the input with a high
impedance amplifier that is called an electrometer. The burner uses a mixture of hydrogen
and air to maintain the flame. The sample of gas to be measured is also injected into the
burner. See Figure 2-4 for a schematic diagram of the FID.
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Figure 2-4: Analyzer assembly with FID detector bridge

A. Polarizing voltage
B. Electrometer
C. Signal out
D. Sample/hydrogen (H2)
E. Air

2.4.3  Micro flame photometric detector (µFPD) burner
The flame photometric detector (FPD) is a very sensitive and selective detector for the
analysis of sulfur or organophosphorus containing compounds. The detector is very stable
and easy to use.
As the analyte is burned in a hydrogen and air flame, a characteristic wavelength of light
is emitted at 394 nm for sulfur. The emitted light is amplified by the photomultiplier tube
(PMT) and processed by the signal processor. The response to phosphorus is linear, and
the response to sulfur is quadratic.
The Emerson µFPD solution consists of three key parts: burner, fiber cable, and PMT
electronics. The hydrogen and air in the burner help to burn the sample containing sulfur
components. The light emitted from the chemical reaction is then transmitted using the
fiber cable from the oven assembly to the electronics module. The PMT electronics module
consists of a 394 nm filter, a photomultiplier tube , and all the necessary electronics to
digitize the signal. The digital signal is then transmitted to the main central processing unit
(CPU) using CAN bus.
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Figure 2-5: µFPD burner - front view

A. µFPD burner
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Figure 2-6: µFPD burner - back view

A. µFPD burner
B. Fiber cable
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Figure 2-7: µFPD burner - side view

A. µFPD burner and cable
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Figure 2-8: µFPD PMT

A. µFPD PMT in the upper enclosure

The detection system in the µFPD uses the reactions of sulfur components in a
hydrogen/air flame as a source for analytical detection. The source of the µFPD's signal is
derived from the light produced by an excited molecule created in the flame's combustion,
that is, a photochemical process called chemiluminescence. A thermocouple is fitted to the
flame cell to ensure that the flame is present. If the flame is not detected, the electrometer
shuts off the hydrogen to the flame cell. It then supplies a voltage to the igniter, waits five
seconds, and opens the hydrogen shut off valve. The electrometer will make between one
and five ignition attempts if necessary. You can select the number of ignition attempts on
the Hardware → Detector screen. If the electrometer does not succeed in igniting, then the
gas chromatograph (GC) shuts off the hydrogen, triggers an alarm, and waits for attention
from the operator.
Related information
Micro flame photometric detector (µFPD)

2.4.4  Micro flame photometric detector (µFPD) electronics
module
The electronics module contains two chambers. The internal chamber contains the photo
multiplier tube (PMT) to insulate it from outside temperature changes. The external
chamber is a thermo-electric cooler (TEC) controlled chamber, which houses the internal
chamber along with the electronic board that generates high voltage power through the
PMT.

Manual Overview
MS-00809-0100-0700 November 2023

Rosemount 700XA 21



Figure 2-9: Electronics module, exploded view

A. Apply thermal compound to both sides.

Overview Manual
November 2023 MS-00809-0100-0700

22 Emerson.com



Figure 2-10: Electronics module, detailed

A. Maier photonics filter
B. O-ring

On the outside of the external chamber is the electronics main board. This board is the
vital part of the µFPD electronics module. It controls the temperature of the TEC, provides
power to the igniter, monitors the flame temperature, and digitizes the PMT signal and
transmits to the main central processing unit (CPU) using CAN bus.
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2.4.5  Liquid sample injection valve (LSIV)
The optional LSIV converts a liquid sample into a gas sample for analysis.

Figure 2-11: LSIV cross section

A. Liquid sample
B. Air supply: four-way action
C. Thermal barrier adapter flange: polyether ether ketone (PEEK)
D. O-ring
E. Heater element

Figure 2-12: LSIV
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The LSIV penetrates the wall of the lower compartment and is held in place by a retaining
ring.
The mounting arrangement is designed to ensure integrity of the flameproof enclosure.
The flash chamber block is stainless steel and is surrounded by an insulating mounting
adapter. It houses the heater and an RTD.
The next section houses sample input connections and stem sealing components. There
are two ⅛-in. outer dimension (OD) tubing ports in this section; one port is for sample
input, the other is the exhaust for sample flow.
The flash chamber components are within the enclosure cavity and surrounded with
insulating covers. At working temperatures, the surfaces of these covers become very hot
to the touch.
The tip of the cylindrical flash chamber is the port where the flashed sample is taken to
the oven system. The port near the outer diameter of the end of the heated flash chamber
block is the input for carrier gas.

2.4.6  Methanator
After all other components have been separated from the sample, carbon monoxide and
carbon dioxide, which are normally present in quantities too small to be detected by
the gas chromatograph (GC), can be sent through the optional methanator, where the
two gases are combined with hydrogen to make methane in a heat-generated catalytic
reaction.
The methanator is also known as a methanizer or catalytic converter.

2.4.7  Data acquisition
Every second, the controller assembly takes exactly 50 equally spaced data samples (one
data sample every 20 milliseconds).
As a part of the data acquisition process, groups of incoming data samples are averaged
together before the result is stored for processing. Non-overlapping groups of 50 samples
are averaged and stored, and thus reduce the effective incoming data rate to 50/10
samples per second. For example, if N = 5, then a total of 40/5 or 8 (averaged) data samples
are stored every second.
The value for the variable N is determined by the selection of a peak width parameter (PW).
The relationship is
N = PW
where PW is given in seconds. Allowable values of N are 1 to 63; this range corresponds to
PW values of 2 to 63 seconds.
The variable N is known as the integration factor. This term is used because N determines
how many points are averaged, or integrated, to form a single value. The integration of
data upon input, before storing, serves two purposes:
• The statistical noise on the input signal is reduced by the square root of N. In the case

of N = 4, a noise reduction of 2 would be realized.
• The integration factor controls the bandwidth of the chromatograph signal. It is

necessary to match the bandwidth of the input signal to that of the analysis algorithms
in the controller assembly. This prevents small, short-duration perturbations from
being recognized as true peaks by the program. It is therefore important to choose
a peak width that corresponds to the narrowest peak in the group under consideration.
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2.4.8  Peak detection
For normal area or peak height concentration evaluation, the determination of a peak's
start point and end point is automatic.
The manual determination of start and end points is used only for area calculations in
Forced Integration mode. Automatic determination of peak onset or start is initiated
whenever Integrate Inhibit is turned off. Analysis is started in a region of signal quiescence
and stability, such that the signal level and activity can be considered as baseline values.
Note
The controller assembly software assumes that a region of signal quiescence and stability
will exist.

Having initiated a peak search by turning Integrate Inhibit off, the controller assembly
performs a point by point examination of the signal slope. It does this by using a digital
slope detection filter, a combination low pass filter and differentiator. The output is
continually compared to a user-defined system constant called Slope Sensitivity. A
default value of 8 is assumed if no entry is made. Lower values make peak onset detection
more sensitive, and higher values make detection less sensitive. Higher values (20 to 100)
would be appropriate for noisy signals, (such as high amplifier gain).
Onset is defined where the detector output exceeds the baseline constant, but peak
termination is defined where the detector output is less than the same constant.
Sequences of fused peaks are also automatically handled. This is done by testing each
termination point to see if the region immediately following it satisfies the criteria of a
baseline. A baseline region must have a slope detector value less than the magnitude of
the baseline constant for a number of sequential points. When a baseline region is found,
this terminates a sequence of peaks.
A zero reference line for peak height and area determination is established by extending a
line from the point of the onset of the peak sequence to the point of the termination. The
values of these two points are found by averaging the four integrated points just prior to
the onset point and just after the termination points, respectively.
The zero reference line will, in general, be non-horizontal, and thus compensates for any
linear drift in the system from the time the peak sequence starts until it ends.
In a single peak situation, peak area is the area of the component peak between the curve
and the zero reference line. The peak height is the distance from the zero reference line
to the maximum point on the component curve. The value and location of the maximum
point is determined from quadratic interpolation through the three highest points at the
peak of the discrete value curve stored in the controller assembly.
For fused peak sequences, this interpolation technique is used both for peaks, as well as
valleys (minimum points). In the latter case, lines are dropped from the interpolated valley
points to the zero reference line to partition the fused peak areas into individual peaks.
The use of quadratic interpolation improves both area and height calculation accuracy and
eliminates the effects of variations in the integration factor on these calculations.
For calibration, the controller assembly may average several analyses of the calibration
stream.

2.4.9  Basic analysis computations
Two basic analysis algorithms are included in the controller assembly:
Area analysis Calculates area under component peak.

Overview Manual
November 2023 MS-00809-0100-0700

26 Emerson.com



Peak height analysis Measures height of component peak.

Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.

Concentration analysis - response factor
Concentration calculations require a unique response factor for each component in an
analysis. You can enter these response factors manually, or the system can automatically
determine them through calibration procedures (with a calibration gas mixture that has
known concentrations).
The response factor calculation, using the external standard, is:

where
ARFn Area response factor for component n in area per mole percent
Arean Area associated with component n in calibration gas
Caln Amount of component n in mole percent in calibration gas
Htn Peak height associated with component n mole percent in calibration gas
HRFn Peak height response factor for component n

The controller assembly stores calculated response factors to use in the concentration
calculations; these response factors are printed out in the configuration and calibration
reports.
Average response factor is calculated as follows:

where
RFAVGn Area or height average response factor for component n
RFi Area or height average response factor for component n from the calibration run
k Number of calibration runs used to calculate the response factors

The percent deviation of new RF averages from old RF average is calculated in the following
manner:

where the absolute value of percent deviation has been previously entered by the
operator.
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Concentration calculation - mole percentage (without
normalization)
After response factors have been determined by the controller assembly or entered by
the operator, component concentrations are determined for each analysis by using the
following equations:

where:
ARFn Area response factor for component n in area per mole percent
Arean Area associated with component n in unknown sample
CONCn Concentration of component n in mole percent
Htn Peak height associated with component n mole percent in unknown sample
HRFn Peak height response factor for component n

Component concentrations may also be input through analog inputs 1 to 4 or may be
fixed. If a fixed value is used, the calibration for that component is the mole percent that
will be used for all analyses.

Concentration calculation in mole percentage (with
normalization)
The normalized concentration calculation is:

where:
CONCNn Normalized concentration of component n in percent of total gas concentration
CONCi Non-normalized concentration of component n in mole percent for each k

component
CONCn Non-normalized concentration of component n in mole percent
k Number of components to be included in the normalization

Note
The average concentration of each component will also be calculated when data averaging
is requested.
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3  Equipment description and
specifications

3.1  Equipment description
The Rosemount 700XA consists of a copper-free aluminum explosionproof chamber and a
front panel assembly. The chamber is divided into two compartments that together house
the gas chromatograph's (GC's) major components. Emerson has designed this GC for
hazardous locations.

Figure 3-1: Rosemount 700XA Gas Chromatograph

A. Upper compartment
B. Lower compartment
C. Front panel assembly
D. Mechanical regulators
E. Sampling system (optional)
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3.1.1  Front panel assembly
The front panel assembly is located on the front section of the lower enclosure and
consists of a removable, explosion-proof panel that shields either a switch panel or a local
operator interface (LOI).

Figure 3-2: 8-stream switch panel (left) and 18-stream switch panel (right)

Switch panel
The switch panel contains a network of On/Off switches that allow you to manually control
the gas chromatograph's (GC's) stream and analytical valves.
There are two types of switch panels: 8-stream and 18-stream. The 8-stream switch panel is
the standard panel and is used when the GC has only one heater/solenoid board installed;
if two heater/solenoid boards are installed, then the 18-stream switch panel is used.

Figure 3-3: Stream valve switches

A valve has the following three operational modes:
AUTO The valve turns on and off according to the Timed Events table (accessible through

Rosemount MON2020). To set a valve to AUTO mode, set its switch on the switch
panel to the Up position.

OFF The valve turns off and remains off until the operational mode is changed. To set
a valve to OFF mode, set its switch on the switch panel to the Center position (the
switch is neither flipped up nor down).
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ON The valve turns on and remains on until the operational mode is changed. To set a
valve to ON mode, set its switch on the switch panel to the Down position.

Figure 3-4: Status LEDs

Top of switch panel

The switch panels also contain the following status lights that allow you to monitor the GC’s
condition:
Working Turns green when the GC is in Analysis mode.
Unack. Alarm Turns yellow if there is an unacknowledged alarm.
Active Alarm Turns red if there is an active alarm.

Flame
ionization
detector
(FID)/flame
photometric
detector (FPD)

The 18-stream switch panel contains an FID or FPD status LED that can
indicate the following:
• A green light means the flame has ignited.
• A flashing yellow light means an attempt is being made to ignite the

flame.
• A red light means the flame as gone out or that the FID or FPD is

over-temperature.

Figure 3-5: FID/FPD status LED
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Figure 3-6: Status LEDs (bottom of switch panel)

MON2020 detects the FID and FPD statuses. You can ignite the flame manually or remotely
using MON2020.

Figure 3-7: MON2020 status indicators

Note
During GC start up, all LEDs turn on for approximately ten seconds.
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Local operator interface (LOI)
The optional LOI gives you in-depth control over the functions of the gas chromatograph
(GC).
The LOI has a high resolution color display that is touch key activated and allows you to
operate the GC without a computer.

Figure 3-8: LOI

The LOI includes the following features:
• Color LCD display with VGA (640 x 480 pixels) resolution
• ASCII text and graphics modes
• Adjustable auto-backlighting
• Eight infrared-activated touch screen keys that eliminate the requirement for a

magnetic pen
• Complete GC status, control, and diagnostics, including full chromatogram display
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3.1.2  Upper compartment
The upper compartment contains the following components:
Valves There are two types of XA valves: 6-port and 10-port. A gas

chromatograph (GC) can have a maximum of six XA valves
consisting of a maximum of four 10-port valves.

Column module Either capillary or micro-packed.
Thermal conductivity
detector (TCD)

The GC has a maximum of two TCDs as well as a micro flame
photometric detector (µFPD) or a flame ionization detector (FID).

Two heating elements A top hat heater and a column heater.
One temperature
switch for each
heating element

The switch turns off its heating element if the heating element
reaches 320 °F (160 °C).

Pressure switch The pressure switch activates when the carrier pressure falls below
a predetermined set point. When activated, the switch triggers a
general alarm that displays on the front panel or local operator
interface (LOI) and in Rosemount MON2020.

Flame ionization
detector (FID)

The optional FID detects trace levels of hydrocarbons.

Flame photometric
detector (FPD)

The optional FPD, which detects trace levels of sulfur
compounds, can be used in place of a TCD, installed as
a side car component. For more information, refer to the
FPD for Gas Chromatographs Hardware Reference Manual.

Micro flame
photometric detector
(µFPD)

The optional integral µFPD detects trace levels of sulfur
compounds.

Methanator The methanator, or catalytic converter, is an optional component
that converts otherwise undetectable carbon dioxide and/or
carbon monoxide into methane by adding hydrogen and heat to
the sample.

Liquid sample
injection valve (LSIV)

The optional LSIV can vaporize a liquid sample, thereby expanding
the GC’s capability to measure liquids.

Related information
Micro flame photometric detector (µFPD)
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3.1.3  Lower compartment
The lower compartment consists of the following components:
Backplane The backplane is the gas chromatograph's (GC's) central printed circuit

board (PCB). Its main function is as a connection point for the GC's
specialized plug-in PCBs. The backplane also hosts connections for analog
outputs and analog inputs, serial ports, and an Ethernet port.

Card cage  WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely
injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure
that the area is free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to
enclosure.

The card cage holds the specialized PCBs that plug into the backplane. The
following PCBs are housed in the card cage:
• Preamplifier board
• Central processing unit (CPU) board
• Base input/output (I/O) board
• Heater/solenoid board
The card cage also has four additional slots for the following optional PCBs:
• A second preamplifier board
• A second heater/solenoid board
• Two optional communications boards

Optional
AC/DC
power
supply

 WARNING
Electric shock
Failure to check the power supply label may result in injury or death to
personnel or cause damage to the equipment. Applying 110 to 220 Vac to a
DC power input GC severely damages the GC.

See power supply label prior to connection.
Check the GC's power design to determine if it is equipped for AC or DC
power.

Note
The Rosemount 700XA CSA-certified unit is equipped with ¾-in. NPT
adapters.
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3.1.4  Mechanical pressure regulators
The mechanical pressure regulators and gauges are used to set and monitor the pressure
of the carrier gas flow through the gas chromatograph's columns, as well as the pressure
of the flame ionization detector (FID) or flame photometric detector (FPD) air and fuel (H2),
if installed.
The regulators and gauges are typically located on front of the analyzer below the
electronics enclosure.

Figure 3-9: Regulators and gauges

Equipment description and specifications Manual
November 2023 MS-00809-0100-0700

36 Emerson.com



3.2  Specifications
Type Specification
Dimensions (without sampling
system)

Height x width x depth: 50 in. (12700 mm) x 40 in. (1016 mm) x 24 in. (610
mm)

Weight (without sampling system) Approximately 150 lb. (68 kg)
Mounting Wall mount (standard)

Free-standing (optional)
Power usage 125 to 250 W
Valve actuation Sample gas: 90 psig (6 barg) maximum

Carrier gas: 90 psig (6 barg) maximum
Actuation gas: 110 psig (8 barg) maximum

Environment
Indoor/outdoor

Thermal conductivity detector (TCD): -4 to +140 °F (-20 to +60 °C)
Flame ionization detector (FID): +32 to +140 °F (0 to +60 °C)
Flame photometric detector (FPD): +32 to +122 °F (0 to +50 °C)

Hazardous area certifications
(hardware dependent)

USA and Canada
Class I, Zone 1, Ex/AEx db IIC, Gb T6/T4/T3
Class I, Division 1, Groups B, C, and D, IP66
EU ATEX and IECEx
Ex db IIC Gb T6/T4/T3
Ta = -4 to +140 °F (-20 to +60 °C)
SIRA 08ATEX 1328X
IECEx SIR 08.0093X
UKCA
CSAE 23UKEX1077X

Consult factory for additional product certifications available.
Table 3-1: Approval temperature ratings
T6 Basic system; no alternative options included
T4 Liquid sample injection valve (LSIV) option included
T4 Heat trace option with a maximum +176 °F (+80 °C) temperature switch set point
T3 Heat trace option with a maximum +230 °F (+110 °C) temperature switch set point
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3.2.1  Electronics hardware
Type Specifications
Communication (standard) • Analog inputs:

— Two standard 4-20 mA inputs filtered with transient protection
• Analog outputs:

— Six isolated outputs, 4–20 mA
• Serial communication ports:

— Three termination blocks
— Configurable as RS-232, RS-422, or RS-485
— One D-sub (9-pin) port for personal computer (PC) connection

• Digital inputs:
— Five inputs, user assignable
— Optically isolated, rated to 30 Vdc at 0.5 A

• Digital outputs:
— Five outputs, user assignable
— Form C and electro-mechanically isolated, 24 Vdc

Communication (optional) Four expansion slots available for additional communications. Each slot has the
capacity to add one of the following:
• Four analog inputs (isolated) card
• Four analog outputs (isolated) card
• Eight digital inputs (isolated) card
• Five digital outputs (isolated) card
• One RS-232, RS-422, or RS-485 serial connection card (up to two maximum)

Ethernet Two available connections
• One RJ45 port
• One 4-wire termination – with 10/100 Mbps
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3.2.2  Airless analytical oven
Type Specification
Valves 6-port and 10-port XA valves; piston-operated diaphragms with pneumatic actuation
Columns Maximum of 90 ft. (27 m) of micro-packed columns; 1/16-in. outside diameter

or
300 ft. (91 m) of capillary columns

Solenoid actuation 24 Vdc
Maximum 100 psig (7 barg)

Temperature control 24 Vdc
2 heaters
2 optional heaters
Maximum oven operating temperature of +302 °F (+150 °C)

3.2.3  Software
Type Specification
Software Windows™-based Rosemount MON2020
Firmware Embedded firmware
Methods 8 Timed Event tables and 8 Component Data tables
Analysis clocks Multiple analysis clock configurations
Peak integration Fixed time or auto slope and peak identification

Update retention time upon calibration or during analysis
Cyber security Encrypted SSL communication between gas chromatograph (GC) and MON2020

3.2.4  Corrosion protection
Type Specification
Enclosure material Copper-free and aluminum-coated with industrial grade powder coat suitable for high

humidity and salt-laden environments.
Process wetted materials Stainless steel; if the function of an item excludes the use of stainless steel, such as

the glass rotameter tubes, materials that are resistant to corrosion are used.
Electronics All electronic circuit boards are covered with a clear conformal coating.

3.2.5  Archived data storage capabilities
Type of record Number of records Remarks
Analysis results 31,744 88 days with 4-minute cycle time
Final calibration results 370 1 year
Calibration results 100 N/A
Final validation results 370 1 year
Validation results 100 N/A
Analysis chromatograms 8,515(1) Approximately 22.5 days assuming running 4-

minute analysis and 1 analysis clock
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Type of record Number of records Remarks
Final calibration chromatograms 370 1 year(2)

Final validation chromatograms 370 1 year(2)

Protected chromatograms 100 User-selectable
Hourly averages(3) 250(1) Approximately 9 days, assuming 4-minute cycle

time
Daily averages 365 1 year
Weekly averages 58 1 year
Monthly averages 12 1 year
Variable averages 250(1) N/A
Every run (up to 250 variables) 250(1) N/A
Alarm logs 1000 N/A
Event logs 1000 N/A

(1) Changed from 2.0.x release.
(2) The gas chromatograph (GC) can store final calibration and validation chromatograms for a year, provided

that no more than one calibration/validation is run per day and the cycle time is less than 15 minutes. If the
cycle time exceeds 15 minutes, the oldest final calibration/validation chromatograms are deleted to make
room for newer ones.

(3) You can have a total of 256 averages, including hourly, 24-hour, weekly, monthly, variable, and every run
averages.
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4  Getting started
Emerson started and inspected your gas chromatograph (GC) before it left the factory.
Emerson also installed program parameters and documented them in the GC Config
Report furnished with your GC.

4.1  Select site
The site you select for the gas chromatograph (GC) is important for measurement
accuracy.
Procedure
Install the GC as close as possible to the sample system, but allow for adequate access
space for maintenance tasks and adjustments.

 WARNING
Hazardous area explosion hazard
Failure to follow this warning may result in injury or death to personnel.

Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the analyzer to
the PC and to connect to other computers and printers in a safe area.

Allow a minimum of 3 ft. (0.9 m) in front of the GC for operator access. Ensure that
exposure to radio frequency interference (RFI) is minimal.

4.2  Unpack the gas chromatograph (GC)
Unpack and inspect the Rosemount 700XA upon receipt.

 WARNING
This device is heavy equipment. Two people are required to move the device.
Failure to observe this warning may cause serious injury to personnel.
Observe all proper lifting methods as defined by your site operating procedures.

Procedure
1. Unpack the equipment.

a) Remove the GC from the shipping crate.
b) Remove the USB memory stick containing the software, applications, quick

start guides, and manuals.
Note
The Rosemount MON2020 version number is located on the back of the USB
card.

2. Retain the shipping information.
3. Inspect all parts and assemblies for possible shipping damage.
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4. If any parts or assemblies appear to have been damaged in shipment, first file a
claim with the carrier.

5. Next, complete a full report describing the nature and extent of the damage and
forward this report immediately to your Emerson Customer Care representative.
Include the GC's model number in the report.
Emerson will provide disposition instructions as soon as possible. If you have
any questions regarding the claim process, contact your Emerson Customer Care
representative for assistance.

6. Only proceed to install and start up the GC if all required materials are on hand and
free from obvious defects.

7. If your GC is configured with an flame ionization detector (FID) or flame photometric
detector (FPD), remove the vent plug from the FID/FPD outlet.

NOTICE
The vent plug has a tag attached to it that reads: REMOVE VENT PLUGS PRIOR TO
OPERATION. Failure to remove the cap could result in a performance failure or
damage to the detector.

4.3  Required tools and components
You will need the following tools and components to install the gas chromatograph (GC).
• Zero grade carrier gas:

— 99.995% pure
— Less than 5 ppm water
— Less than 0.5 ppm hydrocarbons

• High pressure dual-stage regulator for the carrier gas cylinder
— High side up to 3000 psig (207 barg)
— Gauge (psig)
— Low side capable of controlling pressure up to 150 psig (10 barg)

• Calibration standard gas with correct number of components and concentrations
• Dual-stage regulator for the calibration gas cylinder with a low pressure side capable of

controlling pressure up to 30 psig (2 barg)
• Sample probe regulator (fixture for procuring the stream or sample gas for

chromatographic analysis)
• Coalescing filter
• Membrane filter
• ⅛-in. stainless steel tubing

— For connecting calibration gas to the GC
— For connecting carrier gas to the GC
— For connecting stream gas to the GC
— Sulfinert tubing required if sulfur components are present in calibration gas

• Heat tracing, as required for sample transport and calibration lines
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• Miscellaneous tube fittings, tubing benders, and tubing cutter
• 14 American wire gauge (AWG) (18 metric wire gauge [MWG]) or larger electrical wiring

and conduit to provide 120 or 240 Vac, single phase, 50 to 60 Hz, from an appropriate
circuit breaker and power disconnect switch.

• Digital volt-ohm meter with probe-type leads
• Flow measuring device
• Open-end wrenches sized:

— ¼-in.
— 5/16-in.
— 7/16-in.
— ½-in.
— 9/16-in.
— ⅝-in.

• Torque wrench
Related information
Gas chromatograph wiring

4.4  Supporting tools and components
 WARNING

Hazardous area explosion hazard
Failure to follow this warning may result in injury or death to personnel.

Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the analyzer to
the PC and to connect to other computers and printers in a safe area.

• Use a Windows™-based PC and either a direct or remote communications connection to
interface with the gas chromatograph (GC).
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.

• The GC comes with an Ethernet port on the backplane factory-wired with an RJ-45
connector.

Related information
Connect directly to a personal computer (PC) using the gas chromatograph's (GC’s)
Ethernet1 port
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5  Installation and start-up
Note
Because the Rosemount 700XA is available in different configurations, it is possible that not
all of the instructions in this section apply to your particular gas chromatograph (GC). In
most cases, however, to install and set up a 700XA, Emerson recommends that you follow
the instructions in the same order as they are presented in this manual.

5.1  Installation considerations
Before installing the gas chromatograph (GC):

1.  WARNING

The GC is heavy and has a high potential of injuring personnel or damaging
equipment.

Anchor the GC solidly before making electrical connections.
Until all bolts are tight, ensure that the GC is supported to prevent unforeseen
accidents.

2. Ensure that the connections to the enclosure meet local standards.
3. Use approved seals: either cable glands or conduit seals.

a. Install conduit seals within 3 in. (76 mm) of the enclosure.
b. Seal unused openings with approved blanks (plugs). Threads for these

openings are M32 x 1.5.

4. Remove any packing materials before powering up the GC.
5.  WARNING

Hazardous area explosion hazard
Failure to follow this warning may result in injury or death to personnel.

Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the
analyzer to the PC and to connect to other computers and printers in a safe area.

Related information
Mounting arrangements

5.2  Mounting arrangements
The Rosemount 700XA can be installed in one of the following mounting arrangements:
• Wall mount
• Pole mount
• Floor mount
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 WARNING
This device is heavy equipment. Two people are required to move the device.
Failure to observe this warning may cause serious injury to personnel.
Observe all proper lifting methods as defined by your site operating procedures.

5.2.1  Mount the gas chromatograph (GC) to the wall
The simplest mounting arrangement is the wall mount.
If you specify Wall Mount on the sales order, Emerson will ship the GC with a wall mount
installation kit. Four locations on the mounting ears are available for support.

 WARNING

The GC is heavy and has a high potential of injuring personnel or damaging equipment.
Anchor the GC solidly before making electrical connections.
Until all bolts are tight, ensure that the GC is supported to prevent unforeseen
accidents.

Figure 5-1: Wall mount

Prerequisites
Pre-install a pair of 7/16-in diameter bolts with washers on the wall before installing the
final pair of bolts.
The first pair of bolts should be approximately 41.63 in. (1057 mm) off the ground, and
13.63 in. (346 mm) apart. Each bolt should have 0.63 in. (16 mm) of bare length projecting.
Drill a second pair of holes 3.56 in. (90.4 mm) above the first.

Installation and start-up Manual
November 2023 MS-00809-0100-0700

46 Emerson.com



Procedure
1. Maneuver the GC so that the notches in the mounting ears can be placed over the

bolts on the wall and then place the washers over the bolts.
2. Install the second pair of bolts with washers and then tighten all the bolts.

5.2.2  Mount the gas chromatograph (GC) to a pole
The pole mount arrangement uses an additional plate and spacers to allow the necessary
clearance for nuts.
If you specify Pole Mount on the sales order, Emerson will provide the necessary hardware.

 WARNING

The GC is heavy and has a high potential of injuring personnel or damaging equipment.
Anchor the GC solidly before making electrical connections.
Until all bolts are tight, ensure that the GC is supported to prevent unforeseen
accidents.

Figure 5-2: Pole mount

Procedure
1. Use the U-bolt to firmly install the large plate on the pole about 44 in. (1118 mm)

above the ground.
2. Install the long bolts and spacers.
3. Place nuts and washers on the lower bolts.
4. Install the small plate just tightly enough to hold its position, with the small plate’s

U-bolt about 6.88 in. (174. 8 mm) below the large plate’s U-bolt.
5. Hold the matching spacer in place with the bolts installed loosely.
6. Orient the GC so that the notches in the mounting ears can be placed over the lower

bolts on the plate and then add the washers and nuts.
7. Place the nuts with washers on the upper bolts and then tighten all bolts.
8. Adjust the lower bracket to align the bolts with the plate. Tighten the bolts.
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5.2.3  Mount the gas chromatograph (GC) on the floor
If you specify Floor Mount in the sales order, Emerson sends the floor mounting
arrangement pre-assembled with the GC.
The arrangement includes an additional support stand that is intended to be anchored to a
floor or an instrument pad. The base rails have holes that are 13⅝ in. (346 mm) apart, side
to side, and 16¾ in. (425.4 mm) apart front to back. The holes are ½ in. (13 mm) in diameter
and will accept up to 7/16 in. (11 mm) bolts.

Figure 5-3: GC mounted on floor
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5.3  Gas chromatograph wiring
5.3.1  Wiring precautions

• All wiring, as well as circuit breaker or power disconnect switch locations, must conform
to the Canadian Electrical Code (CEC) or National Electrical Code (NEC); all local, state, or
other jurisdictions; and company standards and practices.

• Provide single-phase, three-wire power at 115 or 220 Vac, 50-60 Hz.
Note
If you do not have a single phase, three-wire AC power source, you must purchase an
isolation transformer.

• Locate a power shut-off or disconnect switch in a safe area.
• Provide the gas chromatograph (GC) and any optionally installed devices with one

20-amp circuit breaker for protection.
Note
15 amps is the maximum current for 14 American Wire Gauge (AWG).

• Ensure that the 24 Vdc input power is compliant with the separated extra-low voltage
(SELV) standard by suitable electrical separation from other circuits.

• Use multi-stranded copper conductor wire according to the following
recommendations:
— For power feed distances up to 250 ft. (76 m), use 14 AWG (18 metric wire gauge

[MWG]), stranded.
— For power feed distances 250 ft. (76 m) to 500 ft. (152 m), use 12 AWG (25 MWG),

stranded.
— For power feed distances 500 ft. (152 m) to 1000 ft. (305 m), use 10 AWG (30 MWG),

stranded.

5.3.2  Signal wiring
Follow these general precautions for field wiring digital and analog input/output (I/O) lines:
• For shielded signal conducting cables, shield-drain wires must not be more than two

American Wire Gauge (AWG) sizes smaller than the conductors for the cable. Shielding
is grounded at only one end.

• Metal conduit or cable (according to local code) used for process signal wiring must be
grounded at conduit support points, because intermittent grounding helps prevent the
induction of magnetic loops between the conduit and cable shielding.

• A single-point ground must be connected to a copper-clad, 10-ft. (3 m) long, ¾-in. (19
mm) diameter steel rod, which is buried, full-length, vertically into the soil as close to
the equipment as is practical.
Note
Emerson does not provide the grounding rod.
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Figure 5-4: Interior ground lug, lower enclosure

• Resistance between the copper-clad steel ground rod and the earth ground must not
exceed 25 Ohms.

• On ATEX-certified units, the external ground lug must be connected to the customer’s
protective ground system via 9 AWG (6 mm2) ground wire. After the connection is
made, apply a non-acidic grease to the surface of the external ground lug to prevent
corrosion.

• The equipment-grounding conductors used between the gas chromatograph (GC) and
the copper-clad steel ground rod must be sized according to your local regulations; the
following specifications apply in the US.
Length Wire
15 ft. (4.6 m) or less 8 AWG, stranded, insulated copper
15 ft. (4.6 m) to 30 ft. (9.1 m) 6 AWG, stranded, insulated copper
30 ft. (9.1 m) to 100 ft. (30.5 m) 4 AWG, stranded, insulated copper

• All interior enclosure equipment-grounding conductors must be protected by metal
conduit.

• External equipment that is connected to the GC should be powered via isolation
transformers to minimize the ground loops caused by the internally shared safety and
chassis grounds.

• All process signal wiring should be of a single, continuous length between field devices
and the GC. If, however, the length of the conduit runs require that multiple wiring
pulls be made, the individual conductors must be interconnected with suitable terminal
blocks.

• Use suitable lubrication for wire pulls in conduit to prevent wire stress.
• Use separate conduits for AC voltage and DC voltage circuits.
• Do not place digital or analog I/O lines in the same conduit as AC power circuits.
• Use only shielded cable for digital I/O line connections.

— Ground the shield at only one end.
— Shield-drain wires must not be more than two AWG sizes smaller than the

conductors for the cable.
• When inductive loads (relay coils) are driven by digital output lines, the inductive

transients must be diode-clamped directly at the coil.
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• Any auxiliary equipment wired to the GC must have its signal common isolated from
earth/chassis ground.

NOTICE
Signal interference
If you don't follow this precaution, the data and control signals to and from the GC could
be adversely affected.
Do not place any loop of extra cable left for service purposes inside the GC purged housing
near the conduit entry for AC power.

5.3.3  Electrical conduit installation precautions
• Conduit cutoffs must be cut at a 90-degree angle. Cut conduits with a cold cutting tool,

hacksaw, or by some other approved means that does not deform the conduit ends or
leave sharp edges.

• Coat all conduit fitting-threads, including factory-cut threads, with a metal-bearing
conducting grease prior to assembly.

• Temporarily cap the ends of all conduit runs immediately after installation to prevent
accumulation of water, dirt, or other contaminants. If necessary, swab out conduits
prior to installing the conductors.

• Install drain fittings at the lowest point in the conduit run; install seals at the point of
entry to the gas chromatograph (GC) to prevent vapor passage and accumulation of
moisture.

• Use liquid-tight conduit fittings for conduits exposed to moisture.
When a conduit is installed in hazardous areas, follow these general precautions for
conduit installation:
• All conduit runs must have a fitting, which contains explosionproof sealing (potting)

located within 3 in. (76 mm) from the conduit entrance to the explosionproof housing.
The seal should have a minimum ingress protection (IP) rating of IP54 or equivalent
NEMA®/Type rating on the conduit sealing devices.

• The conduit installation must be vapor tight, with threaded hub fittings, sealed conduit
joints and gaskets on covers, or other approved vapor-tight conduit fittings.

 WARNING

Failure to observe precautionary signs may result in serious injury or death to personnel.
Observe all precautionary signs posted on the certified explosionproof equipment. Consult
your company's polices and procedures and other applicable documents to determine
wiring and installation practices that are appropriate for hazardous areas.

5.3.4  Sample system requirements
Line length If possible, avoid long sample lines. In long flow sample lines, velocity can be

increased by decreasing downstream pressure and using bypass flow via a fast loop.
Note
Stream switching requires a sample pressure of 20 psig (1.4 barg).
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Sample line tubing material Use sulfur-inert tubing for H2S streams; for all other applications, use stainless steel
tubing.
Ensure tubing is clean and free of grease.

Dryers and filters Use small sizes to minimize time lag and prevent back diffusion.
Install a minimum of one filter to remove solid particles. Most applications require
fine-element filters upstream of the gas chromatograph (GC). The GC includes a
2-micron filter.
Use ceramic or porous metallic type filters. Do not use cork or felt filters.
Note
Install the probe/regulator first, immediately followed by the coalescing filter, and
then the membrane filter.

Pressure regulators and flow
controllers

Use stainless steel wetted materials.
Parts should be rated for sample pressure and temperature.

Pipe threads and dressings Use PTFE tape. Do not use pipe thread compounds or pipe dope.
Valving Install a block valve downstream of sample takeoff point for maintenance and

shutdown.
The block valve should be a needle valve or cock valve type, of proper material and
packing, and rated for process line pressure.

5.4  Electrical installation
NOTICE
Emerson switches off central processing unit (CPU) boards before shipping to preserve
their batteries. Before installing the CPU board, be sure to switch it on.
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Figure 5-5: CPU board

A. SW7 battery power ON

5.4.1  Connect power supply
 WARNING

Electrical hazard
Failure to follow this warning may result in injury or death to personnel or cause damage
to equipment.

Ensure that the 24 Vdc input power source is switched Off before connecting the wires.
Ensure that the 24 Vdc power supply is safety extra low voltage (SELV) compliant by
suitable electrical separation from other circuits.

NOTICE
Equipment damage
Failure to observe this precaution may damage equipment.
Check the gas chromatograph (GC) prior to wiring to determine if it is equipped for DC
power.
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Procedure
1. Locate the plug-together termination block inside the electronics enclosure.

Figure 5-6: 24 Vdc power connection on the backplane
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2. Bring the two leads in through one of the two possible entries on the lower
compartment. Connect to the termination plug provided with the GC.

Figure 5-7: Wiring entries on the under side of the lower enclosure

Attribute Wire color
+ (positive) red
– (negative) black

NOTICE
Do not disconnect the factory-installed ground wire.

The backplane board that connects to the 24 Vdc is protected from lead reversal by
the use of blocking diodes.
If the red (+) and black (-) leads are inadvertently reversed, no damage will occur;
however, the system will not have power.

3. Connect the DC power leads to the power disconnect switch that should be properly
fused.
The recommended fuse size is 8 amps.
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5.4.2  Connect optional AC/DC power converter
 WARNING

Failure to follow this warning may result in injury or death to personnel or cause damage
to equipment.
Check the gas chromatograph (GC) prior to wiring to determine if it is equipped for
optional AC power.

Procedure
1. Locate the plug-together termination block inside the electronics enclosure, atop

the power supply and adjacent to the card cage.

Figure 5-8: AC/DC termination block

 WARNING

Failure to follow this warning may result in injury or death to personnel or cause
damage to equipment.
Do not connect the AC power leads without first ensuring that the AC power source
is switched Off.

NOTICE
Failure to observe this precaution may cause damage to equipment.
Do not apply electrical power to the GC until all interconnections and external signal
connections have been verified and proper grounds have been made.

AC wiring is usually color coded as:
Label Wire color
Hot (H) Brown or black
Neutral (N) Blue or white
Ground (G) Green with yellow tracer or green

2. Bring the power leads in through the left entry on the bottom of the enclosure.
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3. If necessary at remote locations, connect the GC chassis ground wire to an external
copper ground rod.

Related information
Signal wiring

5.4.3  Connect gas lines
Procedure

1. Remove the plug from the 1/16-in. sample vent tubing marked SV1 that is located
on the flow panel assembly. Depending on your configuration, there may also be a
second sample vent marked SV2. If so, remove its plug as well.

Figure 5-9: Sample vent and measure vent lines

A. Sample vent
B. Measure vent

• If desired, connect the sample vent lines to an external, ambient pressure vent. If
the vent line is terminated in an area exposed to wind, protect the exposed vent
with a metal shield.

• Use ¼-in. or ⅜-in. tubing for vent lines longer than 10 ft. (3 m)
Note
Do not discard the vent line plugs. They are useful when leak-checking the gas
chromatograph (GC) and its sample or gas line connections.

At this stage in the installation, the measure vent (MV) lines (labeled on the side of
the GC) should remain plugged until the GC has been checked for leaks. For regular
operation, however, the MV lines must be unplugged.
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2. Connect the carrier gas to the GC.
The carrier gas inlet is labeled Carrier In and is a ¼-in. T-fitting.

 WARNING
Leak testing

All gas connections must be properly leak tested at installation.
Do not turn on gas until you have completely checked the carrier lines for leaks.

 WARNING
Explosion hazard
Failure to follow this warning may result in injury or death to personnel.
Do not turn on sample gas until you have completely checked the carrier lines for
leaks.

• Use stainless steel tubing to convey carrier gas.
• Use a dual-stage regulator with high-side capacity of 3,000 psig (206.8 barg) and

low-side capacity of 150 psig (10.3 barg).
• Carrier gas is fed from two bottles for carrier gas plumbing.
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3. Connect calibration standard gas to the GC.
When installing the calibration standard gas line, ensure that the correct tubing
connection is made.
• Use ⅛-in. stainless steel tubing to connect calibration standard gas unless the

application requires treated tubing.
• Use a dual-stage regulator with low-side capacity of up to 30 psig (2.1 barg)

Figure 5-10: Sample stream inlets and calibration gas inlet

A. Sample stream inlets
B. Calibration gas inlet

4. Connect sample gas stream(s) to the GC.
• Use ⅛-in. stainless steel tubing, as appropriate, to connect sample gas.
• Unless stated otherwise in the product documentation, ensure that the pressure

of the calibration and sample line is regulated at 15 psig (1 barg) to 20 psig (1.4
barg).

Postrequisites
After all lines have been installed, proceed with leak-checking the carrier and sample lines.
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5.4.4  Maximum effective distance by communication protocol
type
Table 5-1 lists the maximum distance at which the indicated protocol can transmit data
without losing effectiveness. If you need longer runs, use a repeater or other type of
extender to maintain the protocol's efficiency.
Table 5-1: Maximum distance for each communication protocol
Communication protocol Maximum distance
RS-232 50 ft. (15 m)
RS-422/RS-485 4,000 ft. (1,219 m)
Ethernet (CAT5) 300 ft. (91 m)

5.4.5  RS-485 serial port terminating resistors
To ensure correct communication with all hosts, place a 120-ohm terminating resistor
across the gas chromatograph (GC) serial port terminals on the RS-485 link. On a
multi-dropped link, install the terminating resistor on the last controller link only.

5.4.6  Installing and connecting to an analog modem card
The Rosemount 700XA has two slots (input/output [I/O] Slot A and I/O Slot B) in the card
cage for installing an analog modem.
Note
Rosemount MON2020 only recognizes Microsoft® Windows™-compatible modems that have
all relevant drivers installed correctly.

Note
Analog modems will only work with PSTN phone lines. Analog modems will not work with
voice over Internet protocol VOIP networks.

The following four LEDs are provided on the modem for troubleshooting:
RI (Ring indicator) This LED flashes when it senses a ring. This LED should only flash

once per connection, because the modem automatically answers on
the first ring.

CD (Carrier detect) This LED glows green while connected to MON2020.
RX (Receive) This LED flashes while the gas chromatograph (GC) receives data from

MON2020.
TX (Transmit) This LED flashes while the GC sends data to MON2020.

Install the analog modem
Procedure

1. Start Rosemount MON2020 and connect to the gas chromatograph (GC).
2. Go to Tools → I/O Cards....

The I/O Cards window displays.
3. Change the Card Type for the appropriate input/output (I/O) slot to

Communication Module - Modem.
4. Click Save.
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MON2020 displays the following message: The GC must be rebooted for
the ROC Card changes to take effect.

5. Click OK to dismiss the message.
6. Click OK to close the I/O Cards window.
7. Disconnect from the GC.
8. Turn off the GC.
9. Insert the analog modem card into the appropriate I/O slot in the GC’s card cage.

Ensure that the I/O slot matches the one you selected in Step 3.
10. Tighten the card’s screws to secure the modem in the slot.
11. Insert a telephone cable into the modem card’s RJ-11 socket.
12. Start the GC.
13. Return to MON2020 and connect to the GC via its Ethernet connection.
14. Go to Application → Communication....

The Communication window displays. The appropriate I/O slot should be listed in
the first column (Label).

15. Set the Baud Rate for the analog modem card to 57600.
16. Make note of the I/O slot’s Modbus® Id.
17. Click Save.
18. Click OK to close the Communication window.
19. Disconnect from the GC.

5.4.7  Connect directly to a personal computer (PC) using the gas
chromatograph's (GC’s) Ethernet1 port
The GC’s dynamic host configuration protocol (DHCP) server feature and its Ethernet1 port
on the backplane at J22 allows you to connect directly to the GC. This is a useful feature for
GCs that are not connected to a local area network; all that is needed is a PC, typically a
notebook computer, and a CAT5 Ethernet cable.
Procedure

1. Plug one end of the Ethernet cable into the PC’s Ethernet port and the other end into
the GC’s RJ45 socket on J22 on the backplane.
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2. Locate switch at SW1 directly beneath the Ethernet port on the backplane. Place
SW1 in the On position.
The switch labeled 2 is for future use.

Figure 5-11: SW1 switches on the backplane

Note
The GC can be connected (or remain connected) to the local network on Ethernet2
(TB11) on the backplane while the DHCP feature on Ethernet1 is being used.

This starts the GC’s DHCP server feature. The server typically takes approximately 20
seconds to initialize and start up.

3. Wait for 20 seconds and then do the following to ensure that the server has
provided an Internet protocol (IP) address to the PC:

a) From the PC, go to Start →  Control Panel →  Network Connections.
The Network Connections window lists all dial-up and local area network
(LAN)/high-speed Internet connections installed on the PC.

b) In the list of LAN/high speed Internet connections, find the icon that
corresponds to the PC-to-GC connection and check the status that displays
beneath the Local Area Connection.
It should show the status as Connected. The PC is now capable of connecting
to the GC.
If the status is Disconnected, it may be that the PC is not configured to accept
IP addresses. Proceed to Step 4

4. Right-click the Properties icon.
The Local Area Connection Properties window displays.

5. Scroll to the bottom of the Connection list box and select Internet Protocol
(TCP/IP).

6. To configure the PC to accept IP addresses issued from the GC, select the
Obtain an IP address automatically and Obtain DNS server address
automatically check boxes.

7. Click OK to save the changes and to close the Internet Protocol (TCP/IP) Properties
window.

8. Click OK to close the Local Area Connection Properties window.
9. Return to the Network Connections window and confirm that the appropriate icon’s

status reads Connected.
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Postrequisites
If the icon still reads Disconnected refer to Troubleshoot dynamic host configuration
protocol (DHCP) connectivity issues.
Note
If you power cycle the GC, you will lose connectivity.

5.4.8  Connect to the gas chromatograph (GC) using Rosemount
MON2020
To connect to the GC using the RJ45 Ethernet1 connection:

Procedure
1. Start MON2020.

The Connect to GC window displays.
2. Locate the default Direct-DHCP under the GC Name column.

This GC directory is created automatically when MON2020 is installed. You can
rename the GC, but do not change the Internet protocol (IP) address that it
references, 192.168.135.100.

3. Click the associated Ethernet button.
MON2020 prompts you to enter a user name and password.

4. Enter your user name and password.
MON2020 connects you to the GC.
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5.4.9  Troubleshoot dynamic host configuration protocol (DHCP)
connectivity issues

Recommended actions
1. Ensure that the gas chromatograph (GC) is up and running. If equipped with a

front panel, check the CPU LED on the front panel; a green light means that the
GC is operational. If equipped with a local operator interface (LOI), ensure that
the LOI is communicating with the GC.

2. Check that the SW1 switch is in the On position.
3. Check the following connections:

a) If you are using a Ethernet straight-through cable, ensure that the
personal computer (PC) has an Ethernet network interface card with
auto-MDIX.

b) If your Ethernet network interface card does not support auto-MDIX,
ensure that you are using an Ethernet crossover patch cable.
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c) Check to see if the GC's central processing unit (CPU) board link lights are
on.
See Figure 5-12. The three Ethernet1 LEDs are located on the front
bottom edge of the card. If link lights are off, check your connections.

Figure 5-12: CPU board link lights

A. CPU board
B. Ethernet link lights

4. Do the following to ensure that your network adapter is enabled:
a) Go to Start → Control Panel → Network Connections....
b) Check the status of the Local Area Connection icon. If the status appears

as Disabled, right-click the icon and select Enable from the context menu.

5. Do the following to try to repair the network connection:
a) Go to Start → Control Panel → Network Connections....
b) Right-click the Local Area Connection icon and select Repair from the

context menu.
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5.4.10  Connect directly to a personal computer (PC) using the gas
chromatograph's (GC's) serial port
The GC’s serial port at J23 on the backplane allows a PC with the same type of port to
connect directly to the GC.
This is a useful feature for a GC that is located in an area without Internet access;
all that is needed is a PC running Microsoft® Windows™, a notebook computer, and a
straight-through serial cable.

Figure 5-13: J23 serial port

A. J23 port

To set up the PC for the direct connection:
Procedure

1. Install the communications cable between two computers:
a) Navigate to Start → Control Panel and select the Phone and Modem icon.

The Phone and Modem screen displays.
b) Select the Modems tab and click Add….

The Add Hardware Wizard displays.
c) Select the Don’t detect my modem; I will select it from a list check box and

then click Next.
d) Click Have Disk.

The Install from Disk screen appears.
e) Click Browse

The Browse screen displays.
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f) Navigate to the Rosemount MON2020 install directory (typically C:\Program
Files (x86)\Emerson Process Management\MON2020) and select
Emerson Direct Connection.inf.

g) Click Open.
You return to the Install from Disk screen.

h) Click OK.
You return to the Add Hardware Wizard.

i) Click Next.
j) Select an available serial port and click Next.

The Hardware Installation screen displays.
k) Click Continue Anyway.

After the driver is installed, you return to the Add Hardware Wizard.
l) Click Finish.

You return to the Phones and Modems screen. The Emerson Direct Connect
modem should be listed in the Modem column.

2. Start MON2020 and do the following to create a GC connection for the Emerson
Direct Connection modem:

a) Go to File →  GC Directory....
The GC Directory screen displays.

b) Select Add from the GC Directory screen's File menu.
A New GC row is added to the bottom of the table.

c) Select the New GC text and type a new name for the GC connection.
d) Select the new GC’s Direct check box.
e) Click the Direct button located at the bottom of the GC Directory screen.

The Direct Connection Properties window displays.
f) Select Daniel Direct Connection (COM n) from the Port drop-down list.

NOTICE
The letter n stands for the COM port number.

g) Select 57600 from the Baud Rate drop-down list.
h) Click OK to save the settings.

You return to the GC Directory screen.
i) Click OK to save the new GC connection and to close the GC Directory screen.

3. Connect one end of the direct connect cable to the GC’s serial port at J23 on the
backplane.

4. Connect the other end of the direct connect cable to the PC’s corresponding serial
port.

5. Go to Chromatograph →  Connect....
The Connect to GC screen displays.

6. Click Direct next to the GC entry to connect to the GC using the serial cable
connection.
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5.4.11  Connect directly to a personal computer (PC) using the gas
chromatograph's (GC’s) wired Ethernet terminal
The Rosemount 700XA has a wired Ethernet terminal at TB11 on the backplane that you
can connect to with a static Internet protocol (IP) address. All that is needed is a PC,
typically a notebook computer, and a two-wire, twisted pair CAT5 Ethernet cable with one
of its plugs removed to expose the wires.

Figure 5-14: Crimped CAT5 cable

Note
The GC can be connected (or remain connected) to the local network on Ethernet2 (TB11)
on the backplane while the dynamic host configuration protocol (DHCP) feature is being
used.

Figure 5-15: Wired Ethernet terminal block on the backplane

Installation and start-up Manual
November 2023 MS-00809-0100-0700

68 Emerson.com



Procedure
1. Use the following schematics as a guide to wiring the GC via its four-wire connector

at TB11.
Figure 5-16 shows the traditional wiring scheme. Figure 5-17 shows how to wire a
CAT5 cable without the RJ45 plug.

Figure 5-16: Field wiring to TB11

Figure 5-17: CAT5 wiring to TB11

2. Once you have wired the cable to the Ethernet terminal, plug the other end into a PC
or a wall jack.
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5.4.12  Assign a static Internet protocol (IP) address to the gas
chromatograph (GC)
Procedure

1. Start Rosemount MON2020 and log in to the GC using a direct Ethernet connection.
2. Go to Application →  Ethernet ports....

The Ethernet Ports window displays.
3. Depending upon the Ethernet port to which you want to assign a static IP address,

do the following:
a) The Ethernet port at TB11: Enter the appropriate values in the Ethernet2 IP

Address, the Ethernet 2 Subnet, and the Default Gateway fields.
b) The RJ45 Ethernet port at J22: Enter the appropriate values in the Ethernet1 IP

Address, the Ethernet1 Subnet, and the Default Gateway fields.
Note
See your information technology (IT) staff to obtain IP, subnet, and gateway
addresses.

Important
To configure a Ethernet IP address using the local operator interface (LOI),
refer to Figure A-54.

4. Click OK.
5. Log off the GC.
6. Access the backplane, which is located in the GC’s lower enclosure.

Figure 5-18: Port locations on the backplane
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7. If you are setting up a static IP address for the Ethernet1 port at J22, and you also
intend to connect to your company’s local area network, do the following:

a) Locate the set of dip switches, labeled 1 and 2 , at SW1 on the backplane.
SW1 is located directly beneath the Ethernet port at J22 .

b) Move dip switch 1 to its left position (Off).
This disables the dynamic host configuration (DHCP) server.

8. To connect to the GC:
a) Start MON2020 and select File →  GC Directory....

The GC Directory window displays.
b) Select Add.

MON2020 adds a new GC profile to the end of the table.
Note
You can name the GC’s profile as well as add a short description.

c) Select the new profile and click Ethernet... Enter the GC’s static IP address in
the IP address field.

d) Click OK.
The Ethernet Connection Properties for New GC window closes.

9. Click Save to save the new profile.
10. Click OK to close the GC Directory window.

11. Select Chromatograph  →  Connect... to connect to the GC or click .
The Connect to GC window displays. The newly created GC profile should be listed in
the table.

12. Locate the new GC profile and click the Ethernet button that is associated with it.
The Login window displays.

13. Enter a User Name and User Pin and click OK.

5.4.13  Wiring the discrete digital inputs and outputs
The backplane has five discrete outputs and five discrete inputs. Refer to the Rosemount
MON2020 Software for Gas Chromatographs Manual to learn how to configure the digital
outputs.
Related information
Wire an ROC800 digital output (DO) module

Wire the discrete digital inputs
 WARNING

Electric shock
Failure to observe this precaution may cause serious personal injury or death.
The equipment operates using mains voltage that is dangerous to life. Make sure that the
circuit breakers are set to OFF and tagged off before removing the top cover or opening
the front cover.
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 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.

To connect digital signal input lines to the gas chromatograph (GC):
Procedure

1. Disconnect power to the analyzer and allow the components to cool for at least five
minutes.

2. Open the electronics enclosure door and access the backplane.
3. Make the digital input wiring connections on the backplane at TB7.

Figure 5-19: TB7 on the backplane

Note
The discrete digital input terminals on the backplane are self-powered. Devices
connected to the digital input will be powered by the GC's dedicated isolated 24 V
power supply.

Note
The discrete digital input terminals are optically isolated from the GC's other
circuitry.
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4. Route digital input/output (I/O) lines away from the sensitive detector lines (on the
left side of the backplane) and away from the analog inputs and outputs.
There are connections for five digital inputs on the backplane at TB7, as indicated in
Table 5-2.
Table 5-2: Discrete digital inputs at TB7
TB7 Function
Pin 1 Digital input 1
Pin 2 Digital input return
Pin 3 Digital input 2
Pin 4 Digital input return
Pin 5 Digital input 3
Pin 6 Digital input return
Pin 7 Digital input 4
Pin 8 Digital input return
Pin 9 Digital input 5
Pin 10 Digital input return

Wire an ROC800 digital input (DI) module
To connect the ROC800 DI module to a field device:
Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).

NOTICE
Emerson recommends twisted-pair cables for input/output (IO) signal wiring. The
module's terminal blocks accept wire sizes between 12 and 22 American wire gauge
(AWG). Allow some slack when making connections to prevent strain.

NOTICE
Failure to follow this notice may cause a short circuit and damage equipment. Allow
only a minimal amount of bare wire to prevent short circuits.

2. Insert the exposed end into the clamp beneath the termination screw.
3. Tighten the screw.

Manual Installation and start-up
MS-00809-0100-0700 November 2023

Rosemount 700XA 73



Figure 5-20: Typical wiring

A. Control
B. Discrete device (externally powered)

Table 5-3: ROC800 discrete digital wiring
Terminal Label Definition
1 1 Channel 1 Positive
2 2 Channel 2 Positive
3 3 Channel 3 Positive
4 4 Channel 4 Positive
5 5 Channel 5 Positive
6 6 Channel 6 Positive
7 7 Channel 7 Positive
8 8 Channel 8 Positive
9 COM Common
10 COM Common
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Wiring the discrete digital outputs
The discrete outputs are located on TB3, which is a 15-pin connector, and have five Form-C
relays on the backplane. All contact outputs have a rating of 1A at 30 Vdc.

Figure 5-21: TB3 on the backplane

Table 5-4 lists the discrete digital output function for each pin on the TB3 connector.
Table 5-4: Discrete digital outputs on TB3
Pin Function
Pin 1 Normally closed (NC1)

DIG_OUT NC1
Pin 2 ARM1

DIG_OUT ARM1
Pin 3 Normally open (NO1)

DIG_OUT NO1
Pin 4 NC2

DIG_OUT NC2
Pin 5 ARM 2

DIG_OUT ARM2
Pin 6 NO2

DIG_OUT NO2
Pin 7 NC3

DIG_OUT NC3
Pin 8 ARM3

DIG_OUT ARM3
Pin 9 NO3

DIG_OUT NO3
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Table 5-4: Discrete digital outputs on TB3 (continued)
Pin Function
Pin 10 NC4

DIG_OUT NC4
Pin 11 ARM4

DIG_OUT ARM4
Pin 12 NO4

DIG_OUT NO4
Pin 13 NC5

DIG_OUT NC5
Pin 14 ARM5

DIG_OUT ARM5
Pin 15 NO5

DIG_OUT NO5

Note
Form-C relays are single-pole double-throw (SPDT) relays that have three positions:
normally closed (NC); an intermediate position, also called the make-before-break position
(ARM); and normally open (NO).

Related information
List of engineering drawings - Rosemount 700XA

Optional discrete digital inputs (DI)
When plugged into one of the optional card slots in the card cage, the Emerson ROC800
DI card provides eight additional discrete digital inputs. The discrete digital inputs can
monitor the status of relays, open-collector or open-drain type solid-state switches, and
other two-state devices.
For more information, see ROC800-Series Discrete Input Module at Emerson’s ROC 800-Series
website.

Figure 5-22: Optional digital input/output (I/O) modules
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Wire an ROC800 digital output (DO) module
Figure 5-23: Discrete digital output wiring

A. Control
B. Discrete device (externally powered)

Terminal Label Definition
1 1+ Positive discrete output
2 COM Discrete output return
3 2+ Positive discrete output
4 COM Discrete output return
5 3+ Positive discrete output
6 COM Discrete output return
7 4+ Positive discrete output
8 COM Discrete output return
9 5+ Positive discrete output
10 COM Discrete output return

To connect the ROC800 DO module to a field device:
Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).
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NOTICE
Emerson recommends twisted-pair cables for input/output (IO) signal wiring. The
module's terminal blocks accept wire sizes between 12 and 22 American wire gauge
(AWG). Allow some slack when making connections to prevent strain.

NOTICE
Failure to follow this notice may cause a short circuit and damage equipment. Allow
only a minimal amount of bare wire to prevent short circuits.

2. Insert the exposed end into the clamp beneath the termination screw.
3. Tighten the screw.

5.4.14  Wiring the analog inputs
All Rosemount 700XA gas chromatographs (GCs) have at least two analog inputs. An
additional four analog inputs are available with an ROC800 AI-16 card that can be installed
into one of the optional slots in the card cage.

Analog inputs on the backplane
There are two analog input connections on the backplane at terminal block 10 (TB10).

Figure 5-24: TB10 on the backplane

Table 5-5: Analog inputs TB10
Pin Function
Pin 1 +AI_1
Pin 2 -AI_1
Pin 3 +AI_2
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Table 5-5: Analog inputs TB10 (continued)
Pin Function
Pin 4 -AI_2
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Analog inputs settings switches
Figure 5-25 shows how to wire two analog inputs (TB10).

Figure 5-25: Customer wiring for analog inputs

A. Backplane
B. Analog inputs
C. Analog input 1
D. Analog input ground
E. Analog input 2
F. Cable
G. Customer devices
H. Customer 4-20 mA outputs

Figure 5-26 shows the factory settings for the analog input switches that are located on the
base input/output (I/O) board. These analog inputs are set to accept a current (4-20 mA)
source.

Figure 5-26: Factory settings for analog input switches

Use the Hardware → Analog Inputs menu in Rosemount MON2020 to configure the analog
inputs.
Note
To set an analog input to accept a voltage (0-10 Vdc) source, flip the appropriate switch in
the opposite direction from that shown in Figure 5-26.

Select the input type for an analog input
You can set an analog input to either voltage (0-10 V) or current (4-20 mA) by flipping the
appropriate switches on the base input/output (I/O) board.
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Procedure
1. Turn off the gas chromatograph (GC).
2. Locate and remove the base I/O board, which is in the card cage in the GC’s lower

enclosure.
3. Set analog input #1.;

• To set analog input #1 to current, locate SW1 on the backplane base I/O board
and push the switches up, toward the card ejector.

• To set the analog input to voltage, push the switches down, away from the card
ejector.

4. Set analog input #2.
• To set analog input #2 to current, locate SW2 on the base I/O board and push the

switches up, toward the card ejector.
• To set the analog input to voltage, push the switches down, away from the card

ejector.

5. Replace the base I/O board in the card cage.
6. Close and fasten the electronic enclosure door.
7. Apply power to the GC.
8. Select Hardware →  Analog Inputs....

The Analog Inputs window displays.
9. Set analog input.

• To set the analog input to current, select mA from the mA/Volts drop-down list
for the appropriate analog input.

• To set the analog input to voltage, select Volts from the mA/Volts drop-down list
for the appropriate analog input.

10. Click Save to save the changes and keep the window open or click OK to save the
changes and close the window.
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Typical wiring for line-powered transmitters
Figure 5-27 shows the most common wiring plan for supplying power to two 4-20 mA
transmitters, such as pressure sensor transmitters.

Figure 5-27: Typical wiring for line-powered transmitters

A. Backplane
B. Customer transmitter
C. Analog inputs
D. Transmitter 4-20 mA output

Optional analog inputs (AI)
When plugged into one of the optional card slots on the card cage, the ROC800 AI-16 card
provides four additional analog inputs.
The AI channels are scalable, but are typically used to measure either a 4-20 mA analog
signal or a 1-5 Vdc signal. If required, the low end of the AI module’s analog signal can be
calibrated to zero. For more information, see Analog Input Modules (ROC800 Series).
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Figure 5-28: Optional input/output (I/O) expansion card slots

A. Optional card slots

Wire a ROC800 AI-16 module
NOTICE
Electrostatic discharge (ESD)
Operators and technicians must wear an electrostatic wrist strap when handling printed
circuit cards to prevent shorting the boards through static electricity. Do not install or
remove the printed circuit assemblies while power is applied to the device. Keep electrical
components and assemblies in their protective (conductive) carriers or wrapping until
ready for use. Use the protective carrier as a glove when installing or removing printed
circuit assemblies.
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Figure 5-29: Typical ROC800 wiring

A. 1-5 volt device, externally powered
B. 1-5 volt device, ROC800 powered
C. Current loop device 4-20 mA, ROC800 powered

To connect the ROC800 AI-16 module to a device:
Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).
Note
Emerson recommends twisted-pair cables for input/output (I/O) signal wiring. The
module’s terminal blocks accept wire sizes between 12 and 22 American wire gauge
(AWG). Allow some slack when making connections to prevent strain.

NOTICE
Electrical hazard
Exposing bare wires may cause a short circuit and damage equipment.
Keep exposed bare wires to a minimum.

2. Insert the exposed end into the clamp beneath the termination screw.
3. Tighten the screw.

There are two dip switches on the terminal block side of the module that can be
used to set a 250 Ω resistor in or out of circuit for each analog input.
To put an analog input’s resistor in circuit, flip the appropriate dip switch to I; to put
an analog input’s resistor out of circuit, flip the appropriate dip switch to V.
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Calibrate a ROC800 AI-16 module
Prerequisites
To calibrate the ROC800 AI-16 module you must have a personal computer (PC) with the
ROCLINK™ 800 Configuration software installed and open.
See Emerson’s ROC800 Series page for details, downloads, and manuals.
Procedure

1. Go to Configure →  I/O →  RTD Points →  Calibration.
2. Select an analog input.
3. Click Update to request one value update from the input.
4. Click Freeze to stop the values of the input from being updated during calibration.

Note
If you are calibrating a temperature input, disconnect the RTD sensor and connect a
decade box or comparable equipment to the RTD terminals of the ROC card.

5. Click Calibrate.
6. Enter a value for Set Zero after stabilization.
7. Enter a value for Set Span after stabilization.
8. Enter values for up to three Midpoints one at a time or click Done if you are not

configuring midpoints.
9. Click OK to close the main calibration window and unfreeze the associated inputs.

Postrequisites
To calibrate the inputs for another analog input, return to Step 1.

5.4.15  Analog output wiring
The Rosemount 700XA has at least six analog outputs. An additional four analog inputs are
available with an ROC800 AO card that can be installed into one of the optional slots in the
card cage.
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Factory settings for analog output switches
Figure 5-30 shows how to wire up to six devices to the analog outputs that are located on
the backplane. It also shows how to wire up to two analog inputs.

Figure 5-30: Wiring for six analog outputs

A. Backplane
B. Customer devices
C. Analog outputs
D. Cable
E. Analog power and ground
F. Analog inputs

Figure 5-31 shows the factory settings for the analog output switches that are located on
the base input/output (I/O) board.
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Figure 5-31: Factory settings for analog output switches

Wire customer externally-powered analog outputs
It is possible to furnish power to each analog output while maintaining isolation between
channels.
Procedure
Use Figure 5-32 to provide power wiring to each analog output while maintaining isolation
between channels.
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Figure 5-32: Wiring for customer-powered analog outputs

A. Backplane
B. Customer devices
C. Analog outputs
D. Inputs

Figure 5-32 shows the settings for the analog outputs switches, located on the base input/
output (I/O) board, that are necessary to provide power to each analog output while
maintaining isolation between channels.
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Figure 5-33: Settings for analog output switches

The settings for the analog outputs connections located on the backplane are necessary to
provide power to each analog output while maintaining isolation between channels.

Optional analog outputs
When plugged into one of the optional card slots on the card cage, the ROC800 AO card
provides four additional analog outputs. Each channel provides a 4 to 20 mA current signal
for controlling analog current loop devices.
For more information, see Emerson's ROC 800-Series website.

Connect ROC800 analog output (AO) module to a field device
Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm)
Note
Emerson recommends using twisted-pair cables for input/output (I/O) signal wiring.
The module’s terminal blocks accept wire sizes between 12 and 22 American wire
gauge (AWG). Expose minimal bare wire to prevent short circuits. Allow some slack
when making connections to prevent strain.

2. Insert the exposed end into the clamp beneath the termination screw.
3. Tighten the screw.
4. Close the electronics enclosure door and apply power to the gas chromatograph

(GC).
5. Run Rosemount MON2020 and connect to the GC.
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5.4.16  Configure analytical train
Figure 5-34: Analytical Train Configuration window

Procedure
1. Assign the usage of valves and DOs to each analyzer on the Hardware → Valves,

Hardware → Detectors, and Hardware → Discrete Outputs screens.
2. Open the Application → Analytical Train Configuration screen.

You can use the Filter Selections drop-down list to filter by the type of hardware you
are interested in. The options are:
• All
• Detectors
• Valves
• Discrete Output
• Heaters
By default, All is selected, and all types of hardware are displayed. To filter by a
certain type of hardware, select it from the list. Then only rows with the selected
hardware will be displayed.

3. Click Discrete Output and Valves. Assign the respective DOs, valves, and detectors
to each analytical train.
The valves are assigned with Usage as Analyzer# displayed on this screen. All
available detectors are also displayed on this screen. You cannot configure the same
valve or DO to multiple trains, but you can configure the same detector to multiple
trains.

4. On the Application → Timed Events screen, filter the configured events as per train
selection by selecting the Train# check box.
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5.4.17  Configure an analysis clock
Use this feature to configure a single analysis clock or multiple clocks.

One analysis clock can be considered as one virtual gas chromatograph (GC) that has
independent Sample Loop, Analytical Path, and Timed Event tables.
Multiple analysis clocks can run independently to analyze multiple streams at the same
time. Emerson sets the number of analysis clocks at the factory per the mechanical
configurations of the GC.
Mechanical
configurations

Description

Trains (1 - 6) The configured trains that are used by the analysis
Default Stream
Sequence (Def Strm
Seq)

Sets the default sequence to be used by the indicated analysis during
auto-sequencing.

Purge Duration The amount of time, in seconds, to purge the stream before starting
an analysis, calibration, or validation run. The default value is 60 SEC.
Purging allows sample gas to flow through the sample loop prior to
beginning the run.

Energy Value Check If enabled, the GC analyzes the calibration gas as an unknown stream and
computes its energy value. The GC then compares this value to the Cal Gas
Cert CV and determines if the calibration gas's energy value is within the CV
Check Allowed Deviation. If it isn't, the GC triggers the Energy Value
Invalid alarm. The following conditions must be met before the GC can
perform a EV Check:
• At least one stream must be set up in the Streams screen as a

calibration stream, and the Auto flag for this stream must be enabled.
The EV Check is performed under any of the following circumstances:
• During a warm start that follows a power failure during normal

operation. The GC waits for the heater to reach its set point and
stabilize. It then analyzes the calibration gas as an unknown stream
and identified the peaks. If all the component peaks are identified, the
GC computes the calibration gas's energy value and performs the EV
check.

• After a successful calibration, the GC computes the gas's energy value
with the new response factors and performs the EV Check

1. Press Insert to add a new analysis.
2. Press Delete to delete an analysis.

5.5  Leak checking and purging for first calibration
NOTICE
Equipment damage
Failure to clean and dry the tubing may compromise the integrity of the analyzer or its
warranty.

Make sure all tubing is clean and dry internally.
Prior to installation, blow the tubing free of internal moisture, dust, or other
contaminants.

Manual Installation and start-up
MS-00809-0100-0700 November 2023

Rosemount 700XA 91



Verify that all electrical connections are correct and safe and then turn the gas
chromatograph (GC) on.

5.5.1  Check the gas chromatograph (GC) for leaks
Prerequisites
Leak checking carrier and calibration gas lines requires power and a personal computer
(PC) connected to the GC.
Note
Refer to the analyzer's drawing documentation package that shipped with the GC for leak
checking and identifying vents.
Emerson tested the GC and fittings for leaks at the factory prior to shipment.
Procedure

1. Plug the measure vent (labeled MV) vent line if it is open.
Leave the SV or sample vent line open or unplugged.

2. Slowly pressurize each line in turn; then block in the line, making sure the pressure
holds.
For example, the carrier gas line should be slowly brought up to 100 psig (6.89 barg)
± 2% with the dual-stage regulator at the carrier gas cylinder, and the actuation
pressure should be 100 psig (6.89 barg) maximum.

3. After two minutes, shut the carrier gas bottle valve and observe the high side
regulator gauge on the carrier gas bottle.

a. The gauge should not bleed down more than 100 psig (6.89 barg) in ten
minutes.

b. If helium is lost at a faster rate, leaks are usually found between the carrier
gas bottle and the analyzer. Check and tighten all connections, as well as the
dual-stage regulator.

4. When the leak check is complete, reopen the helium bottle valve. Remove the plug
from the MV line.

5. Shut the metering valve below the rotameter on the front of the flow panel.
Leave the metering valve shut for now; you will reopen it later during initial purging
and the analyzer's first calibration.

6. Repeat the procedure with sample gas and stream gas.
Note
Do not use a liquid leak detector, such as Snoop®, on the valves or components in
the oven.

Note
Refer to the Flow Configuration schematic in the documentation packet that shipped
with the GC for detailed instructions on plugging the flame ionization detector (FID)
and flame photometric detector (FPD) vents.
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5.5.2  Plugged lines, columns, and valves
If the lines, columns, or valves are plugged, check the gas flow at valve ports.
For a reference, use the flow diagram in the drawing package that shipped with your gas
chromatograph (GC) and remember these points about flow diagrams:
• Port-to-port flow paths are indicated by solid or dashed lines on the valve symbol in the

drawing.
• A dashed line indicates flow direction when the valve is On or energized.
• A solid line indicates flow direction when the valve is Off or not energized.

5.5.3  Purge carrier gas lines
Prerequisites
Purging carrier and calibration gas lines requires power and a personal computer (PC)
connected to the gas chromatograph (GC).
Procedure

1. Ensure that the vent line plugs have been removed and the vent lines are open.
2. Ensure that the carrier gas bottle valve is open.
3. Set the GC side of the carrier gas to 115 psig (7.93 barg).
4. Turn on the GC and the PC.
5. Start Rosemount MON2020 and connect to the GC.

Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for
more information.

6. Select Hardware → Heaters....
The Heaters window displays.

Figure 5-35: Heaters window

7. Allow the GC system temperature to stabilize and the carrier gas lines to become
fully purged with carrier gas, which usually takes at least an hour.
The temperature values for the heaters should indicate that the GC is warming up.
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The Status column displays OK.
8. Select Control → Auto Sequence....

Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for
more information.

Note
You can also perform Step 6 through Step 8 with the local operator interface (LOI).

NOTICE
Emerson recommends a continuous operation without sample gas for a period of
four to eight hours (or overnight), during which no changes should be made to the
settings described in Step 1 through Step 7.

5.5.4  Purge calibration gas lines
Prerequisites
Purging calibration gas lines requires power and a personal computer (PC) connected to
the gas chromatograph (GC).

 WARNING
Safety compliance
Failure to follow the safety instructions may cause injury to personnel. The seller does not
accept any responsibility for installations of the device or any attached equipment in which
the installation or operation thereof has been performed in a manner that is negligent
and/or non-compliant with applicable safety requirements.

Install and operate all equipment as designed and comply with all safety requirements.
If the device is not operated in a manner recommended by the manufacturer, the
overall safety could be impaired.
Observe all safety precautions defined in the gas Safety Data Sheet (SDS), especially for
hazardous locations.

Procedure
1. Ensure that the carrier gas lines have been fully purged and that the sample vent

plugs have been removed.
2. Close the calibration gas bottle valve.
3. Fully open the block valve associated with the calibration gas feed.

The block valve is usually located on the lower right-hand corner of the front panel.
Refer to the Rosemount MON2020 Software for Gas Chromatographs Manual for
instructions on selecting streams.

4. Open the calibration gas bottle valve.
5. Increase the outlet pressure to 15 psig (1 barg), plus or minus five percent, at the

calibration gas bottle regulator.
6. Close the calibration gas bottle valve.
7. Let both gauges on the calibration gas bottle valve bleed down to 0 psig (0 barg).
8. Repeat Step 4 through Step 7 five times.
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9. Open the calibration gas bottle valve.

5.6  Start up the system
Procedure

1. For system start-up, run a single-stream analysis of the calibration gas.
a) Verify the calibration stream is set to Auto.
b) Use Rosemount MON2020 to run a single stream analysis on the calibration

stream. Once proper operation of the gas chromatograph (GC) is verified, halt
the analysis by selecting Control →  Halt....
Example
Go to MON2020 →  Control →  Single Stream →  Calibrate and select the
associated analysis stream.
Unless stated otherwise in the product documentation, ensure that the
pressure of the calibration and sample line is regulated at 10 to 30 psig (0.7 to
2.1 barg). Emerson recommends 15 psig (1 barg).

c) Validate calibration gas and retention times and run a manual calibration.
d) Go to MON2020  → Application → Component Data and select the associated

stream. Check the Component Data table for calibration gas validation
information and retention times.

e) Go to MON2020 → Control → Calibration and select the analysis stream to run
a manual calibration. Select the Purge stream for 60 seconds checkbox and
Normal calibration type radio button; then click OK.
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual
for more information.

2. Select Control →  Auto Sequence... to start auto sequencing of the line gas stream(s).
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for
more information.
The GC begins the auto sequence analysis.
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6  Operation and maintenance
6.1  Warning and notice

 WARNING
Precautionary signs
Failure to observe precautionary signs may result in injury or death to personnel or cause
damage to equipment.
Observe and comply with all precautionary signs posted on the device.

NOTICE
Failure to follow this notice can result in damage to the card.
Turn off the device before removing a card from the card cage assembly.

6.2  Start a 2-point calibration
The 2-point calibration process calculates an exponential power fit that the gas
chromatograph (GC) uses to accurately analyze a sample stream with a flame photometric
detector (FPD).
Prerequisites
The 2-Point calibration process requires two calibration gases that will be used to generate
the data for the exponential power fit calculation. While both calibration gases should have
the same components, one of the calibrations gases, called the low calibration gas (LCG),
should have a lower concentration of the components than the other calibration gas, which
is called the high calibration gas (HCG). The GC can then compute the coefficients for the
2-point (2-Pt) exponential power fit by doing a single-level calibration on these individual
LCG and HCG streams.
Procedure

1. Start Rosemount MON2020 and press F6 to open the Component Data window.
2. Change the Calib Type for the target component to 2 pt Calib.
3. For the target component, select the component data table (CDT) that is associated

with the LCG from the 2 Pt Calib High CDT drop-down list.
4. For the target component, select the CDT that is associated with the HCG from the 2

Pt Calib High CDT drop-down list.
5. Run a single stream analysis on the stream associated with the LCG until the

readings stabilize.
6. Run a forced calibration on the stream associated with the LCG.
7. Run a normal calibration on the stream associated with the LCG.
8. Run a single stream analysis on the stream associated with the HCG until the

readings stabilize.
9. Run a forced calibration on the stream associated with the HCG.

10. Run a normal calibration on the stream associated with the HCG.
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The GC is ready to analyze the sample or validation stream using the 2 Pt Exp with
the response factor that was calculated during the LCG and HCG runs.

6.3  Troubleshooting and repair
The most efficient method for maintaining and repairing the Rosemount 700XA is a
component-replacement concept that allows you to return the system to operation as
quickly as possible.
Use troubleshooting test procedures to identify sources of trouble, such as printed-circuit
assemblies, valves, etc., and replace them with parts in known good working order.

6.4  Routine maintenance
The Rosemount 700XA will perform accurately for long periods with very little attention
(except for maintaining the carrier gas cylinders).
It helps to keep a bi-monthly record of certain parameters to assure that the gas
chromatograph (GC) is operating to specifications. Fill out the maintenance checklist bi-
monthly, date it, and keep it on file for access by maintenance technicians as necessary.
This gives a historical record of the operation of the Rosemount 700XA, enables a
maintenance technician to schedule replacement of gas cylinders at a convenient time,
and allows quick troubleshooting and repair when necessary.
Also, create a diagnostic file, which contains calibration and analysis chromatograms,
alarm and event logs, analysis reports, and the complete configuration file, and file it
with the checklist, furnishing a positive dated record of the Rosemount 700XA. You can
compare these chromatograms and reports to the chromatograms and reports run during
the troubleshooting process.
Before contacting Customer Care, connect to your GC and save the diagnostics data file.
From Rosemount MON2020, go to Tools → Save Diagnostic Data to save the diagnostic
data file.
Rosemount MON2020 prompts you to send an email to Customer Care (at
gc.csc@emerson.com) with the diagnostic data file.

6.4.1  Maintenance checklist
Print the sample maintenance checklist in Figure 6-1 for your records.
If you have a problem, please complete the checklist first and have the results available, as
well as the sales order number, when calling your Emerson Customer Care representative
for technical assistance. The sales order number is on the nameplate located on the front
of the Rosemount 700XA. Emerson files the chromatograms and reports archived when
your gas chromatograph (GC) left the factory by this number.
Note
To find the default measurements for the parameters on the checklist, use Rosemount
MON2020 to view the GC’s parameter list.
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Figure 6-1: Sample Maintenance Checklist
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6.4.2  Save diagnostic data
At least every other month, create and save a diagnostic data file and check carrier and
calibration gas supplies.
Fill out a Maintenance checklist.

6.4.3  Service programs
Rosemount Lifecycle Services offers maintenance service programs that are tailored to fit
specific requirements.
Contracts for service and repair can be arranged by contacting Lifecycle Services at the
address or telephone number on the back of this manual or visiting the website at:
Lifecycle Services.

6.4.4  Precautions for handling printed circuit (PC) assemblies
Printed circuit assemblies contain complementary metal-oxide-semiconductor (CMOS)
integrated circuits, which can be damaged if the assemblies are not properly handled.

NOTICE
Electrostatic discharge (ESD)
Operators and technicians must wear an electrostatic wrist strap when handling printed
circuit cards to prevent shorting the boards through static electricity. Do not install or
remove the printed circuit assemblies while power is applied to the device. Keep electrical
components and assemblies in their protective (conductive) carriers or wrapping until
ready for use. Use the protective carrier as a glove when installing or removing printed
circuit assemblies.
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Figure 6-2: SW7 on the central processing unit (CPU) board

A. SW7 switch (ON is towards the dot.)

6.4.5  Flame ionization detector (FID) configuration
When connected to the gas chromatograph (GC) via Rosemount MON2020, select
Hardware → Detectors to access the Detectors dialog.
Refer to the Rosemount MON2020 Software for Gas Chromatographs Reference Manual
for additional configuration details.
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Figure 6-3: Rosemount MON2020 - Detectors window

Halt the analysis: Control → Halt (F3).
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Configure the following fields from the Detectors dialog:
• FID Ignition - Manual or Automatic
• Ignition Attempts
• Wait Time Bet (between) Tries
• Igniter On duration
• Flame On Sense Temp
• Flame Out Sense Temp
• Electrometer Voltage
Note
If the FID does not appear in the Detectors window your gas chromatograph (GC) may not
be fitted with an FID. Disconnect from MON2020 and turn off the GC. Inspect the S1 switch,
which is located on the half-moon-shaped wire terminal board. The switch should be set to
ON.

6.4.6  Replace the central processing unit (CPU)
Procedure

1. Save the gas chromatograph (GC) configuration file. In Rosemount MON2020, go to
File → Save Configuration (to PC).

2. Power down the GC.
3. Open the GC cover.
4. Remove the clear plastic cover that holds the boards in place.
5. Remove the CPU board.

NOTICE
Electrostatic discharge (ESD) handling precautions required
CPU boards are sensitive electronic devices.
Do not ship or store near strong electrostatic, electromagnetic, or radioactive fields.
Use an anti-static wrist strap (or ESD wrist strap) when handling the boards.
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6. On the new CPU board, set up switches as shown in the following image:

Figure 6-4: CPU switch settings

A. Turn SW7 ON (toward the dot).
B. Turn SW3 OFF (away from the dot).
C. Turn SW4 OFF (away from the dot).
D. Turn SW6 OFF (away from the dot).

NOTICE
Rosemount 700XA GCs are tagged with CPU board part number 7A00555G02.

7. Install the new CPU board in the card cage.
Ensure the board is seated firmly in place.

8. Place the clear plastic cover back over the boards.
9. Close the GC cover.
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10. Power up the GC and connect to it through Rosemount MON2020.
11. In Rosemount MON2020, go to Chromatograph → View/Set Date_Time. Set the date

and time for the GC.
Consult the Rosemount MON2020 Software for Gas Chromatographs Reference
Manual for more information.

12. In Rosemount MON2020, go to Tools → Cold Boot. Cold boot the GC.
The GC reboots automatically and disconnects from Rosemount MON2020.

13. Wait for the GC to reboot.
14. Reconnect to the GC using Rosemount MON2020.
15. In Rosemount MON2020, go to File → Restore Configuration (to GC). Use the

configuration file you saved in Step 1 or use the last known good configuration.
16. Wait for the heaters to stabilize.
17. Go to Control → Auto Sequence to auto sequence the GC.

6.4.7  Repairing and maintaining the valves
The valves require minimal repair and maintenance, such as replacing the diaphragms.

Required tools for valve maintenance
The tools required for performing repair and general maintenance on the Rosemount XA
Series valve assemblies are:
• Torque wrench, scaled in foot-pounds
• ½-in. socket for 10-port valves
• 7/16-in. socket for 6-port valves
• ¼-in. open-ended wrench
• 5/16-in. open-ended wrench
• 5/32-in. Allen wrench

Valve replacement parts
Replacement parts required for each Rosemount XA Series valves consist of the following
parts:
• Diaphragm kit 6-port XA valve (PN 2-4-0710-248)
• Diaphragm kit 10-port XA valve (PN 2-4-0710-171)
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Figure 6-5: XA series valves

Overhaul a valve
Note
Rosemount valves have a lifetime warranty. Replacement factory-built XA Series valves are
available. Call your local Emerson Customer Care representative for more information.

If you are overhauling a six-port valve, refer to drawing #CE-22260.
If you are overhauling a ten-port valve, refer to drawing #CE-22300.
Procedure

1. Shut off the carrier and sample gas streams entering the unit.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are
always hot unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make
sure that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

2. Remove the top hat heater from the oven system.
3. If the faulty valve is not easily accessible, loosen the thumb screw and tilt the oven

on its side.
4. Disconnect tubing and fittings that attach to the valve from other locations.
5. Use an Allen wrench to remove the two base plate bolts on the valve to be replaced

or serviced.
6. Remove the valve from the gas chromatograph (GC).
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7. Loosen the valve’s torque bolt.

Figure 6-6: Valve

A. Torque bolt

See Drawing CE-22260.
8. Holding the lower piston plate, pull the valve straight off the block.

The alignment pins may stick slightly.
9. Remove and discard the old valve diaphragms and gaskets.

10. Clean the sealing surface as required using a non-lint-forming cloth and isopropyl
alcohol. Blow the sealing surface with clean, dry instrument air or carrier gas.

NOTICE
Dirt, including dust and lint, can cause troublesome leakage.
Do not use an oil-based cleaner on the valve.

11. Replace the old diaphragms and gaskets, in the same order, with the new ones
supplied.

12. Reassemble the valve using the following steps:
a) Align the pins with holes in the block and push the valve assembly into place.
b) Tighten the valve’s torque bolt.

The six-port valve requires 20 ft.-lb. of torque.
The ten-port valve requires 30 ft.-lb. of torque.

c) Return the valve to the assembly.
d) Reinstall the valve using the two mounting screws and reconnect all fittings

and tubing.

Related information
List of engineering drawings - Rosemount 700XA
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Replace solenoids
You can replace the oven system solenoids and/or the stream switching solenoids.

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.
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Figure 6-7: Solenoids

Prerequisites
Required tools:
• 5/32-in. allen wrench
• Phillips head screwdriver #1
Procedure

1. Remove the thermal cover from the upper enclosure.
2. Loosen the ultem thumb screw and tilt the oven on its side to gain access to the

solenoids that are located on the underside of the ultem.
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3. Loosen the screws holding the solenoid in place and remove the solenoid.
4. Place a small amount of silicone grease on the target device (pneumatic block,

four-way stream block, etc.) where the solenoid is to be placed.
The grease ensures a tight seal.

5. Place the new solenoid.
6. Tighten the screws to hold the solenoid in place.
7. Place the oven upright.
8. Tighten the ultem thumb screw.

Liquid sample injection valve (LSIV) maintenance
The following procedures detail how to remove and install an LSIV, as well as how to
replace an LSIV’s seals.
Install a MAT liquid sample injection valve (LSIV)
You can maintain the LSIV while it is attached to the enclosure. However, it may be easier
to perform maintenance with the LSIV removed from the upper enclosure.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot
unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure
that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

Figure 6-8: MAT LSIV components

A. Union coupling
B. Actuation section
C. Liquid sample connector
D. Thermal barrier adapter

For a detailed view of the MAT LSIV’s components, see Figure 6-11.

Operation and maintenance Manual
November 2023 MS-00809-0100-0700

110 Emerson.com



Prerequisites
Although, for the most part, you can remove and disassemble the LSIV with traditional
tools, such as a wrench or pliers, the following tools ar eshipped with your LSIV-mounted
gas chromatograph (GC).

Figure 6-9: LSIV tools

A. Two 10 mm wrenches
B. Union coupling wrench
C. Two 3 mm Allen wrenches
D. Union coupling spacer

Procedure
1. Install new MAT valve by doing the following:

a) Attach the retaining ring to the MAT LSIV.
b) Slide the MAT LSIV into the mounting hole in the gas chromatograph (GC).

Refer to Drawing #DE-20990 in Engineering drawings.
c) Tighten the retaining ring by twisting it clockwise to secure the MAT LSIV to

the GC.

2. Connect the following internal GC gas lines to the MAT LSIV:
a) Connect the carrier gas line to the MAT LSIV.
b) Connect the sample gas line to the MAT LSIV.

3. Place the insulation sleeve around the flash chamber as shown in Drawing
#DE-20990.

4. Connect the following external GC gas lines to the MAT LSIV:
a) Liquid Sample IN
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b) Liquid Sample Out
c) Air Actuator Inject
d) Air Actuator Retract

5. Install air solenoid items.
Refer to Drawing #DE-20990.

6. Perform a standard system leak test.
7. Restart the sample flow.

You can now return the GC to service.
Remove the MAT liquid sample injection valve
Inside the upper compartment of the gas chromatograph (GC), there are two insulation
covers, which open like clam shells that slide off of the end of the LSIV, to be removed.
Procedure

1. Disconnect the carrier and sample tubing from the LSIV.
2. Remove the heater and resistance temperature device (RTD) from the heater block.
3. Disconnect sample and air tubing from the outer portions of the LSIV.
4. Unscrew the retaining ring, using a pin spanner wrench or other tool.

With the retaining ring loose, the LSIV assembly is free to be pulled out of the upper
enclosure.

Figure 6-10: Rosemount 700XA after LSIV has been removed

A. Union coupling
B. Actuation section
C. Liquid sample connector
D. Thermal barrier adapter

Replace liquid sample injection valve (LSIV) seals
Due to the possible damage caused by the presence of solids in the sample stream,
combined with the regular, repeated motion of the injection valve stem, LSIV seals may
require annual replacement.
Note
Specific application conditions should dictate the frequency of the seals replacement;
monitor analytical performance to determine appropriate replacement intervals.

Note
ID numbers listed in parentheses refer to Figure 6-11.
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Figure 6-11: LSIV exploded view
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Table 6-1: LSIV parts
ID number Part number Part name
01 125-004-XA-EM-SS Vaporizer-cylinder, stainless steel (SS) 316
02 001-104-1/16-SS Connector/carrier, 1/16-in, SS 316(1)

03 120-112-1/8-PEEK Gasket, ⅛-in, polyetheretherketone (PEEK)
04 125-00801/16-SS Connector/capillary-column, 1/16-in, SS 316(1)

Equipped with VESPEL-ferrule, 1/16-in(2)

05 001-131-1/16-V VESPEL-ferrule, 1/16-in bore 0.5 mm/0.19-in
Usable for capillary column fused silica 0.32(3)

06 101-228-1/8-SS Connector, ⅛-in, SS 316(4) (required only if using
packed column ⅛-in or stream splitter)

07 120-038 Anchor plate
08 125-118-XA-EM-PEEK Thermal barrier adapter flange (PEEK)
09 130-020-SS Head piece, SS 316
10 001-164-SS Screw, M4 x 12 hex socket countersunk head, SS

304
11 001-166-SS Screw, M5x16 hex socket head cap, SS 304
12 No part number Heater element(5)

13 No part number Thermocouple(5)

14 No part number Valve top unit

(1) Denotes standard equipment.
(2) See part ID 05.
(3) See part ID 04.
(4) Only if required.
(5) Emerson equipment.

Procedure
1. Halt sample flow and allow time for the LSIV to cool.
2. Remove the actuation portion of the valve by unscrewing the union coupling from

the heater section, which should remain attached to the gas chromatograph (GC).
Emerson has provided a union coupling wrench for this purpose.
This will expose the sample flow chamber and the old seals that ride the metering
rod , which should be treated with great care to prevent bending or scratching.

3. Pull the sample flow chamber assembly off the metering rod. Remove the two seals.
To do this, you may need to push from the opposite side with a rod smaller than
0.175 in (4.4 mm).

4. Place new seals on the sample flow chamber assembly. Press the chamber and seals
back over the metering rod.

5. Place the actuation section in position on the heater section’s headpiece.
6. Use the union coupling spacer to ensure that the union coupling is properly aligned

with the heater section’s headpiece.
7. Use the union coupling wrench to re-tighten the union coupling over the heater

section.
8. Restart the sample flow.
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Postrequisites
Return the GC to service.

6.4.8  Repairing and maintaining the detectors
When a thermal conductivity detector (TCD) fails to perform normally, you may need to
replace it.
Signs that a TCD may be faulty include, but are not limited to, the following:
• A chromatogram with a wandering or drifting baseline
• A chromatogram with a noisy baseline
• A chromatogram with a no peaks
• No chromatogram
A test for a faulty TCD involves measuring the resistance of each filament using a
multimeter. A pair of thermistors should give the same resistance reading; therefore, if
a thermistor reading is significantly different from the reading of its mate, replace the pair.
Otherwise, the TCD bridge will be unbalanced, noisy, and drifty.

Required tools for thermal conductivity detector (TCD)
maintenance
A flat-head screwdriver is required for removing and replacing TCDs. Use a multimeter to
test the thermistor pair.

Thermal conductivity detector (TCD) replacement parts
Consult the parameter list that was provided with the gas chromatograph (GC) for the
thermistor kit required to replace one TCD. A new thermistor seal (2-6-5000-084) is also
required.
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Figure 6-12: TCD

A. Gas connector
B. TCD block
C. TCD 1 and TCD 2 retainer nuts and thermistor leads
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Replace a thermal conductivity detector (TCD)
See drawing DE-22143 in List of engineering drawings - Rosemount 700XA.

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.

Procedure
1. Disconnect all power to the GC.
2. If you have not already done so, remove the explosion-proof dome and the thermal

cover.
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3. Unscrew and remove the TCDs from the TCD block and the gas connectors.
Be careful not to damage the PTFE washer that is placed between the TCD and the
TCD block.

Figure 6-13: Components of a TCD block

a. Gas connector
b. TCD block
c. TCD
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Figure 6-14: Components of a TCD

A. Gas tubing connector
B. TCD block
C. TCD 1 and TCD 2 retaainer nuts and thermistor leads

4. Loosen the two retainer nuts.
5. Use a flat head screw driver and remove the four TCD termination block screws.
6. The TCD thermistors are held within the TCD block by the retainer nut. To replace

the thermistor, do the following:
a) Unscrew and release the thermistor leads from the termination block.
b) Unscrew the retainer nut from the TCD block.
c) Remove the PTFE seals as well as the thermistor and its wires from the

retainer nut.
d) Remove the PTFE shields from the old thermistor wires and install on the new

thermistor wires.
e) Insert a new PTFE seal into the TCD block.
f) Thread the thermistor through the retainer nut.
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g) Screw the retainer nut back into the TCD block.
Ensure a tight fit (quarter turn after finger tight); otherwise a potential leak
path might open.

h) Reconnect the thermistor leads to the termination block, taking care to
reconnect the thermistor leads to the corresponding terminal block screws.

Note
The thermistors are a matched pair (2-5-1611-003) and must be replaced as such.
Repeat Step 6 for each thermistor in a pair.

Note
Tighten the block screws with a torque wrench to 20 in.-oz.

7. Reconnect the gas tubings.
Make sure tubing is properly seated and reattach the TCD housing with the four
screws.

8. Replace the thermal cover and explosion-proof dome.
9. Apply power to the GC.

Remove the flame ionization detector (FID)
The FID has no replaceable parts. If it has damage (such as a broken RTD or igniter coil)
you will need to remove and replace the FID.

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.
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Figure 6-15: FID

A. Termination board
B. Cap
C. Ground shield cover
D. Mounting bracket
E. Vent connector
F. Exhaust tube

Procedure
1. Disconnect all power to the gas chromatograph (GC).

Allow at least 10 minutes for the components to cool down.
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2. Locate the FID switch, which is on the half-moon-shaped wire terminal board, and
flip it to the OFF position.

Figure 6-16: Location of the FID switch

3. Remove the explosion-proof dome and the thermal hood.
4. Remove the screw connecting the termination board to the FID cap.
5. Remove the two screws from the mounting bracket.
6. Unscrew and remove the vent connector.

Note
Use a backing wrench on the bolt fronting the FID cap when removing the vent
connector.

7. Remove the screw from the top of the FID assembly.

NOTICE
Electrostatic discharge (ESD)
Operators and technicians must wear an electrostatic wrist strap when handling
printed circuit cards to prevent shorting the boards through static electricity. Do not
install or remove the printed circuit assemblies while power is applied to the device.
Keep electrical components and assemblies in their protective (conductive) carriers
or wrapping until ready for use. Use the protective carrier as a glove when installing
or removing printed circuit assemblies.

Postrequisites
To reassemble the FID, refer to Reassemble the flame ionization detector (FID). The final
step is to flip the FID switch to the ON position.

Reassemble the flame ionization detector (FID)
Procedure

1. Insert the FID into the mounting bracket and secure with the two block screws.
2. Grasp the edges of the FID board and align with the six socket tubes that extend

into the pins in the cap.
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3. Replace the screw at the top of the FID assembly.
4. Tighten the tubing nut connector, securing the FID exhaust tube.
5. Screw in the tubing nut connectors located at the base of the FID.
6. Install the explosion-proof cover over the FID assembly and secure to the base with

eight bolts.

Replace igniter/thermocouple assembly
Figure 6-17: Igniter/thermocouple assembly front view

A. Bulkhead nut
B. Screws and washers
C. Fitting
D. Bulkhead nut
E. Igniter/thermocouple assembly
F. Igniter connector
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Figure 6-18: Igniter side view

A. Fitting
B. Screws and washers
C. Bulkhead nut
D. Black plastic edge
E. Igniter/thermocouple assembly
F. Port A
G. Port H
H. Port S

Procedure
1. Loosen the bulkhead nut.
2. Detach the igniter connector.
3. Remove the screws and washers from the plastic bracket.
4. Rotate the micro flame photometric detector (µFPD) burner around the bulkhead

nut until there is enough room to remove the igniter/thermocouple assembly.
5. Loosen the nut; then slide the igniter/thermocouple assembly and ferrule (not

shown here) out of the µFPD burner through the fitting.
6. Slide the bulkhead nut and a new ferrule on the new igniter/thermocouple

assembly. Then slide the µFPD burner through the fitting.
7. Align the black plastic edge of the igniter with the end of the nut and gradually

tighten the nut to the fitting. Keep pushing the igniter toward the burner while
tightening the nut. The back edge has to be flush with the end of nut when secured.
Tighten the nut to 4 in.-lb.
Do not overtighten the nut.

8. Rotate the µFPD burner back to its original position. Finger tighten the screws and
washers.
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9. Tighten the bulkhead nut to 20-in. lb.
10. Secure the screws and washers.
11. Reconnect the igniter connector.

Troubleshoot igniter/thermocouple assembly
Figure 6-19: Igniter/thermocouple assembly drawing

A. Purple, igniter
B. Black, igniter
C. White, thermocouple
D. Red, thermocouple

Figure 6-20: Igniter/thermocouple assembly photo

A. Back plate
B. Connectors
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• Resistances measured between pins 1 and 2 shall be 0.5 - 1.2 ohms.
• Resistances measured between pins 3 and 4 shall be less than 4 ohms.

Recommended actions
1. Detach connectors.

Voltage between pins 1 and 2 on extension cable end shall measure 3.0 to 3.3
Vdc while igniting. You can manually ignite with the Detectors pop-up window.
If no voltage is measured, you may need to replace the photomultiplier tube
(PMT) module or extension cable.

2. Remove black plate.
Igniter shall glow red while igniting or if you apply 3 Vdc to pins 1 and 2 on
burner end. Do not apply more than 3.3. Vdc to igniter. Do not apply voltage to
igniter for more than 20 seconds.

Remove the micro flame photometric detector (µFPD) burner
Use this procedure and refer to assembly drawing DE-22143 to replace the µFPD burner.

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot
unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure
that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

Tools required
• 7 ⁄64-in. Allen wrench
• Phillips screwdriver
• Flathead screwdriver
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Procedure
1. Disconnect all power to the unit. Allow at least 10 minutes for the components to

cool-down.
2. Remove the explosion-proof dome and the thermal hood.
3. Use a 7⁄64-in. Allen wrench and remove the fiber cable screws from the µFPD burner

mounting plate to disconnect the cable.

Figure 6-21: µFPD burner disassembly back view

A. µFPD burner
B. µFPD fiber cable clamp
C. Screws µFPD burner
D. µFPD fiber cable
E. Thumb screw
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4. Affix electrical tape to the end of the disconnected fiber cable to prevent debris or
moisture contamination.

Figure 6-22: µFPD fiber cable disassembled

5. Remove the two screws from the µFPD burner housing.
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6. Remove the fiber cable clamp screws and O-ring. Set aside for reassembly.

Figure 6-23: µFPD fiber cable clamp disassembly
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7. Disconnect the air intake, hydrogen intake, and sample lines.

Figure 6-24: µFPD igniter and intake lines

A. Igniter/thermocouple (TC)
B. Air intake port
C. Hydrogen intake port
D. Sample intake port
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8. Loosen the top bulkhead nut and remove the µFPD burner assembly.

Figure 6-25: µFPD burner bulkhead

A. Bulkhead nut

Install the micro flame photometric detector (µFPD) burner
Use this procedure and refer to assembly drawing DE-22143 to install the µFPD burner.

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.
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 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot
unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure
that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

Tools required
• 7 ⁄64-in. Allen wrench
• Phillips screwdriver
• Flathead screwdriver
Procedure

1. Disconnect all power to the unit.
Allow at least 10 minutes for the components to cool-down.

2. Remove the explosion-proof dome and the thermal hood.
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3. Attach the male fitting of the µFPD burner to the bulkhead nut on the GC. Finger
tighten the bulkhead nut.

Figure 6-26: µFPD burner installation

A. µFPD burner

4. Attach and finger tighten two screws/washers on the plastic bracket to center post.
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5. Tighten the bulkhead connector with torque of 20 in. lb.

Figure 6-27: µFPD fiber cable clamp assembly

6. Install the fiber cable to the µFPD burner connector and secure with cable clamp.
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7. Install the two screws in the rear of the µFPD burner housing.

Figure 6-28: µFPD burner assembly

A. µFPD burner
B. µFPD cable clamp
C. Screws µFPD burner
D. µFPD fiber cable
E. Thumb screw
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8. Connect the igniter, air intake, hydrogen intake, and sample lines.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are
always hot unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make
sure that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

Figure 6-29: µFPD igniter and intake lines

A. Igniter/thermocouple
B. Air intake port
C. Hydrogen intake port
D. Sample intake port

9. Replace the thermal hood and the explosion-proof dome.
10. Apply power to the GC.
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Remove the micro flame photometric detector photomultiplier
tube (µFPD PMT) module

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot
unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure
that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

Tools required
• 7 ⁄64-in. Allen wrench
• Phillips screwdriver
• Flathead screwdriver
Procedure

1. Disconnect all power to the unit. Allow at least 10 minutes for the components to
cool-down.

2. Remove the explosion-proof dome and the thermal hood.
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3. Use a 7⁄64-in. Allen wrench and loosen the fiber cable screws from the µFPD burner
mounting plate to disconnect the cable.

Figure 6-30: µFPD burner disassembly

A. µFPD burner
B. Fiber cable clamp
C. Screws µFPD burner
D. µFPD fiber cable
E. Thumb screw
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4. Affix electrical tape to the end of the disconnected fiber cable to prevent debris or
moisture contamination.

Figure 6-31: µFPD fiber cable disassembled
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5. Loosen the screws holding the fiber cable bottom clamp. Slide the bottom clamp up.

Figure 6-32: µFPD fiber cable clamp disassembly
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6. Loosen the thumb screw and carefully lift and tilt the Ultem plate and upper
assembly.

Figure 6-33: Upper assembly tilted
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7. Loosen the fiber cable clamp screws and disconnect the fiber cable from the PMT.

Figure 6-34: Fiber cable disconnected from the µFPD PMT module

A. Fiber cable
B. Cable clamp
C. Cable clamp screws
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8. Disconnect the wire terminals for J6, J10, and J2.

Figure 6-35: µFPD PMT module connections

A. J6 - CAN and power signals
B. J10 - igniter
C. J2 - thermocouple
D. USB connector
E. PMT module bracket screws
F. Stream manifold screws
G. Stream manifold

9. Loosen the two Phillips screws from the stream solenoid manifold.
10. Move the entire manifold away from the µFPD PMT module.
11. Use a large flat head screwdriver to loosen the two µFPD PMT module bracket

screws.
12. Move the 1/16-in. stainless steel tubing away and pull the µFPD PMT module out of

the enclosure.

Install the micro flame photometric detector (μFPD) photo
multiplier tube (PMT) module
Tools required
• 7 ⁄ 64-in. Allen wrench
• Phillips screwdriver
• Flathead screwdriver

Procedure
1. Lower the µFPD PMT module into the enclosure.
2. Use a large flathead screwdriver to tighten the two µFPD PMT module bracket

screws.
3. Use a Phillips head screwdriver and tighten the two screws to attach the stream

solenoid manifold.
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4. Attach the J6, J10, and J2 wire terminals to the µFPD PMT module.

Figure 6-36: µFPD PMT module connections

A. J6 - CAN and power signals
B. J10 - igniter
C. J2 - thermocouple
D. USB connector
E. PMT module bracket screws
F. Stream manifold screws
G. Stream manifold
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5. Connect the fiber cable to the µFPD PMT module and tighten the two cable clamp
Allen screws.
The shoulder of fiber cable shall be flush with clamp surface to ensure fiber cable is
fully inserted into PMT module.

Figure 6-37: Fiber cable connected to the µFPD PMT module

A. Fiber cable
B. Cable clamp
C. Cable clamp screws
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6. Carefully tilt and lower the Ultem plate and upper assembly. Tighten the thumb
screw.

Figure 6-38: Upper assembly tilted

7. Remove electrical tape on the end of the fiber cable.
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8. Insert the fiber cable into the µFPD burner.

Figure 6-39: µFPD fiber cable assembly

A. µFPD burner
B. Fiber cable clamp
C. Screws µFPD burner
D. µFPD fiber cable
E. Thumb screw

9. Tighten the burner fiber cable clamp screws.
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10. Tighten the fiber cable upper clamp screws.

Figure 6-40: µFPD fiber cable clamp assembly

11. Replace the insulated cover and the explosion-proof dome.
12. Apply power to the gas chromatograph (GC).
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6.4.9  Maintain the methanator
The optional methanator, which is a catalytic converter, converts otherwise undetectable
CO2 and/or CO into methane by adding hydrogen and heat to the sample. The methanator
requires little maintenance.
Order Rosemount Kit PN 2-3-0710-265 for the methanator replacement parts.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot
unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure
that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

Note
Insulate the methanator assembly to prevent heat loss.
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Figure 6-41: Methanator assembly

A. Methanator housing cover
B. Heater insulator (2)
C. Heater insulator, split
D. Heater block, methanator bottom
E. Methanator column
F. RTD
G. Cartridge heater
H. Heater block, methanator top
I. Methanator housing

The RTD is replaceable. When replacing it, take care to anchor the RTD cable to the tubing
to prevent loosening over time.
To replace the RTD, consult drawing #CE-22715.
Related information
List of engineering drawings - Rosemount 700XA

6.4.10  Measure vent flow
Prerequisites
You will need an accurate flow meter for this measurement.
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Procedure
1. Consult the parameter list that was provided with the gas chromatograph (GC) to

learn the appropriate flow rate.
2. Attach a flow meter to each measurement vent output on the side of the GC that is

labeled MVn, where n is for each vent.
The flow should match the value displayed in the parameter list.

6.4.11  Access electrical components
Emerson designed the gas chromatograph (GC) to operate for long periods of time without
needing preventative or regularly scheduled maintenance.
The enclosure is explosion-proof, dust-proof, water-proof, and flame-proof.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot
unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure
that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

Prior to opening the GC, use MON2020 to ensure that there are no configuration or
parameter errors.
Procedure

1. Ensure electrical power is disconnected from the GC and the environment is safe.
2. Allow the GC to cool.
3. Unscrew and remove the front panel.
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Figure 6-42: Remove the front panel

4. Unscrew and remove the switch panel or LOI.

Figure 6-43: Remove the switch panel or LOI

The PCBs are located in the card cage.

Operation and maintenance Manual
November 2023 MS-00809-0100-0700

152 Emerson.com



Figure 6-44: PCBs in the card cage

5. Note the location and direction of any board removed. Release the catch(es) and
remove/replace the circuit board(s) as necessary.

6. Close and latch the electronics enclosure door.
7. Apply power to the GC.

Replace AC/DC power supply
The AC/DC power supply is mounted on the left wall of the lower enclosure adjacent to
the card cage. To access it, remove the front panel and the switch panel or local operator
interface (LOI) from the lower enclosure.

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.
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Figure 6-45: AC/DC power supply in lower compartment

Prerequisites
A Cross point #2 Phillips screwdriver is required to remove and replace the AC/DC power
supply.
Procedure

1. Remove power from the gas chromatograph (GC).
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2. Unscrew and remove the front panel.

Figure 6-46: Removing the front panel

3. Unscrew and remove the switch panel or LOI to allow access to the card cage.

Figure 6-47: Removing the switch panel or LOI
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4. If present, remove the clear cover from the card cage.

Figure 6-48: Card cage

5. Unplug all the cards in the card cage but do not remove them.
6. Unscrew the three switch panel connector posts. Remove the washers as well.
7. Lift the card cage with the boards and remove it from the lower enclosure.
8. Unscrew and remove the post closest to the power supply.
9. Unplug the connector at the top of the power supply on the left.

10. Unplug the low voltage cable connected along the lower edge of the backplane.
11. Disconnect the ground lead from the power supply at the chassis ground

immediately inside the lower enclosure opening.
12. Remove the nut just above the power supply. Twist the power supply free of the

attaching stud and lift it from its anchor plate. Remove the power supply carefully to
avoid damage due to wire interferences.

13. Using a Phillips screwdriver, remove the two screws attaching the anchor plate to
the inside of the enclosure.

14. Remove the anchor plate through the front opening of the enclosure.
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15. The replacement power supply is shipped with the new anchor plate attached to it
with a nut. Remove this nut to separate the new power supply and anchor plate.

Figure 6-49: Replacement power supply

A. Anchor plate
B. Nut
C. Replacement power supply
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16. Place and mount the new anchor plate to the inside of the enclosure with the
Phillips screws and a Phillips screwdriver.
The orientation of the new anchor plate will clear the threaded hole as shown in
Figure 6-50.

Figure 6-50: Power supply anchor plate in GC enclosure

17. Maneuver the new power supply into the anchor plate, ensuring that the wires are
free to be connected.
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6.4.12  Communications
The Rosemount 700XA has four serial communication ports: Port 0, Port 1, Port 2, and Port
3, which is a dedicated personal computer (PC) to gas chromatograph (GC) port.
You can set the mode for each of the first three ports to RS232, RS422, or RS485. Normally,
the customer specifies these port configurations at the time of order, and Emerson sets
them at the factory. However, the customer can use Rosemount MON2020 to change them
at any time.
Note
The backplane has two switches located at SW1. The first switch is used for starting the
DHCP server. The second switch is reserved for future use.

The backplane has two Ethernet ports:
Name Location Connector type
ETHERNET1 J22 RJ45 (DHCP-enabled)
ETHERNET2 TB11 4-wire terminal block

Related information
Connect directly to a personal computer (PC) using the gas chromatograph's (GC’s)
Ethernet1 port

Maximum distance by communication type
Communication Type Maximum distance
RS-232 50 ft (15.24 m)
RS-422/RS-485 4,000 ft (1,219.20 m)
Ethernet (CAT5) 300 ft (91.44 m)
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Change the line drivers
The following table lists the relevant traits of the gas chromatograph's (GC's) serial ports.

Port name Port mode Terminal block location on
the backplane

Communication modes
supported

Port 0 RS232 TB1

Modbus® ASCII/RTU

RS422, RS485 TB2
Port 1 RS232 TB5

RS422, RS485 TB6
Port 2 RS232 TB8

RS422, RS485 TB9
Port 3 (DB9 connector) RS232 J23 (Laptop-PC) Modbus® ASCII/RTU

Direct connection through
Rosemount MON2020

Note
You can use Port 3 to connect directly to the personal computer (PC).

 WARNING
Explosion
Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the analyzer, disconnect all electrical power and ensure that the area is
free of explosive gases.
Keep cover tight while circuits are live.
Use cables or wires suitable for the marked T ratings.
Cover joints must be cleaned before replacing the cover.
Conduit runs to the enclosure must have sealing fitting adjacent to enclosure.

 WARNING
Burns
Some parts of the analyzer may be heated to 248 °F (120 °C).
To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot
unless it has been switched off and allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure
that it has been switched off and allowed to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

The factory setting for each port is RS232. To change the setting of a serial portL
Procedure

1. Start MON2020 and connect to the GC.
2. Select Applications → Communication.

The Communication window displays.
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3. Select the appropriate mode from the Port drop-down list for the appropriate serial
port.
The options are:
• RS232
• RS485
• RS422

Figure 6-51: Rosemount MON2020 Communication window

4. Click OK.
5. Close MON2020.
6. Turn off the GC.
7. Locate and remove the base in/out (I/O) board, which is located in the card cage in

the GC’s lower enclosure.
8. Consult Figure 6-52, which shows the correct switch settings.
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Figure 6-52: Base I/O board (PN 7A00403G01/G02)

A. SW10 - ON position - factory setting

9. Consult the following figures, which show the correct switch settings for each mode.
Port 0 corresponds with channel “1” on each switch; Port 1 corresponds with channel
“2” on each switch; Port 2 corresponds with channel “3” on each switch.

Figure 6-53: RS-232 switch

Figure 6-54: RS-422 (full duplex/four-wire) switches
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Figure 6-55: RS-485 (half duplex/two-wire) switches

Therefore, if you want to set Port 1 to RS-232 mode, you would set channel 2 on
SW13 to the down position.

10. To learn the location of a switch on the Base I/O board, consult Figure 6-56:

Figure 6-56: Serial port switches on the base I/O board

11. Make sure that SW12 is set to the down position or Port 0 will not function.
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Note
Ordinarily SW12 should never be adjusted. It is used by the factory for testing
purposes. If it was somehow set to the top, be sure to return it to its factory-set
position, which is the down position.

12. To enable line termination for a serial port, set the appropriate port switch on SW10
to the bottom position.

13. Replace the Base I/O board in the card cage.
14. Consult Table 6-2, which shows the correct termination block wiring for each mode

and port.
Table 6-2: Port configurations
The first column lists the port number; the first row lists the communications mode. The table cell at which the
desired port and the desired mode intersect contains the appropriate wiring for that configuration.

RS232 RS422 (full duplex/4-wire) RS485 (half duplex/2-wire)
Port 0

Port 1

Port 1 N/A N/A

Port 2
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15. Access the backplane and see Figure 6-57 to locate the appropriate terminal blocks:

Figure 6-57: RS232 and RS485, TB1 and TB2 on the backplane
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A. TB1, Serial Port 0, RS232
B. TB2, Serial Port 0, RS422/485
C. TB5, Serial Port 1, RS232
D. TB8, Serial Port 2, RS232
E. TB9, Serial Port 2, RS422/485

16. Once the appropriate termination blocks are wired correctly, close and secure the
electronics enclosure door, and apply power to the GC.

Install optional RS-232 serial ports
You can install an optional RS-232 board in one or both of the expansion in/out (I/O) slots
provided on the gas chromatograph's (GC's) card cage in the electronics enclosure.
You can use this extra port for Modbus® ASCII/RTU communications or to connect directly
to a computer installed with Rosemount MON2020.
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Figure 6-58: RS-232 connections

Terminal Label Definition
1 RX Receive
2 TX Transmit
3 RTS Request to send
4 DTR Data termininal ready
5 GND Ground

Procedure
1. Start Rosemount MON2020 and connect to the GC.
2. Select Tools → I/O Cards.
3. Identify the appropriate card slot under the Label column and then select

Communications module - RS232 from the appropriate Card Type drop-down list.
4. Click OK.
5. Turn off the GC.
6. Install the RS-232 board into the appropriate I/O card slot in the GC’s card cage.
7. Close and secure the electronics enclosure door.
8. Apply power to start the GC.

Install an optional RS-485/RS-422 serial port card
You can install an optional RS-485 board in one or both of the expansion in/out (I/O) slots
provided with the gas chromatograph's (GC's) card cage in the electronics enclosure. You
can configure this card to RS-422 (four wire) or RS-485 (two wire) mode.
RS-485 mode is the default setting. See Emerson.com/ROC800-Series.
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Procedure
1. Start Rosemount MON2020 and connect to the GC.
2. Go to Tools → I/O Cards.

The I/O Cards window displays.
3. Identify the appropriate card slot under the Label column and then select

Communications module - RS422/485 from the appropriate Card Type drop-down
list.

Figure 6-59: Rosemount MON2020 I/O Cards window

4. Click OK.
5. Turn off the GC.
6. Install the RS-485/RS-422 serial port card into the appropriate expansion slot in the

GC’s card cage.
7. Replace the card cage cover, local operator interface (LOI) board, and enclosure

cover. Start the GC.

Configuring the optional RS-485 serial port to function as an
RS-422 serial port
See Table 6-3 for the correct jumper settings to configure the optional RS-485 serial port to
function as an RS-422 serial port:

Table 6-3: Configuring the serial connections for RS-485/RS-422 serial communications
Jumpers RS-485 (half duplex/2-wire) RS-422 (full duplex/4-wire)
J3 Half Full
J5 Half Full

Termination IN Termination OUT
J4 In Out
J6 In Out
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Table 6-3: Configuring the serial connections for RS-485/RS-422 serial communications
(continued)
Jumpers RS-485 (half duplex/2-wire) RS-422 (full duplex/4-wire)
TB1 wire terminals RS485 (half duplex/2-wire) RS422 (full duplex/4-wire)
A RxTx+ Rx+
B RxTx- Rx-
Y Normally closed Tx+
Z Normally closed Tx-

6.4.13  Installing or replacing a FOUNDATION™ Fieldbus module
Figure 6-60: FOUNDATION Fieldbus module

The FOUNDATION Fieldbus module should be mounted adjoining the card cage. It is held in
place by the LOI post tips that attach to the LOI posts.
Mounting the FOUNDATION Fieldbus module requires the following items:
• A FOUNDATION Fieldbus module
• A FOUNDATION Fieldbus assembly bracket
• A FOUNDATION Fieldbus cable assembly
• Two screws
• Two flat washers
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Remove a FOUNDATION™ Fieldbus module
Note
Be sure to properly ground yourself before performing this procedure.

Procedure
1. Unscrew the two local operator interface (LOI) post tips.

You can now detach the FOUNDATION Fieldbus module from the card cage.
2. Remove the two screws that attach the FOUNDATION Fieldbus assembly bracket to the

FOUNDATION Fieldbus module.

Install a FOUNDATION™ Fieldbus module
NOTICE
Properly ground yourself before performing this procedure.

Note
The gas chromatograph (GC) draws 21 mA from the FOUNDATION Fieldbus module.

Procedure
1. Attach the Fieldbus assembly bracket to the FOUNDATION Fieldbus module by aligning

the two holes in the Fieldbus assembly bracket with the two holes at the bottom of
the FOUNDATION Fieldbus module and screwing in the two thumb screws.

2. Attach the Fieldbus assembly bracket to the card cage by aligning the Fieldbus
assembly bracket's second set of holes with the local operator interface (LOI) post
tip holes in the card cage.

3. Screw in the LOI post tips.
4. Use the Table 6-4 to connect the FOUNDATION Fieldbus cable assembly to the

backplane:
Table 6-4: FOUNDATION Fieldbus wiring
Backplane terminal block Post number Wire color
TB15 1 Brown

2 White
3 Green

TB13 3 Red
4 Black

Connect the GC’s FOUNDATION™ Fieldbus module to a Fieldbus
segment
The FOUNDATION Fieldbus module has a terminal at TB1 on the carrier board, which is the
middle card in the stack. This terminal can be used to connect to a fieldbus segment.
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Figure 6-61: Carrier board showing connector at TB1

To connect to a fieldbus segment, do the following:
Procedure

1. Attach one end of a wire to 1 on the TB1 terminal and to the positive (+) terminal on
the fieldbus segment.

2. Attach one end of a wire to 2 on the TB1 terminal and to the negative (-) terminal on
the fieldbus segment.
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Connect the optional ground wire
Figure 6-62: Carrier board showing ground lug at TB2

NOTICE
The FOUNDATION Fieldbus module is designed to be intrinsically safe; however attaching a
ground wire will nullify this feature.

Procedure
If you wish to provide the FOUNDATION Fieldbus module with surge protection, connect the
ground lug at TB2 on the module’s carrier board to the frame of the gas chromatograph
(GC).

FOUNDATION™ Fieldbus jumper settings
In order for the FOUNDATION Fieldbus module to work correctly, you must set several
jumpers that are spread across a number of circuit boards.
Table 6-5: FOUNDATION Fieldbus jumper settings
Board Jumper Set?
Preamplifier JP1 No
Heater Solenoid Driver(s) JP1 No
Base I/O JP1 Yes

JP2 No
JP3 Yes (Pins 2 and 3)

CPU S3 No
S4 No

LOI J1 Yes
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For more details, consult the following drawings:

Figure 6-63: Preamplifier board

JP1 on the preamplifier board should not be set. The preamplifier board is located in slot 1
of the card cage.

Figure 6-64: Heater/solenoid driver board

JP1 on the heater/solenoid driver board should not be set. The heater/solenoid driver
board is located in slot 2 of the card cage. If there is an additional heater/solenoid driver
board, it will be located in slot 4, and its JP1 jumper also should not be set.
The Base I/O board, which is located in slot 3 of the card cage, has three jumpers that
affect the performance of the Foundation Fieldbus.
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Figure 6-65: JP1 on the Base I/O board

JP1 on the Base I/O board should be set.

Figure 6-66: JP2 on the base in/out (I/O) board

JP2 on the Base I/O board should not be set.

Figure 6-67: JP3 on the base I/O board

Operation and maintenance Manual
November 2023 MS-00809-0100-0700

174 Emerson.com



JP3 on the Base I/O board has three pins, and the jumper should be set on pins 2 and 3.

Figure 6-68: CPU board

S3 and S4 on the CPU board should be switched to OFF, which is the left-most position
while holding the board right-side up.

Figure 6-69: LOI board

The J1 jumper is located on the back of the LOI, at the top while holding the LOI right-side
up. It should be set.

6.4.14  Analog inputs and outputs
Use MON2020 to calibrate or adjust the analog outputs.
However, make sure to measure these outputs with a calibrated digital meter upon initial
installation at zero scale and full scale. Then use MON2020 to set the sapn so that it
represents values from 0 to 100 percent of the user-defined units in use.
Nominally, calibration is made within a range of 4-20 milliamperes (mA) output from each
analog channel. To set a reference point to trigger an alarm condition, configure zero scale
calibration with a 0 mA output and full scale calibration set up to 22.5 mA output.
If there is reason to suspect that the span on any particular channel might be off after a
period of time and heavy use, then recalibrate the analog output for that channel.
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Analog output adjustment
Emerson sets the initial analog output adjustments at the factory before shipment at
standard values (4-20 mA). You many need to check and/or adjust these values depending
on output cabling/impedance.
The adjustment may require two people if the units are some distance apart. It requires a
calibrated digital meter to check the zero and full scale values at the receiving end. You can
use MON2020 to adjust the scale or span value.
You can use different engineering units, volts, and percentages to calibrate the analog
outputs.

6.4.15  Upgrading the embedded software
The base GC firmware performs functions similar to operating systems such as DOS,
Windows™, or Linux®. The base GC firmware provides the basic resources and interfaces
to run the customer's applications. There is no direct user-level interface to the firmware.
If you need to upgrade the firmware to your system, refer to the MON2020 Software for
Gas Chromatographs Reference Manual for additional information.
The GC’s applications use the tools provided by firmware to perform the desired gas
chromatograph applications for the user. There are different applications to facilitate
different gas chromatographic needs. To load a new application or to upgrade an existing
application, refer to the MON2020 Software for Gas Chromatographs Reference Manual for
details.
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7  Troubleshooting
The information is arranged either by major subsystems or by major functions of the gas
chromatograph (GC).
Note
Correct all alarms before recalibrating.

7.1  Hardware alarms
Use LTLOI Failure through Flame Photometric Detector Board 1 Comm Failure to identify
the alarm, potential cause, and solution for the problem.

7.1.1  LTLOI Failure
Recommended actions

1. Power the gas chromatograph (GC) down completely.
2. Check that the local operator interface (LOI) is connected to the backplane

board at one end and the LOI board at the other end.
3. Power up the GC.
4. If the message appears again, replace the LOI board.

7.1.2  Maintenance Mode
A technician has put the gas chromatograph (GC) into Maintenance mode for servicing.

Recommended action
To disable Maintenance mode, deselect the Maintenance Mode check box in the
System dialog.

7.1.3  Power Failure
Potential cause
The gas chromatograph (GC) has experienced a restart, caused by a power failure, since
alarms were last cleared.

Recommended action
Allow the GC to automatically restart in Warm Start mode.
During Warm Start mode, the GC does the following:

a. Waits for the heaters to stabilize.
b. Purges the sample loop.
c. Actuates the valves for two cycles.

After completing these actions, the GC switches to auto-sequence mode.
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7.1.4  User Calculation Failure
The gas chromatograph (GC) has detected one or more errors while parsing a user-defined
calculation.
Potential cause
This usually happens when a user-defined calculation attempts to use a system variable
that does not exist.

Recommended action
Fix the calculation that is referring to the undefined system variable.

7.1.5  Low Battery Voltage
The gas chromatograph (GC) has detected a low battery voltage on the central processing
unit (CPU) board.

Recommended actions
Replace the CPU board immediately to avoid losing GC configuration data.

a) Save the diagnostic data file. In Rosemount MON2020, go to Tools → Save
Diagnostic Data....

b) Power down the GC.
c) Ensure that SW7 on the CPU board is in the On position.
d) Replace the CPU board.
e) Restore configuration back to the GC. In Rosemount MON2020, go to File → 

Restore Configuration to GC....

7.1.6  Preamp Board Comm Failure
The gas chromatograph (GC) cannot detect the preamp board.
Preamp board 1 or 2.

Recommended actions
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot on the backplane.

In Rosemount MON2020, select Hardware → Installed Hardware for hardware
slot locations.

3. Power up the GC.
4. If the message appears again, replace the preamp board.

7.1.7  Flame ionization detector (FID), flame photometric
detector (FPD), or µFPDG2 (FPDG2) Failure
Alert message identifies FID/FPD or FPD G2 hardware. The FID/FPD or µFPD is not
detected.

Recommended actions
1. Power the gas chromatograph (GC) down completely.
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2. Check that the board is properly seated in the correct slot (Preamp 2) on the
backplane.

3. Power up the GC.
4. If the message appears again, for the FID, replace the electrometer. For the

µFPD, replace the photomultiplier tube (PMT) module.

7.1.8  Heater Solenoid Board (1 or 2) Comm Failure
Heater/solenoid board not detected.

Recommended actions
1. Power the gas chromatograph (GC) down completely.
2. Check that the board is properly seated in the correct slot (Heater Solenoid 1 or

Heater Solenoid 2) on the backplane.
3. Power up the GC.
4. If message appears again, replace the heater/solenoid board.

7.1.9  Base in/out (IO) Board Comm Failure
The gas chromatograph (GC) is not detecting the base IO (multifunction IO) board.

Recommended actions
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot on the backplane.
3. Power up the GC.
4. If message appears again, replace the base IO board.

7.1.10  Stream Skipped
The gas chromatograph (GC) cannot analyzer one or more streams in the stream
sequence, because the streams' Usage option is set to Unused.

Recommended actions
In Rosemount MON2020, do one of the following:
• Remove the unused stream(s) from the stream sequence.
• Change the Usage option of the stream(s) in the Streams dialog to something other

than Unused.

7.1.11  GC Idle
Potential cause
Someone has placed the gas chromatograph (GC) in Idle mode. The GC is not running an
analysis.

7.1.12  Heater (1-8) Out of Range
The gas chromatograph (GC) has failed to regulate heater zone temperatures for the
indicated heater to within preset limits.
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Recommended actions
1. Check temperatures within the GC, using Rosemount MON2020 or the local

operator interface (LOI).
Be aware that the GC may generate this alarm following start-up or if the set
point has been changed.

2. Check wiring, looking for splits or loose connections at the termination board
(for both the heaters and the RTDs.

3. If necessary, replace the defective heater and/or RTD.

7.1.13  Flame Out
Detector 1 Flame Out
The flame ionization detector (FID) or flame photometric detector (FPD) will not light or has
extinguished.
Potential cause
The FID is out.

Recommended actions
1. Use the front switch panel or Rosemount MON2020 to ignite the flame.
2. If unable to sustain the flame, confirm that both fuel and air cylinders are

connected and contain sufficient pressure.
3. Confirm that the fuel and set points are set to achieve the factory-desired

mixture.
4. Confirm that there is no blockage at the FID exhaust outlet, such as a cap or ice.
5. Check that the wiring connections are secure for the FID, both on the FID cap

and at the termination board.
6. If necessary, replace the FID module.

To ignite the flame manually:
1. Connect the air to the inlet and slowly bring the pressure to 60 psig (4.1 barg).
2. Connect hydrogen to the inlet and slowly bring the inlet pressure to 60 psig (4.1

barg).
3. Remove tubing from the flame cell exhaust and use a digital flow meter to

adjust the air control valve until you obtain a reading of 160 cc/min.
4. Turn off the air supply.
5. Set the auto relight switch (S1) on the electrometer printed circuit board (PCB)

to the OVERRIDE position.
6. Use the digital flow meter to adjust the hydrogen control valve until you obtain

a reading of 100 cc/min.
7. Turn on the air supply.
8. Set the auto relight switch (S1) on the electrometer PCB to the RUN position.

The auto relight sequence begins as follows:
a. The LED on the electrometer comes on after 10 seconds, and the glow

plug fitted to the side of the flame cell is supplied a voltage.
b. After another five seconds, the hydrogen shut-off valve operates.
c. The gas mixture ignites.
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d. If the flame does not light in five seconds, the electrometer de-energizes
the hydrogen shut-off valve to stop the flow into the flame cell.

e. The flame cell is purged with air and nitrogen carrier gas.
f. The process starts again (up to ten times) until the flame stays lit.

g. If the flame does not stay lit, the LED flashes. If the alarm output is
linked to the 2350A controller discrete input, an alarm is present on the
controller.

h. Set the auto relight switch (S1) on the electrometer PCB to the RESET
position and then back to the RUN position.

i. The relight sequence restarts.

Potential cause
The FPD is out.

Recommended actions
1. In Rosemount MON2020, click Open H2 Valve.

The H2 Valve Cur State field changes to Open.
2. Click Ignite.

The Flame Status field changes when the internal temperature exceeds the
value set in the Flame On Sense Temp field.
Note
If the Flame Ignition field is set to Auto, the GC will automatically restart the
flow if it goes out.

3. If the GC fails to light after resetting the electrometer, recheck the air and
hydrogen flow.

7.1.14  Flame Over Temperature
Detector 1 flame over temperature.
The flame ionization detector (FID) flame temperature is above safe limits set at the
factory. The FID flame has been extinguished, the fuel supply valve closed, and automatic
analyses halted.

Recommended actions
1. Confirm that both fuel and air cylinders are connected and contain sufficient

pressure.
2. Confirm that fuel and air set points are set to achieve desired mixture.
3. Use the local operator interface (LOI) or Rosemount MON2020 to ignite the FID.

7.1.15  Detector Scaling Factor Failure
The gas chromatograph (GC) detected an excess scaling factor deviation for the detector.
Detectors 1-3.

Recommended action
Replace the preamp board.
The preamp boards for detectors 1 and 2 are located in Preamp 1.
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The preamp board for detector 3 is located in Preamp 2.

7.1.16  No sample flow (1 or 2)
This alarm applies to the optional sample flow switch. The corresponding flow switch
indicates that there is no sample flow in the gas chromatograph (GC).

Recommended actions
Check the sample gas rotameter in the sample conditioning system for flow.
• If no gas flow or no rotameter is present:

a. Confirm that there is gas flow at the sample point location.
b. Ensure that the sample valves in the sample conditioning system are open.
c. Ensure that the bypass return vent path is free of obstruction.
d. Confirm that the sample line is connected from the sample point to the GC's

sample conditioning system and is free of obstruction.
e. Close the valve at the sample tap, remove pressure from the line, and check

the filters at the probe, the sample conditioning system, or both. If they are
filled with liquids or particulates, replace the filtering elements.

• If automatic stream selection valves are present, confirm that they are operating
properly.

• If a slight sample gas flow is present at the rotameter in the sample conditioning
system, drain or replace all filters.

• If you observe flow in the rotameter, replace the sample flow switch.

7.1.17  Low Carrier Pressure (1-4)
Input carrier pressure for the detector is below the preset limit.

Recommended actions
1. Check that the carrier cylinder pressure is at least 10 psig (0.69 barg) above the

mechanical regulator set point.
2. If input carrier pressure is low, check the carrier cylinder pressure.
3. Replace the carrier gas cylinder if required.

7.1.18  Analog Input (1-10) High Signal
Measured value for the indicated analog input is greater than the customer-defined full
scale range.

7.1.19  Analog Input (1-10) Low Signal
Measured value for the indicated analog input is lower than the customer-defined full scale
range.

7.1.20  Analog Output (1-10) High Signal
Measured value for the indicated analog output is greater than the customer-defined full
scale range.
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7.1.21  Analog Output (1-10) Low Signal
Measured value for the analog output is lower than the customer-defined zero range.

7.1.22  Stream (1-20) Validation Failure
The most recent validation sequence for the indicated stream failed.

Recommended actions
1. Ensure that the validation gas cylinder isolation valves are open.
2. Ensure that the validation gas regulators are set properly.
3. If the validation gas regulator pressure is below the set point, replace the gas

bottle with a full one.
4. If the gas used for validation is the same as the gas that is used for calibration,

ensure that the cylinder gas composition value listed on the cylinder's tag or
on the certificate of analysis received from the supplier matches the value
displayed in Rosemount MON2020's Component Data table.

7.1.23  Stream (1-20) RF Deviation
The most recent calibration sequence failed.

Recommended actions
1. Ensure that the calibration gas cylinder isolation valves are open.
2. Ensure that the calibration gas regulators' pressures are set properly and that

the cylinder is not below the set point. If the cylinder is below the set point,
replace it with a full cylinder

3. Verify that the calibration cylinder gas composition value listed on the cylinder
tag or on the certificate of analysis received from supplier matches the
calibration cylinder gas composition value displayed in Rosemount MON2020's
Component Data table. If there is a mismatch, edit the Component Data table to
reflect the correct value. Re-run the calibration sequence.

4. If the calibration is still unsuccessful, contact your Emerson representative.

7.1.24  Energy Value Invalid
For each configured analysis, perform a check of the analyzed energy value of the
calibration gas against the known value as part of the warm start sequence.
The Energy Value Invalid alarm is raised to instruct the associated DCS that the analyzer has
failed and all data should be ignored until a successful calibration run has been performed
to verify the analysis of the gas chromatograph (GC).
On completing warm-up, the GC performs a single analysis of the calibration stream. Using
results of the analysis, the GC calculates the energy value and compares it against the
previously entered value stored in the tables.
If the calculated energy value is within the allowable limits set up by the operator, the
Energy Value Invalid alarm is cleared, and the GC returns to normal operation; otherwise,
the Energy Value Invalid alarm remains active.

Recommended actions
1. Ensure that correct calibration gas energy value and limits have been entered in

the Component Data Table → Edit Energy Value dialog.
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2. Ensure the calibration gas bottle is open and not low or empty.
3. Check analyzed concentration results for each individual component versus

calibration gas concentrations in the Component Data table.
4. Adjust timed events if necessary.

7.1.25  Calibration Energy Check Fail
After completing a calibration sequence, the gas chromatograph (GC) performs a
calibration gas energy value check.
If the calculated energy value fails the check, the software automatically runs the
calibration again.
If the second calibration also fails this check, the GC raises a system alarm, Calibration
Energy Value Check Fail.

Recommended actions
1. Ensure the calibration gas bottle is open and not low or empty.
2. Check analyzed concentration results for each individual component versus

calibration gas concentrations in the Component Data table.
3. Adjust timed events if necessary.

7.1.26  Stored Data Integrity Failure
Archived results, event logs, and alarm logs are stored as records in the instrument
database along with a CRC16 checksum. When the data is retrieved, the gas
chromatograph (GC) recomputes the checksum and checks the stored checksum against
the calculated checksum. If they don't match, the GC raises a Stored Data Integrity Failure
alarm.

Recommended actions
1. Reset archives using the dialog under MON2020 → Logs/Reports Menu.

NOTICE
All archived data in the GC will be lost.

2. If this problem recurs, replace the central processing unit (CPU) board.

7.1.27  ROM Checksum Failure
The gas chromatograph (GC) recomputes the firmware checksum at periodic intervals. If
the calculated checksum varies from the original value, the GC raises a ROM Checksum
Failure alarm.

Recommended actions
1. Re-flash the GC controller firmware in Rosemount MON2020: Tools → Upgrade

Firmware.

NOTICE
All archived data in the GC will be lost.
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2. If this problem recurs, replace the central processing unit (CPU) board.

7.1.28  Sample Fluid Unavailable
The stream switching sequence defined in the Custom Logic configuration failed to
successfully execute.

Recommended action
Confirm proper operation of all sample system components and ability to provide
adequate sample flow.

7.1.29  Flame Photometric Detector Board 1 Comm Failure
The gas chromatograph (GC) cannot detect the flame photometric detector (FPD).

Recommended actions
1. Power the GC down completely.
2. Check that all cables are securely connected to the FPD interface module.
3. Power up the GC.
4. If the message appears again, replace the FPD photomultiplier tube (PMT)

module.

7.2  No power to flame photometric detector (FPD)
Recommended actions

1. Check cable (7A00454G01), connectors, and terminals.
2. Check flex cable.
3. Check that the voltage from the lower terminal is 25 Vdc.

7.3  Can't ignite flame photometric detector (FPD)
Recommended actions

1. Check the flow.
Gas flow rates are measured at exhaust while oven reaches to set temperature.
The air flow should be 150 cc/min, and the H2 flow should be 100 cc/min.

2. Check igniter resistance in ohms.
The resistance should be 0.6 to 1 ohms.

3. Ensure that the flame temperature is >> 493.1 °F (220 °C) when the ignitor is
first turned on and then goes down to 413.1 °F (140 °C).

4. Ensure that there are no restrictions at the exhaust line.

7.4  No peaks showing
Recommended actions

1. Ensure that the flame is on.
2. Ensure that the sample gas has been injected.
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3. Check carrier gas flow.
4. Check sample flow.
5. Check columns.

7.5  Small peaks
Recommended actions

1. Clean the burner windows with isopropyl alcohol (IPA).
2. Adjust the air to H2 flow rate to between 1.3 and 1.7.
3. Ensure that the flame photometric detector (FPD) high voltage is 800 Vdc for

side cart option of FPD.

7.6  No temperature readings
Recommended action
Check the thermocouple.
The thermocouple's resistance should be less than 3.5 ohms.

7.7  Noisy baseline
Recommended action
Click Autozero to adjust the baseline.

7.8  Peak clipping
Recommended action
Click Autozero to adjust the baseline.
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7.9  Test points
The backplane has a set of test points that allow you to measure the voltage output of the
base input/output (I/O) card.

Figure 7-1: Lower enclosure showing test points on the backplane

Each test point is labeled with a voltage value that, when measured with a voltmeter,
should give a measurement equal to what is displayed on the label. A reading that does
not match this label may indicate a faulty base I/O card. Try swapping out the suspect
card with a different one, and take another measurement. To get a measurement for a
test point, touch the voltmeter’s negative probe to the DGND test point and touch the
voltmeter’s positive probe to the desired test point.
The test points are associated with the following gas chromatograph (GC) components:
Table 7-1: Backplane test points and associated GC components

Test point GC component Tolerances for
DC voltages

VIN Voltage in N/A
I RTN Isolated return N/A
I 24V (regulated) Isolated voltage (loop power) 24 V (±2.4 V)
24V (regulated) GC power 24 V (±2.4 V)
17V5 Preamplifier (input for the bridge circuit) 17.5 V ±0.5 V
12V Optional I/O cards 12 V ±0.6 V
5V1 System chips 5.1 V ±0.25 V
3V4 System chips 3.4 V ±0.15 V
FVIN Field voltage input 24 V ± 1.5 V
FVGND Field voltage ground 0 V ± 3 V

The input voltage range for a DC power supply is between 23.5 and 24.5 volts.
The input range for an AC power supply is 90 to 264 volts (auto-ranging).
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7.10  Voltage LEDs
A set of LEDs can be found above the test points .
These LEDs are a quick way to visually inspect the voltage status of some of the gas
chromatograph's (GC's) electrical components.

Figure 7-2: Voltage LEDs

The following LEDs are associated with the following GC components:

VIN (fuse open) Glows red when the fuse has blown or been removed;
otherwise, it is not lit.

1 RTN - 24 loop
(Power)

Glows when the power supply for the analog outputs is
functioning properly; otherwise it is not lit.

24V regulated (GC
power)

Glows when the GC power is functioning properly;
otherwise, it is not lit.

17V (Input for the
preamp)

Glows when the power supply for the preamp is
functioning properly; otherwise, it is not lit.

12V (Input for the I/O
cards0

Glows when thee optional ROC expansion card's power
supply is functioning properly; otherwise, it is not lit.

5V1 Glows when the system chip's 5.1 V power supply is
functioning properly; otherwise, it is not lit.

3V4 Glows when the 3.4 V power supply for the system chips is
functioning properly; otherwise, it is not lit.

Power ON Glows when the GC is on; otherwise, it is not lit.
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7.11  Monitoring the detector(s) and columns
temperature
Use MON2020 to monitor the temperature of the detector(s) and columns to determine if
the GC is thermally stable.
When connected to the GC via MON2020, select Hardware → Heaters to access this
function.
When viewing the Heater window, the typical heater configuration is as follows:
• Heater 1 is the analytical block heater.
• Heater 2 is the “high hat” heater.
The Temperature column on the Heaters window displays the current temperature; the
Current PWM column displays the percentage of power being used to run the heater.
The settings and values shown in the Heaters window and described below, are preset at
the factory and are based on the specific customer application. Do not change these values
unless application engineering or or customer service personnel recommend it or as part
of a factory application requirement.
Function Typical setting
Detector(s) or analytical block temperature 176 °F (80 °C)
Oven temperature 176 °F (80 °C)
Spare
Or, Methanator
Or, LSIV

N/A
572 °F (300 °C)
302 °F (150 °C)
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A  Local operator interface (LOI)
A.1  Local operator interface (LOI) for displaying and

entering data
The LOI has multiple components that you can use to interact with the unit.

Figure A-1: LOI components

A. LCD display screen
B. Keypads
C. LED indicators
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A.1.1  LED indicators
There are three LED status indicators on the local operator interface (LOI) that show the
overall status of the gas chromatograph (GC). These LEDs are positioned to the right of the
display screen. Each LED, when lit, indicates a specific condition.

The GC is currently running an analysis.

The GC has at least one unacknowledged alarm.

The GC has an out-of-tolerance or alarm condition that requires
an operator action.

A.1.2  LCD display screen
The LCD display screen measures 4.4 by 3.3 in. (111.4 x 83.5 mm) and is capable of 640 by
480 VGA pixel resolution, supporting both text and full graphics.
The backlighting, boost, and brightness are all under software control. The boost and
brightness levels are user-adjustable.

A.1.3  Keypad
The keypad consists of eight infrared keys.

Command keys
The four keys located above the LCD display screen are command keys.

Related information
Navigating the screens

Arrow keys
The four keys below the LCD display screen are arrow keys that allow you to navigate
within the screen by scrolling or moving the cursor from field to field. These keys function
in the same way as a computer keyboard’s arrow keys.

Left Up Down Right
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Pressing a key
To press a key, place a finger on the glass over the associated key hole and then remove
the finger.
Holding a finger over the key hole will cause that key to repeat until the finger is removed.

A.2  Using the local operator interface (LOI)
A.2.1  Start-up

When the gas chromatograph (GC) starts, the local operator interface (LOI) automatically
runs in Status Display mode. Each analyzer's information is displayed in rows. The GC may
have from one to four analyzers.
Only the description and values section of the LOI status variables are scrolled manually
between the configured analyzers for the GC.

Screen Description
Status Displays information about the operational state of the analyzer, including a

manually-scrolling list of up to 25 user-selectable parameters that can be defined or
modified using the MON2020 software.
Note
There is more than one Live Chromatogram screen if the GC is configured with more
than one analysis/cycle clock.
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Screen Description
Live Chromatogram Displays the chromatogram for the current analysis in real time.

Note
There is more than one Live Chromatogram screen if the GC is configured with more
than one analysis/cycle clock. Four detectors are supported for a single analysis.
If there is more than one detector for one analysis (ex. Det 1, Det 3, Det 5), D1/3/5
displays on the title bar.

If there are four live analyses for the GC, the Analysis screen displays for each clock.

Note
This screen does not display if the GC is not currently analyzing a sample.

Active Alarms Lists active alarms, if any.
Heater Displays information about the PID temperature control loops.
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Screen Description
Valves Displays the settings and states of the stream and analyzer valves.

In Status Display mode, pressing the RIGHT key takes you to the next available non-idle
analysis live CGM screen. If all the cycle clocks are idle, then press RIGHT on the Status
screen to go to the Alarm screen. Press LEFT on the Alarm screen to go to the Status
screen. When you press RIGHT, the LOI displays each screen in succession and then loops
back to the Status screen.

Figure A-2: LOI Status screen

This screen displays the Analysis names and all the four cycle clocks in the Status table.
The LOI status variables are shown for one cycle clock every 15 seconds as depicted in
Figure A-2. For the next 15 seconds, the LOI automatically scrolls and displays the next
cycle clock’s variables.
In Status Display mode, you can manually scroll to the next screen using the RIGHT key, or
to the previous screen using the LEFT key. You can pause automatic scrolling at any time by
pressing the EXIT key, and you can resume automatic scrolling by pressing either the LEFT
or the RIGHT key. Automatic scrolling resumes after ten minutes of keypad inactivity.
Press F1 when MOVE is displayed in the green box below to foucs inside the screen, so that
you can navigate through the controls of the screen using the LEFT, RIGHT, UP, and DOWN
keys. Press EXIT to return focus to the top level (outside of the screen). Press LEFT or RIGHT
at the top level to resume automatic scrolling in addition to moving to the previous or next
screen.
At any time, while in Status Display mode, you can press ENTER or F2 to enter the Main
Menu. Use the EXIT key to leave the Main Menu and return the LOI to Status Display mode.
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If you log onto the GC from the Main Menu to perform operations or edit data, when you
exit the menu you will automatically be logged off the LOI.

A.2.2  Navigating menus
The Status screen is now the default home screen. This screen lists information from the
four analyzers as well as the local operator interface (LOI) variables.
You can also access the Status screen from the Application menu. This Status screen
displays the same list of items as the Home Status screen but, the F1 key has works
differently here. The Move label displays as soon as you select the Status screen from the
Application menu.
When the user presses F1 then, the Move label changes to Next, indicating that the LOI
status variables for the next analyzer are displayed at the bottom of the page. If you press
F1 again, the status variables for next analyzer displays. These LOI status variables keep
revolving between the analyzers in order every time you press F1.

Figure A-3: LOI Home (Status) screen

At any time while in Status Display mode, you can press ENTER or F2 to enter the Main
Menu.
Use the UP or DOWN keys to navigate between fields or controls within each drop-down
menu. Pressing DOWN while focus is on the last field of a drop-down menu moves the
focus to the first field on a screen. Alternatively, pressing UP while focus is on the first field
of the drop down menu causes the focus to move to the last field.
Use the ENTER key from the Main Menu to activate submenus and individual menu items.
Press EXIT to leave the Main Menu and return the LOI to Status Display mode if no menu is
dropped down. If a menu is dropped down, then pressing EXIT closes that menu.
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If you log in to the gas chromatograph (GC) from the Main Menu to perform operations or
edit data, when you exit the menu you will automatically be logged off the LOI.
The Main Menu allows you access to all of the available LOI screens; however, you must be
logged on to make changes. If you are not logged on and you attempt to edit a field, the
Login screen will appear first.
After a period of fifteen minutes of inactivity, the LOI automatically logs you off.

A.2.3  Navigating the screens
Local operator interface (LOI) screen have several functions. They can display data for
review or edit and initiate activities.

Figure A-4: LOI Home (Status) screen

Within any given screen, the function of the ENTER key depends upon the context. You can
use it to validate and save changes or to initiate an action.
If the gas chromatograph (GC) finds a validation error after you press ENTER, an Invalid
Entry message displays. Press ENTER again to close the message and then re-enter your
data.
Press EXIT to close the currently open screen. If you have made changes to the screen,
the LOI will display a confirmation message asking if you want to save your changes. Use
the arrow keys to select the appropriate button and press ENTER. If you select No, your
changes will be discarded and the Main Menu will display; if you select Cancel, the message
window will close and you will be returned to the current screen; if you select Yes, your
changes will be validated and saved and then you will be returned to the Main Menu.
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The F1 and F2 keys are context dependent. A one-word description of the function of each
of these keys displays in a green prompt box directly under the key in the title bar of the
top-level full-sized screen.
In some cases, F1 acts as a toggle between scrolling either a line or a page at a time. When
this is true, the currently selected option (LN or PG) displays with a green background and
black text, while the non-selected option displays with a black background and green text.
The table below lists the possible functions of the F1 key:

Press F1 to move the cursor around within the boundary of the screen.

Press F1 to open the edit dialog for the field that contains the cursor.
The type of dialog that displays depends upon the type of field to be
edited.
Press F1 to select the field to be edited.

Press F1 to delete the character to the left of the cursor.

Press F1 to scroll line by line within a screen.

Press F1 to scroll page by page within a screen.

Press F1 to click the button and execute the command

Note
Throughout this appendix, when referring to the F1 key, the key’s current valid function will
be indicated in parenthesis—for instance, F1 (MOVE) or F1 (SELECT).

The F2 key, when MAIN is displayed in the prompt box, closes all screens and goes back to
the Main Menu.
There is a navigation icon in the upper right corner of the screen that indicates which
navigation keys are active for the currently displayed screen.
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Figure A-5: Navigation keys

A. None
B. Left
C. Up
D. Right
E. Down
F. Left/right
G. Up/down
H. All

When you press a key, a green check will flash in the upper left corner if the key is valid; if
the key is not valid, a red cross (X) will flash in the upper left corner.
Related information
Editing numeric fields
Editing non-numeric fields

A.2.4  Editing numeric fields
When the focus is on an editable field, pressing F1 (EDIT) will display the Edit dialog
containing the field’s original text.
Use the LEFT or RIGHT keys to move through the individual characters within the field and
to select the character to be changed. Use the UP or DOWN keys to select the value of each
digit. The possible values are 1, 2, 3, 4, 5, 6, 7, 8, 9, 0, "-” (minus), “.” (period), and E.
Special characters supported are: @, !, #, $, %, , &&, *, “_”, = , and ?
The “-” value is available for signed numbers.
The “.” and the E values are available for floating-point numbers, except for retention times
and timed event values.
The following rules apply when entering a floating-point value:
• More than one E is not allowed.
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• More than one “.” is not allowed.
• If the previous position is an E, then a “.” and a 0 are not allowed.
• A “-” is allowed only after an E or at the first position.
• If the previous position is “.”, then an E is not allowed.
• If the first character is a “-” and the current index is 1, then a “.” is not allowed.
• If the previous position is a “-”, then a 0 is not allowed.
• If the next character is an E, then a “.” is not allowed at the previous location.
The DOWN key moves backward in the list from the current value of the selected digit.
The UP key moves forward in the list from the current value of the selected digit.
The F1 (BACKSP) key acts as a backspace and deletes the digit immediately to the left of the
current position.
The ENTER key validates and saves the entry and then closes the Edit dialog. The new entry
will display in the field.
The EXIT key cancels any changes that were entered and closes the Edit dialog, restoring
the previous value to the field.
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A.2.5  Editing non-numeric fields
The function of the keys when editing non-numeric data is context-dependent.

Editing alphanumeric fields
Alphanumeric fields take numbers (0 - 9) and letters (a - z, A - Z).

Select check boxes
Figure A-6: Selecting a check box

Procedure
Press F1 (SELECT) to select or deselect a check box.

Click buttons
Procedure
Press F1 (EXECUTE) to click a button and execute a command.

Select radio buttons
Procedure

1. Press F1 (SELECT) to select a group of radio buttons.
2. Use the UP/DOWN or LEFT/RIGHT keys to move through the various radio buttons

within the group.
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3. Press ENTER to accept the current selection or press EXIT to abort any changes and
to restore the previous selection.

Select an item from a list box
Procedure

1. Press F1 (SELECT) while focused on the list box to switch it to Edit mode.

Figure A-7: Selecting a list box

2. Use the UP and DOWN keys to move between the values within the list box.
3. Press ENTER to accept the current selection or press EXIT to abort the new selection,

and the list box will revert to the previous selection.
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Select an item from a combo box
Procedure

1. Press F1 (SELECT) while focused on the combo field.
A Combo dialog opens and displays a list of available selections.

Figure A-8: Selecting from a combo box

2. Use the UP and DOWN keys to move between the selections.
3. Press ENTER to select the desired value or press EXIT to restore the combo box’s

initial value.
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Enter a date and time
Procedure

1. Press F1 (SELECT) while focused on the Date and Time field
The Enter the Date and Time dialog displays. By default, the focus is set on the
Month unit.

Figure A-9: Entering a date and time

2. Use the UP and DOWN keys to change the value of the unit—that is, to go from
January to February, or from 1 to 2.

3. Use the LEFT and RIGHT arrow keys to change units—that is, to go from months to
years or hours to minutes.
Note
If the focus is on the leftmost section, the LEFT key will be inactive, and similarly if
the focus is on the rightmost section, the RIGHT key will be inactive.

4. Press ENTER to save the change or press EXIT to discard the change and restore the
original value.

Set the time
Procedure

1. Press F1 (SELECT) while focused on the Time field
The Enter the Time dialog displays. By default, the focus is set on the Hour unit.

2. Use the UP and DOWN keys to change the value of the unit.
3. Use the LEFT and RIGHT arrow keys to change units—to go from hours to minutes,

for example.
Note
If the focus is on the leftmost section, the LEFT key will be inactive, and similarly if
the focus is on the rightmost section, the RIGHT key will be inactive.
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4. Press ENTER to save the change or press EXIT to discard the change and restore the
original value.

A.3  Navigate and interact with the screen
This tutorial, which guides you through the procedure for editing data on a screen,
will incorporate all of the preceding information to demonstrate the typical method of
navigating and interacting with the local operator interface (LOI).
You will learn how to perform the following actions:
• Open and close screens.
• Navigate through tables.
• Select fields for editing.
• Save data.
Procedure

1. From the Main Menu, click the RIGHT key enough times to navigate to the
Application menu.
The System submenu, as it is the first item in the list, is already selected.
Note
In this instance, the term click means to tap the glass on the spot directly above the
arrow’s keyhole.

Figure A-10: Navigate to the Application menu

Note
Notice the navigation icon in the upper right corner, which indicates that all four
arrow keys are active. This allows you to navigate to all of the menu items and sub
menu items.
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Note
Notice that the green prompt boxes are empty. This means that the F1 and F2 keys
are inactive from the Main Menu.

2. Click ENTER.
The System screen displays.

Figure A-11: System screen

Note
Notice the navigation icon in the upper right corner, which indicates that no arrow
keys are active.
Notice that the green prompt boxes now display function keywords. MAIN means
that if you click F2, the LOI will close the current screen and return you to the Main
Menu. MOVE means that if you click F1, the arrow keys are enabled for navigation
within the System screen.

3. Click F1.
The LOI switches to Edit mode. Notice that the navigation icon in the upper right
corner of the screen indicates that the DOWN key is active.

4. Click the DOWN key once.
Now the navigation icon indicates that both the UP and DOWN keys are active.

5. Click the UP arrow once to return to the previous cell.
The navigation icon again indicates that only the DOWN key is active.
Notice that the green F1 prompt box reads EDIT.

6. Click F1.
You must be logged in to the gas chromatograph (GC) to make a change to any
screen. If you try to edit a field before logging in—as you just did, the LOI displays
the Login dialog to prompt you to log in.
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Figure A-12: Login screen (Edit mode prompt)

Note
Notice that there is also a navigation icon on the Login dialog.

7. Click F1 (SELECT) and navigate up or down the list to highlight your user name.
Note
For the remainder of this tutorial, when referring to the F1 key, the key’s current
valid function will be indicated in parenthesis—for instance, F1 (MOVE) or F1
(SELECT).

8. Click ENTER.
9. Navigate to the Password field, press F1 (EDIT), and enter your password.

Important
The password security policy requires a login name and password. Security levels
include:
• High - password policy level includes following parameters:

— Ensure minimum eight characters length and maximum of 12 characters.
— Ensure at least one upper case character.
— Ensure at least one lower case character.
— Ensure at least one digit.
— Ensure at least one special character:

• At symbol, exclamation mark, percent symbol, Caret symbol, Ampersand
symbol, Asterisk symbol, underscore, equals, plus, question mark, colon,
or dash

• @, !, #, $, %, ^, &&, *, _, =, +, ?, :, -‸
• Immediate reuse of a password will not be allowed. This will avoid setting

same password as new password repetitively
• Ensure password doesn’t contain user name
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• There will not be any kind of password expiration after certain time
• Medium password policy level includes the following parameters:

— Ensure minimum eight characters length and maximum of 12 characters.
— Ensure at least one upper case character.
— Ensure at least one digit.
— Ensure password doesn’t contain user name.
— There will not be any kind of password expiration after certain time.
:

• Low password policy level include the following rules:
— Ensure minimum eight characters length and maximum of 12 characters
— Password should contain any alphanumeric character combination (i.e.,

numbers, small letters, capital letters, special characters).
— There will not be any kind of password expiration after certain time

10. Click ENTER twice.
Now that you are logged in, you can edit the fields on the screen.

11. Click F1 (EDIT).
The Enter the data dialog displays.
The Enter the data dialog allows you to edit the selected field.

Figure A-13: Enter the data screen

12. To delete a character, press F1 (BACKSP). To enter new data, use the UP and DOWN
keys to cycle through the available characters, and use the RIGHT key to add a new
character to the field.
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13. When you are finished entering data, press ENTER to validate and save the new
information. To discard the information, press EXIT.

Figure A-14: New data displayed

Note
If a validation error is found after pressing ENTER, an Invalid Entry message displays.
Press ENTER to close the message and then re-enter your data.

14. Use the DOWN arrow to move to the Allow Multiple Writers check box.

Figure A-15: Allow Multiple Writers check box selected
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15. Press F1 (SELECT).
This clears the check box.

Figure A-16: Allow Multiple Writers check box not selected

16. Click F1 (SELECT) again to reselect the check box.
17. Navigate to the Time Format field.

Figure A-17: Time Format field
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18. Press F1 (SELECT).
The Select an Item combo box displays.

Figure A-18: Select an Item combo box

19. Use the DOWN key to scroll down to the last item in the combo box. Press ENTER.
20. Press ENTER a second time to save all the changes that were made to the table.

Note
If you neglect to press ENTER at this point, all of your changes will be lost.

21. Press F2 (MAIN) to return to the Main Menu.
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A.4  Local operator interface (LOI) screens
The Main Menu has six top-level submenus: Chromatogram, Hardware, Application,
Control, Logs/Reports, and Tools.
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.
Table A-1 through Table A-4 list the submenus and commands that are available from the
Main Menu.

Table A-1: Chromatogram menu
Submenu Command Subcommands Reference
Chromatogram Chromatogram menu

View N/A Chromatogram menu
Live Chromatogram View screen (Status Mode) Figure A-21
Live Chromatogram screen (Advanced Mode) Figure A-22
Archived Chromatogram screen (Advanced Mode) Figure A-27
Live && Archived Chromatogram Viewer Options menu Figure A-28
CGM Scaling screen Figure A-29
Select Detector screen Figure A-30
Chromatogram TEV table Figure A-31
Chromatogram CDT table Figure A-32
Chromatogram Raw Data table Figure A-33

Table A-2: Hardware and Application menus
Submenu Command Subcommands Reference
Hardware Hardware menu

Heaters N/A Figure A-35
Valves N/A Figure A-36
Detectors N/A Figure A-34
Discrete Inputs N/A Figure A-38
Discrete Outputs N/A Figure A-39
Analog Inputs N/A Figure A-40
Analog Outputs N/A Figure A-41
Installed
Hardware

N/A Figure A-42

Application Figure A-43
System N/A Figure A-44
Component Data Figure A-45CDT 1

CDT 2
CDT 3
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Table A-2: Hardware and Application menus (continued)
Submenu Command Subcommands Reference

CDT 4
Timed Events Figure A-46TEV 1

TEV 2
TEV 3
TEV 4

Streams N/A Figure A-50
Status N/A Figure A-53
Ethernet Ports N/A Figure A-54

Table A-3: Logs/Reports and Control Menus
Submenu Command Reference
Logs/Reports Logs/Reports menu

Maintenance Log Figure A-57
Event Log Figure A-58
Alarm Log Figure A-59
Unack Alarms Figure A-60
Active Alarms Figure A-61
Report Display Figure A-63

Control Control menu
Auto Sequence Figure A-65
Single Stream Figure A-66
Halt Figure A-67
Calibration Figure A-68
Validation Figure A-69
Stop Now Figure A-70

Table A-4: Tools menu
Submenu Command Reference
Manage Tools Tools menu

Screen Control Figure A-72
Diagnostics Figure A-74
Logout No screen
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A.4.1  Chromatogram menu
The Chromatogram menu enables you to view live and archived chromatograms and their
associated component data tables (CDTs) and timed event (TEV) tables, as well as to edit
the display properties if the chromatogram screens.
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.

Figure A-19: Chromatogram menu
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Figure A-20: Select Chromatogram screen

• After selecting the live chromatogram, select Options and view and select the detectors
associated with that cycle clock.

• All the detectors that are associated with a cycle clock are shown with a radio button.
The other detectors that are not associated with that cycle clock are grayed out as
shown in Figure A-21
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Figure A-21: Live Chromatogram View (Status mode) screen
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Note
The blue box displays the current analysis time.

Figure A-22: Live Chromatogram View (Advanced mode) screen

Note
The blue box displays the current analysis time.
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Figure A-23: Live Chromatogram - Analysis 1

Figure A-24: Live Chromatogram - Analysis 2
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Figure A-25: Live Chromatogram - Analysis 3

Figure A-26: Live Chromatogram - Analysis 4
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Figure A-27: Archived Chromatogram (Advanced mode) screen
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Figure A-28: Live and Archived Chromatogram Viewer Options screen

Note
The blue box displays the cursor’s X- (analysis time) and Y- (amplitude) coordinates.
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Figure A-29: CGM Scaling screen

After selecting the live CGM, select the Options menu to view and select the detectors
associated with that cycle clock.

Figure A-30: Detector selection via Options menu
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Figure A-31: Chromatogram Timed Events (TEV) Table screen

Figure A-32: Chromatogram Component Data Table (CDT) screen
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Figure A-33: Chromatogram Raw Data Table screen
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A.4.2  Hardware menu
The Hardware menu enables you to view and manage the GC’s hardware components.
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.

Figure A-34: Hardware menu

Figure A-35: Heaters screen
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Figure A-36: Valves screen

Note
The usage (Sample/BF1, Dual Column), mode (Auto, Off), and state (green = on, black = off,
red = error) of each valve is displayed.
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.

Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.
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Figure A-37: Detectors screen

Table A-5: Detector screen fields
Detector Screen G1 Board G2 Board

Field Names
Flame ionization
detector (FID)

Flame
photometric
detector (FPD) FID FPD

FID Temp RTD Selectable Blank Blank Blank
H2 Valve Selectable Blank Selectable Selectable
Flame Ignition Selectable Blank Selectable Selectable
Ignition Attempts Editable Blank Editable Editable
Wait Time Bet Tries Editable Blank Editable Editable
Igniter On Duration Editable Blank Editable Editable
Flame On Sense Temp Editable Blank Editable Editable
Flame Out Sense Temp Editable Blank Editable Editable
FPD Flame Status DI Blank Selectable Blank Blank
Scaling Factor Read only Read only Read only Blank
Flame Temp Read only Blank Read only Read only

The Detector screen field label names and their respective field statuses are described as
editable or non-editable depending on G1/G2 board types.
When you select one of the buttons on G1 boards (for example, Auto-zero), then since
FID and µFPD are both enabled for Auto-zero, when that button is selected a combo box
displays for you to select either FID or µFPD detector (if both detector types are configured
with the gas chromatograph [GC]). After selecting one of the detectors, the Auto-zero event
is triggered for that detector.
For G2 boards, since the µFPD is disabled for Auto-zero no combo box displays for you
to select the detector. Only one detector is a valid selection for Auto-zero in the available
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detectors on that GC, so the Auto-zero selection triggers the event for the FID detector. If
the button option is valid for more than one detector type, only then does the combo box
display. If only one detector type is valid for that specific button, then the combo box does
not display and the selection triggers that specific event on the only workable detector.

Table A-6: Detector screen Auto-zero buttons
Button Name G1 Board G2 Board

FID FPD FID FPD
Auto-Zero Enabled Enabled Enabled Disabled

Figure A-38: Discrete Inputs screen

Figure A-39: Discrete Outputs screen
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Figure A-40: Analog Inputs screen

Figure A-41: Analog Outputs screen

Manual Local operator interface (LOI)
MS-00809-0100-0700 November 2023

Rosemount 700XA 229



Figure A-42: Installed Hardware screen
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A.4.3  Application menu
The Application menu allows you to view the Component Data, Timed Events, and Streams
tables for the gas chromatograph (GC). The System, Status, and Ethernet Ports screens are
also accessible from this menu.
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.

Figure A-43: Application menu

Figure A-44: System screen

Manual Local operator interface (LOI)
MS-00809-0100-0700 November 2023

Rosemount 700XA 231

https://www.emerson.com/documents/automation/manual-mon2020-software-for-gas-chromatographs-rosemount-en-105130.pdf


Figure A-45: Component Data Table (CDT) screen

Figure A-46: Timed Events (TEV) - Valve Events screen
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Figure A-47: TEV - Integration Events screen

Figure A-48: TEV - Spectrum Gain Events screen
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Figure A-49: TEV - Analysis Time screen

Figure A-50: Streams Screen

The Streams screen shows the different streams configured for the specific cycle clock.
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Figure A-51: Single Stream Analysis screen

• All four Analyses are listed in this screen.
• For the selected Analysis, the streams are displayed.

Figure A-52: Single Stream Analysis (continued)
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Figure A-53: Status screen

Figure A-54: Ethernet Ports screen
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A.4.4  Logs/Reports menu
The Logs/Reports menu enables you to view the various reports that are available from the
gas chromatograph (GC).
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.

Figure A-55: Logs/Reports menu

Figure A-56: Report Display screen

The Report Display screen shows the analysis names for Cycle Clock 3 and 4. It also shows
all the streams associated with cycle clocks.
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Figure A-57: Maintenance Log screen

Figure A-58: Event Logs screen
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Figure A-59: Alarm Logs screen

Figure A-60: Unack Alarms screen

Analysis Cycle Clocks 3 and 4 Unacked alarms when Idle.
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Figure A-61: Active Alarms screen

Figure A-62: Active Alarm screen with multiple analysis clocks

Note
Analysis Cycle Clocks 3 and 4 - alarms when Idle.
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Figure A-63: Report Display screen

The right side of the Report Display screen shows the analysis names for the four analysis
clocks and all the streams associated with cycle clocks

A.4.5  Control menu
The Control menu enables you to stop, calibrate, or place on automatic control a sample
stream from the analyzer.
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.
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Figure A-64: Control Menu screen

Figure A-65: Auto Sequence screen

The Auto Sequence screen provides selections for the four Analysis options or ALL. Select
the radio button and press ENTER to begin auto sequencing. Press EXIT to abort the
process.
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Figure A-66: Single Stream screen

The Single Stream screen provides selections for the four Analysis options. Select the radio
button and press ENTER to begin the analysis. Press EXIT to abort the process. The stream
for the selected analysis is indicated in the field below the analysis.

Figure A-67: Halt screen

The Halt screen provides selections to halt the analysis for the four Analysis options or All.
Select the radio button and press ENTER to halt the current analysis. Press EXIT to abort
the process.
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Figure A-68: Calibration screen

The Calibration screen provides selections for provides selections for the four Analysis
options or ALL.

1. Select the radio button and press ENTER.
2. Select the Calibration Type, Normal or Forced.
3. Press ENTER to begin the calibration.
4. Press EXIT to abort the process.
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Figure A-69: Validation screen

The Validation screen provides selections for the four Analysis options or All. Select the
radio button and press ENTER to begin the validation. Press EXIT to abort the process.
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Figure A-70: Stop Now screen

Important
Do not perform a Stop Now unless absolutely necessary. Whenever possible, use the Halt
function.
This function forces the system into Idle mode. If Stop Now is performed while an analysis
clock run is in progress, the components may continue to elute from the columns. No
analysis data will be generated. To immediately stop an analysis run, do the following:

A. Select Control  → Stop Now. A confirmation message displays.
B. Select the Analysis Clock radio button and press ENTER to stop the analysis.
C. Click Yes and the current analysis clock run stops.
D. Press EXIT to abort the process to stop.

A.4.6  Tools menu
The Tools menu enables you to change the screen control, change a user’s password, and
log off of the gas chromatograph (GC) to which you are connected.
Note
Consult the Rosemount MON2020 Software for Gas Chromatographs Manual for more
information.
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Figure A-71: Tools Menu screen

Use the Tools → Screen Control menu to adjust screen brightness Up or Down.
Use the Boost Up or Down command to increase or decrease the contrast intensity.

Figure A-72: Screen Control screen
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Figure A-73: Change PIN screen

Figure A-74: Diagnostic screen
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Figure A-75: LOI Settings screen
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A.5  Troubleshoot a blank local operator interface
(LOI) display screen
If the LOI is powered up but the LCD display screen is blank, do the following:
Procedure

1. Power down the gas chromatograph and allow to cool before opening the upper
enclosure door.

2. Unscrew and remove the LOI board.
3. Flip the LOI over to expose its motherboard and associated electronics. Make sure

the J12 connector is tightly connected to the motherboard via ribbon cable.

Figure A-76: Jumpers at J105 on LOI motherboard

4. Check the jumpers located at J105 on the motherboard. These jumpers control the
screen’s power. To function properly, jumper pins 3 and 4 must be set; if they are
not, set them.

If the screen is still blank, replace the board.
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B  Carrier gas installation and
maintenance
This appendix provides a description of the optional carrier manifold (P/N 2-3-5000-050)
that permits the connection of two carrier gas bottles, or cylinders, to a gas
chromatograph (GC) system.

B.1  Carrier gas
The benefits of this manifold are as follows:
Note
The illustration and information in this appendix are adapted from drawing AE-10098.

• When one bottle is nearly empty (i.e., 110 psig [758.4 kPa] remaining), the other bottle
becomes the primary supply.

• You can disconnect each bottle for refilling without interrupting gas chromatograph
(GC) operation.

Figure B-1: Manifold for two carrier gas bottles to GC system

A. Analyzer
B. Carrier cylinder
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Valve Carrier gas cylinder Valve description
V-1 Carrier Cylinder 1 Bleed valve
V-2 Carrier Cylinder 1 Block valve
V-3 Carrier Cylinder 2 Block valve
V-4 Carrier Cylinder 2 Bleed valve

B.2  Install manifold and purge line
To install and purge the dual-bottle carrier gas manifold, proceed as follows:
Procedure

1. Install manifold as shown in Figure B-1. Close all valves and tighten all fittings. Run
tubing to the gas chromatograph (GC), but do not connect.

2. Back off pressure regulator (counter clockwise) fully.
3. Open cylinder valve for Carrier Cylinder 1.

The pressure indicator will read the cylinder pressure.
4. Open the shut-off valve attached to the carrier regulator.
5. Regulate pressure out of the cylinder to 20 psig (137.9 kPa); then close the cylinder

valve.
6. Open V-1 (bleed valve) and let the carrier gas bleed to atmosphere until both gauges

read 0 psig; then close V-1.
7. Repeat Step 4 and Step 5 twice to purge the line to V-2.
8. Purge the line to V-3 by repeating Step 2 through Step 6; but this time, use bleed

valve V-4 and Carrier Cylinder 2.
9. With valves 1-4 closed, open both cylinder valves and regulate both carriers to

approximately 10 psig (68.9 kPa).
10. Open V-2 and V-3 simultaneously; then turn both cylinder valves off and let the

carrier gasses bleed through the line to the GC until all gauges read 0 psig.
11. Repeat Step 8 and Step 9 twice to purge the line to the GC.
12. Close V-3; leave V-2 open.
13. Open the cylinder valve of Carrier Cylinder 1 and, with carrier gas flowing at 10 psig

(68.9 kPa) or below, connect the carrier line to the GC.
14. Slowly regulate Carrier Cylinder 1 to 110 psig (6.9 to 758.4 kPa).
15. Open V-3 and slowly regulate Carrier Cylinder 2 to 100 psig (689.4 kPa).

By doing this, all but 100 pounds of Carrier Cylinder 1 will be used before any of
Carrier Cylinder 2 is used. When Carrier Cylinder 1 gets to 100 pounds, replace the
cylinder.

16. Leak-check all of the fittings carefully.
17. Let the GC run overnight before calibrating.
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B.3  Replace carrier cylinder
To replace one carrier cylinder without interrupting gas chromatograph (GC) operation:
Procedure

1. Turn cylinder valve off.
2. Back off on cylinder pressure regulator until handle turns freely.
3. Remove cylinder.
4. Attach new cylinder to regulator.
5. Open cylinder valve for Carrier Cylinder 1.

The pressure indicator will read the cylinder pressure.
6. Open the shut-off valve attached to the carrier regulator.
7. Regulate pressure out of the cylinder to 20 psig (1.4 BarG); then close the cylinder

valve.
8. Repeat Step 6 and Step 7 twice to purge the line to V-2.
9. Open V-1 (bleed valve) and let the carrier gas bleed to atmosphere until both gauges

read 0 psig (0 BarG); then close V-1.
10. Repeat
11. Leak-check the fitting.
12. Open the appropriate block valve to the analyzer (V-2 or V-3) and regulate outlet

pressure to appropriate level.
See Step 14 and Step 15 of Install manifold and purge line.

B.4  Calibration gas for BTU analysis
The calibration gas used for BTU analysis should be blended of gases specified as primary
standards. Primary standard gases are blended using weights that are traceable to the
National Institute of Standards and Technology (NIST). For other applications, blend the
calibration gas to the specifications detailed in the analyzer’s Application Data Sheets.
The calibration gas should not have any component that could drop out at the coldest
temperature to which the gas will be subjected. A typical blend for a temperature of 0 °F
(-17.7 °C) is listed in the following table. No dropout will occur in this calibration gas if it is
blended at a pressure below 250 psig (1723.7 kPa).
Gas Mole Percent
Nitrogen 2.5
Carbon Dioxide 0.5
Methane Balance
Propane 1.0
Isobutane 0.3
N-butane 0.3
Neopentane 0.1
Isopentane 0.1
N-pentane 0.1
N-hexane 0.03
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Carefully plan the sampling system for the best chromatographic analyses.
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C  Micro flame photometric detector
(µFPD)
The latest version of the Rosemount 700XA is now designed with an integral µFPD. In
previous versions of the gas chromatograph (GC), side-car design was the only option for
the FPD. The new design reduces the gas chromatograph's footprint and eliminates the
side-car.

Figure C-1: Rosemount 700XA µFPD

A. µFPD burner assembly

The µFPD photo multiplier tube (PMT) is located in the upper enclosure beneath the oven
assembly ULTEM base plate.
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Figure C-2: µFPD PMT

C.1  Configure the micro flame photometric
detector (µFPD)
Procedure

1. Open MON2020 and select Hardware → Detectors.
If your gas chromatograph (GC) has an integral FPD, FPD G2 displays in Slot 1 or Slot
2.
Note
Before making any modifications to this window, halt the analysis.

2. Select Hardware → Detectors.
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3. Select Manual if you want to control the burner ignition; select Auto if you want the
GC to control the burner ignition.
The following data displays for each detector:

Name Description
Det # Numerical identifier for the detector to which the following data applies.
Detector Options, which depend on your GC's configuration, are:

• TCD (thermal conductivity detector)
• FPD G2 (µFPD)
• FID (flame ionization detector)
• FID G2

H2 Valve Optional hydrogen carrier shut-off valve
Flame Temp RTD Select the appropriate resistance temperature device (RTD) from the drop-down list.

The RTD measures the temperature of the flame.
Flame Ignition Select Manual if you want to control the burner ignition; select Auto if you want the

GC to control the burner ignition.
Ignition Attempts Indicates the number of times the GC will try to light the flame. If an Auto ignition

sequence fails to light the flame after the specified number of attempts, the GC will
close the hydrogen valve, switch the ignition parameter to Manual, and set an active
alarm.

Wait Time Bet Tries Indicates the amount of time, in seconds, the GC will wait between ignition attempts.
Igniter On Duration Indicates the length of time that the igniter will remain on.
Flame On Sense Temp The flame ignites when the internal temperature exceeds the value set in this field.
Flame Out Sense Temp The flame is extinguished when the internal burner temperature falls below the value

set below the Flame On Sense Temp.
FPD Flame Status DI Applies to FPDs only. Allows you to select from a list of available digital inputs (DIs).

The DI that is selected will receive the FPD's flame status value.
Preamp Val Detector count. Read-only.
Flame Temperature Temperature of the flame as read by the RTD. Read-only.
Flame Status Options are: Off, On, and Over Temperature. Read-only.
H2 Valve Cur State Options are: Open and Closed. Read-only.
Scaling Factor Preamp calibration factor.
Igniter Status Options are: Off and On. Read-only.
Electrometer Voltage(1) Output at first stage of FID preamp. Read-only.
Pre Amplifier Voltage(1) Output at second stage of FID preamp. Read-only.
Polarizing Voltage(1) Igniter voltage. Read-only.
Gain Status Options are: Low and High.
Status Options are: Ok, Not Installed, and Internal Error. Read-only.

(1) Not used with µFPD.

4. If the Flame Ignition field is set to Manual, and if the Flame Status field is set to Off,
do the following to restart the flame:

a) Click Ignite.
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The Flame Status field changes to On when the internal temperature exceeds
the value set in the Flame On Sense Temp field.
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D  Recommended spare parts
D.1  Recommended spare parts for Rosemount

700XA thermal conductivity detector (TCD)
analyzers

Quantity Description Part number
1-5 gas chromatographs

(GCs)
6 or more GCs or critical

installations
1 1 Kit, fuse, XA 2-3-0710-074
1 2 Solenoid, 4-way, MAC, 24 Vdc 2-4-0710-224
1 1 Thermistor seals, package of

10
2-3-0500-391

1 per valve 1 per valve Kit diaphragm, 10-port XA 2-4-0710-171
1 per valve 1 per valve Kit, diaphragm, 6-port XA 2-4-0710-248

1 1 Column set Note 2
1 per stream 1 per stream Filter element 2 micron 2-4-5000-113
1 per stream 1 per stream Membrane kit, 120 filter 2-4-5000-938

0 1 PCA detector preamp 2-3-0710-001 7A00401G01
0 1 PCA solenoid/heater driver 2-3-0710-002 9A00402G01
0 1 PCA base in/out (I/O) 2-3-0710-003 7A00403G01
0 1 PCA backplane 2-3-0710-005 7A00420G01
0 1 PCA main central processing

unit (CPU)
2-3-0710-0077A00555G01

0 (1) Assembly, power supply (AC) 7A00077G01
0 (2) Pressure switch carrier 2-4-0710-266
0 1 per detector Kit, thermistors, thermal

conductivity detector (TCD)
(2)

0 1 per carrier Carrier dryer assembly 2-3-0500-180

(1) If the GCs are powered with an AC line in, we recommend one spare.
(2) If the GCs have a pressure switch installed, we recommend one spare.
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D.2  Recommended spare parts for Rosemount
700XA flame ionization detector (FID)/thermal
conductivity detector (TCD) analyzers

Quantity Description Part number
1-5 gas

chromatographs
(GCs)

6 or more
GCs or critical
installations

1 1 Kit, fuse, XA 2-3-0710-074
1 2 Solenoid, 4-way, MAC, 24 Vdc 2-4-0710-224
1 1 Thermistor seals, package of 10 2-3-0500-391

1 per valve 1 per valve Kit diaphragm, 10-port XA 2-4-0710-171
1 per valve 1 per valve Kit diaphragm, 6-port XA 2-4-0710-248

1 1 Column set (1)

1 per stream 1 per stream Filter element, 2 micron 2-4-5000-113
1 per stream 1 per stream Membrane kit, 120 filter 2-4-5000-938

0 1 PCA detector preamp 7A00401G01
0 1 PCA solenoid/heater driver 9A00402G01
0 1 PCA base in/out (I/O) 7A00403G01
0 1 PCA backplane 7A00420G01
0 1 PCA main central processing unit (CPU) 7A00555G01
0 1 PCA flame ionization detector (FID) electrometer 2-3-0710-014
0 (2) Assembly, power supply (AC) 7A00077G01
0 1 Assembly, micro FID, XA 2-3-0710-077
0 (3) Kit, field methanator replacement 2-3-0710-700
0 (3) Pressure switch, carrier 2-4-0710-266
0 1 per detector Kit, thermistors, thermal conductivity detector

(TCD)
N(1)

0 1 per carrier Carrier dryer assembly 2-3-0500-180

(1) Application dependent. Please contact your Emerson Customer Care representative and provide the GC's
sales order number for the recommended part number and description.

(2) If the GCs are powered with an AC line, we recommend one spare.
(3) If the GCs have this option installed, we recommend one spare.
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D.3  Recommended spare parts for Rosemount
700XA flame ionization detector (FID) analyzers

Quantity Description Part number
1-5 gas

chromato-
graphs (GCs)

6 or more GCs
or critical

installations
1 1 Kit, fuse, XA 2-3-0710-074
1 2 Solenoid, 4-way, MAC, 24 Vdc 2-4-0710-224

1 per valve 1 per valve Kit, diaphragm, 10-port XZ 2-4-0710-171
1 per valve 1 per valve Kit, diaphragm, 6-port XA 2-4-0710-248

1 1 Column set (1)

1 per stream 1 per stream Filter element, 2 micron 2-4-5000-113
1 per stream 1 per stream Membrane kit, 120 filter 2-4-5000-938

0 1 PCA detector preamp 7A00401G01
0 1 PCA solenoid/heater driver 9A00402G01
0 1 PCA base in/out (I/O) 7A00403G01
0 1 PCA backplane
0 1 PCA main central processing unit

(CPU)
7A00555G01

0 1 PCA flame ionization detector (FID)
electrometer

2-3-0710-014

0 (2) Assembly, power supply (AC) 7A00077G01
0 1 Assembly, micro FID, XA 2-3-0710-077
0 (3) Kit, field, methanator replacement 2-3-0710-700
0 (3) Pressure switch, carrier 2-4-0710-266
0 1 per carrier Carrier dryer assembly 2-3-0500-180

(1) Application dependent. Please contact your Emerson Customer Care representative and provide the GC's
sales order number for recommended part number and description.

(2) If the GCs are powered with an AC line, we recommend one spare.
(3) If the GCs have this option installed, we recommend one spare.
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D.4  Recommended spare parts for Rosemount
700XA micro flame photometric detector (µFPD)
analyzers

Description Part number Quantity
µFPD burner 7A00233G01 0 (as needed)
µFPD fiber cable 7P00444H01 0 (as needed)
µFPD assembly, igniter, and thermocouple 7A00232G01 1
µFPD Edmond optics lens, 25 mm outer diameter (OD) 7C00319-001 2
µFPD flame chamber 7P00435H01 0 (as needed)
µFPD gas mixer 7P00437H01 0 (as needed)
µFPD side entry photomultiplier tube (PMT) module 7A00234G01 0 (as needed)
µFPD O-ring kit 7A00243G01 1
µFPD screws, connectors, and washers kit 7A00244G01 1
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E  Shipping and long-term storage
recommendations
For applications equipped with special columns, such as mole sieve, read and follow the
additional instructions shipped with the analyzer and/or column set first. If you need
another copy, please contact customer service.
The following recommendations should be followed:
• For shipping purposes the gas chromatograph should be secured to a wooden pallet,

maintained in a vertical position and enclosed in a wood framework.
• Auxiliary equipment such as sample probes may be stored in the packaging in which it

was shipped. If this packaging material is no longer available, secure the equipment to
prevent excessive shaking and protect the accessories in a water proof enclosure.

• The gas chromatograph should be stored in a sheltered environment that is
temperature controlled between -30 °C (-22 °F) and 60 °C (140 °F) to keep the gas
chromatograph’s protective coatings from deteriorating from exposure to rain or
caustic or corrosive environments. Humidity in the sheltered environment should be
non-condensing. Be especially cautious of humidity if the conduit has been potted.
Temporary caps and desiccant may be necessary.

• The configuration of the analyzer may be retained through battery back-up on the CPU
for at least two years. If lost for some reason, a custom program for downloading
the appropriate GC application is included on the USB shipped with the system
documentation.

• If the gas chromatograph has been in operation, the system should be purged with
carrier gas before powering the gas chromatograph down, especially when heavy
hydrocarbons or components that tend to polymerize are present. Allowing the gas
chromatograph to perform a few analysis cycles without sample gas is an acceptable
method of purging the system.
Note
To expedite the purge process, you may use 30 psig of a dry inert gas, such as nitrogen
or helium.
Monitor the results and halt the analyzer after component values fall to 0 or after peaks
are significantly reduced in size. Save a copy of the diagnostic data under Tools → Save
Diagnostic Data; once the file has been saved to a local PC, USB, or hard drive, you may
remove power.

• After removing power from the GC, remove the purge gas and immediately cap all
inlets and vents, including the carrier drier. These vents and inlets should be capped
with the fittings that were in place when the GC shipped from the factory or with
Swagelok® caps (not provided). This will protect the columns and filters and should
result in a trouble-free start up when the unit is returned to service.

• The sample conditioning system vents and inlets should also be capped with the fittings
that were in place when the system shipped from the factory. Additionally, all vents
should be closed.

• Any remaining openings—such as conduit entries—should also have appropriate plugs
installed to prevent foreign material such as dust or water from entering the system.
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F  Pre-defined Modbus® map files
For the Modbus map files used with the gas chromatograph, see the Pre-Defined Modbus
Map Files Reference Manual.
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G  Engineering drawings
G.1  List of engineering drawings - Rosemount

700XA
• BE-22175 Label Set Field Wiring Card 1 (Sheets 1, 2, and 3)
• DE-22050 Outline and Dimensional Pole, Wall and Floor Mounting Units, Rosemount

700XA
• CE-22260 Assembly, 6 Port XA Valve, Rosemount 700XA
• CE-22300 Assembly, 10 Port XA Valve, Rosemount 700XA
• DE-22143 (Sheets 1-7) Unit Assembly Rosemount 700XA Gas Chromatograph (GC)
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MS-00809-0100-0700 November 2023

Rosemount 700XA 267



MS-00809-0100-0700
Rev. AC

2023

For more information: Emerson.com/global
©2023 Emerson. All rights reserved.
Emerson Terms and Conditions of Sale are available
upon request. The Emerson logo is a trademark and
service mark of Emerson Electric Co. Rosemount is a
mark of one of the Emerson family of companies. All
other marks are the property of their respective owners.

http://Emerson.com/global

	 Rosemount 700XA 
	Contents
	1 Cybersecurity recommendations for Rosemount XA gas chromatograph (GC) and MON2020 users
	2 Overview
	2.1 System description
	2.1.1 Analyzer assembly
	2.1.2 Electronics assembly
	2.1.3 Sample conditioning system (SCS)

	2.2 Functional description
	2.3 Software description
	2.3.1 Embedded gas chromatograph (GC) firmware
	2.3.2 Rosemount MON2020

	2.4 Theory of operation
	2.4.1 Thermal conductivity detector (TCD)
	2.4.2 Flame ionization detector (FID)
	2.4.3 Micro flame photometric detector (µFPD) burner
	2.4.4 Micro flame photometric detector (µFPD) electronics module
	2.4.5 Liquid sample injection valve (LSIV)
	2.4.6 Methanator
	2.4.7 Data acquisition
	2.4.8 Peak detection
	2.4.9 Basic analysis computations
	Concentration analysis - response factor
	Concentration calculation - mole percentage (without normalization)
	Concentration calculation in mole percentage (with normalization)



	3 Equipment description and specifications
	3.1 Equipment description
	3.1.1 Front panel assembly
	Switch panel
	Local operator interface (LOI)

	3.1.2 Upper compartment
	3.1.3 Lower compartment
	3.1.4 Mechanical pressure regulators

	3.2 Specifications
	3.2.1 Electronics hardware
	3.2.2 Airless analytical oven
	3.2.3 Software
	3.2.4 Corrosion protection
	3.2.5 Archived data storage capabilities


	4 Getting started
	4.1 Select site
	4.2 Unpack the gas chromatograph (GC)
	4.3 Required tools and components
	4.4 Supporting tools and components

	5 Installation and start-up
	5.1 Installation considerations
	5.2 Mounting arrangements
	5.2.1 Mount the gas chromatograph (GC) to the wall
	5.2.2 Mount the gas chromatograph (GC) to a pole
	5.2.3 Mount the gas chromatograph (GC) on the floor

	5.3 Gas chromatograph wiring
	5.3.1 Wiring precautions
	5.3.2 Signal wiring
	5.3.3 Electrical conduit installation precautions
	5.3.4 Sample system requirements

	5.4 Electrical installation
	5.4.1 Connect power supply
	5.4.2 Connect optional AC/DC power converter
	5.4.3 Connect gas lines
	5.4.4 Maximum effective distance by communication protocol type
	5.4.5 RS-485 serial port terminating resistors
	5.4.6 Installing and connecting to an analog modem card
	Install the analog modem

	5.4.7 Connect directly to a personal computer (PC) using the gas chromatograph's (GC’s) Ethernet1 port
	5.4.8 Connect to the gas chromatograph (GC) using Rosemount MON2020
	5.4.9 Troubleshoot dynamic host configuration protocol (DHCP) connectivity issues
	5.4.10 Connect directly to a personal computer (PC) using the gas chromatograph's (GC's) serial port
	5.4.11 Connect directly to a personal computer (PC) using the gas chromatograph's (GC’s) wired Ethernet terminal
	5.4.12 Assign a static Internet protocol (IP) address to the gas chromatograph (GC)
	5.4.13 Wiring the discrete digital inputs and outputs
	Wire the discrete digital inputs
	Wire an ROC800 digital input (DI) module
	Wiring the discrete digital outputs
	Optional discrete digital inputs (DI)
	Wire an ROC800 digital output (DO) module

	5.4.14 Wiring the analog inputs
	Analog inputs on the backplane
	Analog inputs settings switches
	Select the input type for an analog input
	Typical wiring for line-powered transmitters
	Optional analog inputs (AI)
	Wire a ROC800 AI-16 module
	Calibrate a ROC800 AI-16 module

	5.4.15 Analog output wiring
	Factory settings for analog output switches
	Wire customer externally-powered analog outputs
	Optional analog outputs
	Connect ROC800 analog output (AO) module to a field device

	5.4.16 Configure analytical train
	5.4.17 Configure an analysis clock

	5.5 Leak checking and purging for first calibration
	5.5.1 Check the gas chromatograph (GC) for leaks
	5.5.2 Plugged lines, columns, and valves
	5.5.3 Purge carrier gas lines
	5.5.4 Purge calibration gas lines

	5.6 Start up the system

	6 Operation and maintenance
	6.1 Warning and notice
	6.2 Start a 2-point calibration
	6.3 Troubleshooting and repair
	6.4 Routine maintenance
	6.4.1 Maintenance checklist
	6.4.2 Save diagnostic data
	6.4.3 Service programs
	6.4.4 Precautions for handling printed circuit (PC) assemblies
	6.4.5 Flame ionization detector (FID) configuration
	6.4.6 Replace the central processing unit (CPU)
	6.4.7 Repairing and maintaining the valves
	Required tools for valve maintenance
	Valve replacement parts
	Overhaul a valve
	Replace solenoids
	Liquid sample injection valve (LSIV) maintenance
	Install a MAT liquid sample injection valve (LSIV)
	Remove the MAT liquid sample injection valve
	Replace liquid sample injection valve (LSIV) seals


	6.4.8 Repairing and maintaining the detectors
	Required tools for thermal conductivity detector (TCD) maintenance
	Thermal conductivity detector (TCD) replacement parts
	Replace a thermal conductivity detector (TCD)
	Remove the flame ionization detector (FID)
	Reassemble the flame ionization detector (FID)
	Replace igniter/thermocouple assembly
	Troubleshoot igniter/thermocouple assembly
	Remove the micro flame photometric detector (µFPD) burner
	Install the micro flame photometric detector (µFPD) burner
	Remove the micro flame photometric detector photomultiplier tube (µFPD PMT) module
	Install the micro flame photometric detector (μFPD) photo multiplier tube (PMT) module

	6.4.9 Maintain the methanator
	6.4.10 Measure vent flow
	6.4.11 Access electrical components
	Replace AC/DC power supply

	6.4.12 Communications
	Maximum distance by communication type
	Change the line drivers
	Install optional RS-232 serial ports
	Install an optional RS-485/RS-422 serial port card
	Configuring the optional RS-485 serial port to function as an RS-422 serial port

	6.4.13 Installing or replacing a FOUNDATION™ Fieldbus module
	Remove a FOUNDATION™ Fieldbus module
	Install a FOUNDATION™ Fieldbus module
	Connect the GC’s FOUNDATION™ Fieldbus module to a Fieldbus segment
	Connect the optional ground wire
	FOUNDATION™ Fieldbus jumper settings

	6.4.14 Analog inputs and outputs
	Analog output adjustment

	6.4.15 Upgrading the embedded software


	7 Troubleshooting
	7.1 Hardware alarms
	7.1.1 LTLOI Failure
	7.1.2 Maintenance Mode
	7.1.3 Power Failure
	7.1.4 User Calculation Failure
	7.1.5 Low Battery Voltage
	7.1.6 Preamp Board Comm Failure
	7.1.7 Flame ionization detector (FID), flame photometric detector (FPD), or µFPDG2 (FPDG2) Failure
	7.1.8 Heater Solenoid Board (1 or 2) Comm Failure
	7.1.9 Base in/out (IO) Board Comm Failure
	7.1.10 Stream Skipped
	7.1.11 GC Idle
	7.1.12 Heater (1-8) Out of Range
	7.1.13 Flame Out
	7.1.14 Flame Over Temperature
	7.1.15 Detector Scaling Factor Failure
	7.1.16 No sample flow (1 or 2)
	7.1.17 Low Carrier Pressure (1-4)
	7.1.18 Analog Input (1-10) High Signal
	7.1.19 Analog Input (1-10) Low Signal
	7.1.20 Analog Output (1-10) High Signal
	7.1.21 Analog Output (1-10) Low Signal
	7.1.22 Stream (1-20) Validation Failure
	7.1.23 Stream (1-20) RF Deviation
	7.1.24 Energy Value Invalid
	7.1.25 Calibration Energy Check Fail
	7.1.26 Stored Data Integrity Failure
	7.1.27 ROM Checksum Failure
	7.1.28 Sample Fluid Unavailable
	7.1.29 Flame Photometric Detector Board 1 Comm Failure

	7.2 No power to flame photometric detector (FPD)
	7.3 Can't ignite flame photometric detector (FPD)
	7.4 No peaks showing
	7.5 Small peaks
	7.6 No temperature readings
	7.7 Noisy baseline
	7.8 Peak clipping
	7.9 Test points
	7.10 Voltage LEDs
	7.11 Monitoring the detector(s) and columns temperature

	A Local operator interface (LOI)
	A.1 Local operator interface (LOI) for displaying and entering data
	A.1.1 LED indicators
	A.1.2 LCD display screen
	A.1.3 Keypad
	Command keys
	Arrow keys
	Pressing a key


	A.2 Using the local operator interface (LOI)
	A.2.1 Start-up
	A.2.2 Navigating menus
	A.2.3 Navigating the screens
	A.2.4 Editing numeric fields
	A.2.5 Editing non-numeric fields
	Editing alphanumeric fields
	Select check boxes
	Click buttons
	Select radio buttons
	Select an item from a list box
	Select an item from a combo box
	Enter a date and time
	Set the time


	A.3 Navigate and interact with the screen
	A.4 Local operator interface (LOI) screens
	A.4.1 Chromatogram menu
	A.4.2 Hardware menu
	A.4.3 Application menu
	A.4.4 Logs/Reports menu
	A.4.5 Control menu
	A.4.6 Tools menu

	A.5 Troubleshoot a blank local operator interface (LOI) display screen

	B Carrier gas installation and maintenance
	B.1 Carrier gas
	B.2 Install manifold and purge line
	B.3 Replace carrier cylinder
	B.4 Calibration gas for BTU analysis

	C Micro flame photometric detector (µFPD)
	C.1 Configure the micro flame photometric detector (µFPD)

	D Recommended spare parts
	D.1 Recommended spare parts for Rosemount 700XA thermal conductivity detector (TCD) analyzers
	D.2 Recommended spare parts for Rosemount 700XA flame ionization detector (FID)/thermal conductivity detector (TCD) analyzers
	D.3 Recommended spare parts for Rosemount 700XA flame ionization detector (FID) analyzers
	D.4 Recommended spare parts for Rosemount 700XA micro flame photometric detector (µFPD) analyzers

	E Shipping and long-term storage recommendations
	F Pre-defined Modbus® map files
	G Engineering drawings
	G.1 List of engineering drawings - Rosemount 700XA



